# Table of Contents

**Home** .............................................................................................................................................................................................................. 1

**Introduction to the Nik Collection by DxO** ....................................................................................................................................................................................... 2  
  *Introducing the Nik Collection by DxO* ....................................................................................................................................................................................... 3

**Settings** ................................................................................................................................................................................................................. 4
  *System requirements* ................................................................................................................................................................................................... 5
  *Installation, activation, and uninstallation* ................................................................................................................................................................. 7

**Control points** ........................................................................................................................................................................................................ 13
  *Principles and functions* ................................................................................................................................................................................................ 14

**Workflow** ....................................................................................................................................................................................................... 20
  *DxO PhotoLab* .................................................................................................................................................................................................. 21
  *Adobe Lightroom Classic* .................................................................................................................................................................................................. 28
  *Serif Affinity Photo* ................................................................................................................................................................................................ 48
  *Standalone mode* ..................................................................................................................................................................................................... 51
  *Non-destructive workflow (Nik Collection 3)* ........................................................................................................................................................................ 53

**Workflow with Adobe Photoshop** ............................................................................................................................................................................................... 67
  *Accessing the Nik Collection* .................................................................................................................................................................................................. 68
  *Selective Tool 2 and Brush tool* .................................................................................................................................................................................... 81

**Analog Efex Pro 2** .................................................................................................................................................................................................. 92
  *Introduction* ............................................................................................................................................................................................................ 93
  *Settings and help* ....................................................................................................................................................................................................... 94
  *Interface and keyboard shortcuts* .................................................................................................................................................................................. 97
  *Cameras and tools* ..................................................................................................................................................................................................... 109
  *Custom camera kits and tools* ....................................................................................................................................................................................... 124

**Color Efex Pro 4** ........................................................................................................................................................................................................ 130
  *Introduction* ............................................................................................................................................................................................................ 131
  *Settings and help* ....................................................................................................................................................................................................... 132
  *Interface and keyboard shortcuts* .................................................................................................................................................................................. 135
  *Managing recipes and filters* ................................................................................................................................................................................................ 149

**Dfine 2** .................................................................................................................................................................................................................... 156
  *Introduction* ............................................................................................................................................................................................................ 157
  *Settings and help* ....................................................................................................................................................................................................... 159
  *Interface and keyboard shortcuts* .................................................................................................................................................................................. 161
  *Measuring and reducing noise* ...................................................................................................................................................................................... 167

**HDR Efex Pro 2** ........................................................................................................................................................................................................ 181
  *Introduction* ............................................................................................................................................................................................................ 182
  *Settings and help* ....................................................................................................................................................................................................... 184
  *Interface and keyboard shortcuts* .................................................................................................................................................................................. 187
  *Merging images* ......................................................................................................................................................................................................... 199
  *Using and managing presets* .................................................................................................................................................................................... 205
  *Correction tools* ......................................................................................................................................................................................................... 211

**Perspective Efex** .................................................................................................................................................................................................. 224
  *Introduction* ............................................................................................................................................................................................................ 225
  *Settings and help* ....................................................................................................................................................................................................... 226
  *Interface and keyboard shortcuts* .................................................................................................................................................................................. 228
  *Applying DxO Optics Modules* ............................................................................................................................................................................... 233
  *Correcting distortion* .................................................................................................................................................................................................. 235
  *Correcting volume deformation* ................................................................................................................................................................................ 239
In the news: Nik Collection 3 by DxO!

- Non-destructive workflow (Nik Collection 3)
- Perspective Efex
- Selective Tool 2 and Brush tool
Introduction to the Nik Collection by DxO
Introducing the Nik Collection by DxO

The Nik Collection by DxO offers a wide range of creative tools with numerous filters, renderings, and editing options that are readily mastered both by demanding photographers and by photographers who are looking for easy-to-use tools.

The suite is compatible with Adobe Photoshop, Adobe Lightroom Classic, Serif Affinity Photo, and DxO PhotoLab, and is based on the following 8 plug-ins or external editors:

- **Analog Efex Pro 2**, simulating the rendering of many types of film cameras.
- **Color Efex Pro 4**, offering a variety of color camera renderings and recipes for color photography.
- **Dfine 2**, allowing for very precise noise correction, both globally and locally.
- **HDR Efex Pro 2**, for merging and processing images with a wide dynamic range.
- **Perspective Efex**, specializing in geometric image correction.
- **Silver Efex Pro 2**, offering a rich palette of tools and renderings for black and white.
- **Sharpener Pro 3**, taking care of all sharpening tasks from the beginning of the workflow to media output.
- **Viveza 2**, using darkroom principles to easily correct tonality and color.

The Nik Collection by DxO is based on a variety of technologies such as selective correction with control points (U-points); film simulation based on the real-world characteristics of old-fashioned film; tone compression and 32-bit image support for HDR; and optical correction and associated modules from DxO Labs.

In this guide you will find not only a complete description of all the tools, plugin by plugin, but also all you need to know about workflows with host applications, as well as the different usage scenarios.
Settings
System requirements

Supported operating systems
The Nik Collection 3 by DxO supports the following operating systems:

- Microsoft Windows 8.1 or higher (64-bit only)
- Microsoft Windows 10 version 1607 or higher (64-bit only)
- Apple macOS 10.13 or higher

Hardware configuration
PC (Windows)

- Intel® Core™ 2 or AMD Athlon™ 64 X2 or higher (Intel Core® i5 or higher recommended)
- 4 GB of RAM (8 GB recommended)
- Minimum of 4 GB of available space on your hard drive
- Microsoft Surface devices are not supported
- Required conditions requests for supporting HiDPI monitors:
  - Microsoft Windows 10.1607 and higher versions
  - Adobe Photoshop CC 2015.5 and higher versions (if launched from Adobe Photoshop)

Mac (macOS)

- Intel® Core™ i5 or higher
- 4 GB of RAM (8 GB recommended)
- Minimum of 4 GB available space on your hard drive

Graphic cards (GPU)

- NVIDIA GeForce series 8 and higher, ATI Radeon series HD2000 and higher, and Intel HD Graphics 2000 and higher
- Note: If your graphics card is not compatible, GPU acceleration will be deactivated in favor of the CPU.

Compatible host software
PC

- Adobe Photoshop CS5 (64-bit) and higher
- Adobe Photoshop Elements 13 (64-bit) and higher (note: HDR Efex Pro 2 is not compatible with Photoshop Elements)
- Adobe Photoshop Lightroom 3 and higher
- DxO PhotoLab 2 and higher
- Serif Affinity Photo 1.8.3 and higher

Mac

- Adobe Photoshop CS5 (64-bit) and higher
- Adobe Photoshop Elements 13 (64-bit) and higher (note: HDR Efex Pro 2 is not compatible with Photoshop Elements)
- Adobe Photoshop Lightroom 3 and higher
- DxO PhotoLab 2 and higher
- Serif Affinity Photo 1.8.3 and higher
Installing, activating, and uninstalling
You will find instructions for the following on this page:

- Downloading
- Installation
- Activation
- Installing in host applications
- Installing in Serif Affinity Photo
- Uninstallation

Downloading
You can download the Nik Collection by DxO at nikcollection.dxo.com; it will be saved in your computer’s Downloads folder. In Windows, the file will have the extension .exe; in Mac, the file has the extension .dmg.

Installing

1. Be sure to close all host image editing applications, such as Photoshop or Lightroom.
2. Locate the installation file you downloaded, and double-click it.
3. The installer automatically attempts to locate the appropriate location for the installation, as well as the installed host applications. It is recommended that you keep the default options of the installer. If no host applications are found, exit the installer and restart it.
4. Once the installation is complete, you can access the software from the host image editing applications.

For users who already own Nik Software products, product keys are no longer
Before installing the new version of Nik Collection to replace a previous version, we recommend that you first export the types, presets, and recipes that you have customized or imported from Analog Efex Pro 2, Color Efex Pro 4, Silver Efex Pro 2, and HDR Efex Pro 2.

Activating

At the first launch after installation, a window will prompt you to enter your registration key. This window will appear at each launch as long as you have not entered the key. During the trial period (30 days), you will be able to continue using the Nik Collection; after that, you will be blocked at the registration window.

Installing in host applications

The Nik Collection by DxO automatically installs in the following host applications (make sure they are closed first):

- DxO PhotoLab
- Adobe Lightroom Classic
- Adobe Photoshop
- Adobe Photoshop Elements

Installing in Serif Affinity Photo*

*Important: Compatibility between Affinity Photo and the Nik Collection by DxO exists from version 1.8 and higher of the Serif program, and from version 2.5 and higher of the collection.

Plug-ins for the Nik Collection by DxO are not automatically installed in Affinity Photo during the installation process. You must install them manually as follows:

For Mac users:

1. Plugin installation and creation:
   1. Launch the Nik Collection 2.5 by DxO Installer.
   2. During the "Compatible Hosts" step, click + to create a new folder in the directory of your choice to store the Nik Collection plug-ins, then click Open. In the installer window, you will then see a new host in the list called Adobe Photoshop Custom1.
1. By successively clicking Continue, then Install, a "DxO" folder will be created in the background in the directory of your choice. This DxO folder will contain all the Nik Collection by DxO plugins.

2. Continue the installation until the end and click on **Close**.

3. Launch the Affinity Photo program.

4. Import the Nik Collection plugins into Affinity Photo:
   1. From the top menu bar, go to **Affinity Photo > Preferences**.
   2. In the window that opens, click on the **Photoshop Modules** icon.
1. In the **Modules Search Folder** section, click on **Add**.

2. In the dialog window, select the **DxO** folder generated inside the folder you created during installation, and press the **OK** button.

3. Underneath the **Detected Modules** section, select the **Allow the use of "Unknown" modules** checkbox.
1. Click on Close.

2. In the other dialog window, select Restart.

3. After the restart, if it is open, close the Preferences popup.

4. Import your image into Affinity Photo.

5. Launch the Nik Collection by DxO plugins via Affinity Photo:
   - Go to Filters > Modules > Nik Collection > Name of plugin.

For Windows users:

A. Plugin installation and creation:
   1. Launch the Nik Collection by DxO installer.
   2. During the "Compatible Hosts" step, click + to create a new folder in the directory of your choice to store the Nik Collection plugins, then click Open. In the installer window, you will then see in the list a new host called Adobe Photoshop Custom1.
   3. By successively clicking on Continue, then Install, a "DxO" folder will be created in the background in the directory of your choice. This DxO folder will contain all Nik Collection by DxO plugins.
   4. Continue the installation to the end and click Close.
B. Launch the Affinity Photo application.

C. Import the Nik Collection plugins into Affinity Photo.
   1. In the top menu bar, go to Edit > Preferences.
   2. In the window that opens, click on the Photoshop Modules icon.
   3. In the Modules Search Folder section, click on Add.
   4. In the dialog window, select the DxO folder generated inside the folder you created during installation, and press the OK button.
   5. Underneath the Detected Modules section, select the Allow the use of "Unknown" modules checkbox.
   6. Click on Close.
   7. In the other dialog window, select Restart.
   8. After the restart, if it is open, close the Preferences popup.

Uninstalling
There are two different ways to uninstall the Nik Collection by DxO; before using either method, close the the host applications.

- **Method 1:** Go to the Programs (PC) or Applications (Mac) folder, then go to the Nik Collection folder, where you will find an Uninstall icon. Click it to start the deinstallation and then follow the instructions.

- **Method 2:** Click on the installer in your Downloads folder, then in the window that appears, click on the Uninstall icon and follow the instructions.
Control points
Control points

Principles and functions

Control Points use U Point technology, developed by Nik Software and acquired in 2017 by DxO Labs, which allows you to make precise selections without the need for masks or complex selection tools. (The name “U Point” is simply an abbreviated form of “you point.”) Each of the Nik Collection by DxO’s plugins (except Perspective Efex) includes control points tailored to its function. For example, in Dfine 2, control points allow you to selectively reduce noise, while in Viveza 2, they allow you to correct tone and color.

Each control point makes its selection based on the characteristics of the reference pixels to which it is applied. These characteristics include:

- RGB channels (red, green, blue)
- Hue or tint
- Saturation
- Brightness
- Texture (thanks to the consideration of adjacent pixels and the presence of details)
- Location of the selected pixels

U Point technology then automatically selects other elements and areas of the image with characteristics similar to the selected image point on which the control point is placed within the range defined by the size slider. (To define the size of the selection, use the Size slider associated with each control point.) Finally, adding control points in the same image allows for even finer and more precise analyses, which will have an impact on the efficiency and accuracy of your selections. Further, more areas will be selected simultaneously in the image.

Note that control points and U Point technology have also been integrated into the local settings of DxO PhotoLab.

You can compare below the different control points/U-points in the Nik Collection by DxO, and the version in DxO PhotoLab (bottom image in the series):
Control Point / Analog Efex Pro 2

Control Point / Color Efex Pro 4
Control points

Control Point / Sharpener Pro 3 (Output Sharpener)

Control Point / Viveza 2
Control Point / DxO PhotoLab
Workflow
DxO PhotoLab

The Nik Collection by DxO is accessible to DxO PhotoLab users as a set of external applications via a dedicated button in the Image Explorer, both in the Photo Library tab and the Customize tab. In this chapter, we discuss:

- Settings
- Recommended settings
- Standard workflow

Settings

The first thing to do is to set the type of file you will transfer to one of the Nik Collection plugins:
1. At the bottom right, in the DxO PhotoLab image explorer toolbar, click on the **Nik Collection** button.

2. In the **Plugin Selector**, click **Settings**.

3. In the **Format** section, choose the file format:
   - **Action**: Choose between TIFF and JPEG format
   - **Quality** (for TIFF format): Choose from 16-bit, 8-bit, or 8-bit with compression (depth per channel, R, G, and B).
   - **Quality** (for JPEG format): Use the slider to adjust the compression level.

4. In the **Resize** section, you will determine the physical characteristics of images to be processed in the Nik Collection:
   - **Resolution**: Set to 72 ppi (dots per inch) by default, this setting has no influence on image characteristics until you specify a physical dimension (changing this value automatically activates the resize options). Indeed, if a lab or a printer asks you for 240 or 300 ppi, you will also have to resize the image (for example, a 50x75 cm print at 300 ppi).
   - **Resize the image**: Click the box to manually activate the resizing options (automatic activation when changing resolution).
   - **Maximum dimension** lets you set the dimension of the wide side of the image in pixels (px) for images intended for electronic (web) distribution, or
the physical dimensions of the wide side of the image in centimeters or inches for images intended for printing.

- **Interpolation**: Allows the use of algorithms in the case of physical enlargement of the image, with the algorithms Bicubic (default choice), Sharper Bicubic or Bilinear.

5. In the **Advanced** section, you can assign a space or color profile in the **ICC Profile** menu:

- **Original**: Default choice, keeps the original profile of the image transferred from DxO PhotoLab to the Nik Collection, and back
- **sRGB**: Select this space for general use (web, inkjet printing, minilab).
- **Adobe 1998**: Select this space for a print run at an off-set printer’s.
- **Choose Profile**: allows you to search and assign an ICC profile stored in your operating system (adds to the menu).
- **Clear Menu**: Deletes added profiles.

**Recommended settings**

For a maximum quality workflow, especially if you plan to do further processing and retouching later, or to provide documents of the highest quality:

- 16-bit TIFF format
- Do not change the resolution
- Do not resize
- Original ICC profile

For maximum quality workflow, but without considering further processing afterwards:

- Format JPEG, compression 75 à 100%.
- Do not change the resolution
- Do not resize
- Original ICC profile

For a standard workflow, without considering further processing, for Facebook broadcast, or for emailing:

- JPEG format, 70-75% compression
- Do not change the resolution
- Resize to 2048 pixels
- sRGB profile
* In general, when processing images in the Nik Collection, maintain maximum quality workflow. You will be able to modify your files afterwards, depending on their usage, during the export phase in DxO PhotoLab.

Standard workflow*

The workflow from DxO PhotoLab is very simple:

1. Process your original image in DxO PhotoLab (automatic corrections, white balance, tone, noise, etc.).

2. If you want to send a batch of images to the Nik Collection, whether it's a batch process (all plug-ins) or an HDR merge (HDR Efex Pro 2), make sure you have selected them all in the Image Explorer.

3. Click on the **Nik Collection** button.

4. In the Plugin Selector, click the button for the desired plug-in. The plug-in will open.

5. Process your image in the plug-in.

6. When finished, click **Save** on the lower right. Your processed image will return to DxO PhotoLab.

- If you start from a folder, the return image from the Nik Collection will appear next to the original with the same name, with the suffix _Nik added, the extension depending on the file format chosen in the settings.

- If you start from a project, the return image from the Nik Collection will not be directly visible, as it is not automatically assigned to that project. To view both the original and the processed image in the Nik Collection, right-click the original and select **View Image Folder**.
Selecting a Nik Collection plug-in from DxO PhotoLab.

Image Gilles Theophile
Editing in the Nik Collection (Analog Efex Pro 2).

Processed image is returned to DxO PhotoLab.
* In a standard workflow, the Nik Collection's return image processing can no longer be changed. If you want to take advantage of this feature from DxO PhotoLab, see **Non-destructive Workflow** (Nik Collection 3.0 and later only).
Adobe Lightroom Classic
The Nik Collection is one of the very first external editors made available for Adobe’s workflow program. Please note that the Nik Collection is only compatible with Lightroom Classic, as the cloud variant, Lightroom (formerly Lightroom CC), does not currently have an interface for plugins. In this section, we discuss:

- External editing preferences
- Recommended settings
- Standard workflow
- Workflow with HDR Efex Pro 2
- Non-destructive workflow

External editing preferences
To change the default settings after installing the Nik Collection or to set the files that will be transferred to the Nik Collection as desired:

1. Open the Lightroom Classic Preferences (PC: Edit menu, Mac: Lightroom Classic menu).
2. Go to the **External Editing** tab.

3. In the **Additional External Editor** section, select one of the Nik Collection plugins from the **Preset** list.

4. Choose from among the following settings:

   - **File format**: Choose TIFF, PSD, or JPEG.
   - **Color Space**: Choose ProPhoto RGB, Adobe RGB (1998), P3 Monitor, or sRGB.
   - **Depth**: Select the depth per R, G, and B channel, either 16-bit (TIFF and PSD) or 8-bit (TIFF, PSD, and JPEG).
   - **Resolution**: 240 (leave as is).
   - **Compression**: TIFF format only; LZW or ZIP methods are available to save disk space.

5. In the **Preset** menu (see step 1), the plugin name is followed by: **(modified)**. Go to the very bottom and select **Update Preset**.

6. For other plugins, repeat steps 1 to 6*

7. In the **Stack with Original** section, select the checkbox to allow the processed image to be returned to the Nik Collection with the original as an expanded stack.

8. If you wish, you can create your own suffix in the **Edit Externally File Name** section. Otherwise, the suffix _Modify will be added to the original file name to form the name of the file processed in the Nik Collection.

9. Exit Preferences (no restart required).

* You can leave the External Editing Preferences as they are, and configure the files in the dialog box that appears when transferring from Lightroom Classic to one of the Nik Collection's plugins (see the paragraph about Standard workflow below).

**Recommended settings**

For a maximum quality workflow, especially if you plan to do further processing and retouching later, or to provide documents of the highest quality:

- 16-bit TIFF format (for universality) or 16-bit PSD format (specific to a workflow with Photoshop)
- Adobe RGB Space (1998)
- Do not change the resolution

For maximum quality workflow, but no further processing planned:

- JPEG format, 75-100% compression
• sRGB space
• Do not change the resolution

For a standard workflow, with no further processing planned, for Facebook broadcast, or emailing:

• JPEG format, 65-75% compression
• sRGB space
• Do not change the resolution

* In general, when processing images in the Nik Collection, maintain maximum quality workflow. You will be able to modify your files afterwards, depending on their usage, during the export phase in Lightroom Classic.

Standard workflow
The step-by-step procedure explained here concerns exchanges between Lightroom Classic and all the plugins of the Nik Collection, with the exception of HDR Efex Pro 2 (see the HDR Efex Pro 2 sub-section below).

From a RAW file
The workflow with RAW files, as well as DNGs generated by cameras, requires the creation of a TIFF, PSD, or JPEG file, depending on the settings in Lightroom Classic’s external editing preferences (which implies output from a RAW stream):

1. Make basic corrections to your originals.
2. In a folder or collection, select one or more images.
3. Right-click, and from the cascading menus, choose Edit in and select the desired plugin.
4. In the Retouch Photo(s) with dialog box:
   • Only the Edit a Copy with Lightroom Adjustments option is available. In this case, Lightroom Classic will generate a file according to the options in the External Editing Preferences, to which it will apply any corrections made beforehand.
   • By deploying the File Copy Option arrow, you can change your external editing preferences.
5. Click on Edit. The images will open in the selected plugin.
8. Click Save. The plugin closes; your images return to Lightroom Classic, stacked with their originals in the original folder or collection, with the file name followed by the suffix set in
the Editing External Preferences.

**Selecting an external editor in Lightroom Classic**
Edit Photo with Silver Efex Pro 2

What to Edit

- **Edit a Copy with Lightroom Adjustments**
  
  *Apply the Lightroom adjustments to a copy of the file and edit that one. The copy will not contain layers or alpha channels.*

- **Edit a Copy**
  
  *Edit a Copy is not applicable to raw or Digital Negative files.*

- **Edit Original**
  
  *Edit Original is not applicable to raw or Digital Negative files.*

▼ Copy File Options

- **File Format**: TIFF
- **Color Space**: Adobe RGB (1998)
- **Bit Depth**: 16 bits/component
- **Resolution**: 240
- **Compression**: None

- [Cancel](#)
- [Edit](#)

*External editing options*
Processing an image in the selected external editor (Silver Efex Pro 2)

From a TIFF, PSD, or JPEG file

Several scenarios are possible here, as your TIFF, PSD or JPEG files may come from other sources, unless they are files that you have already processed in the Nik Collection:

1. In a folder or collection, select one or more images.

2. Right-click and, from the cascading menus, choose Edit in and then select the desired plugin.

3. In the Retouch Photo(s) with dialog box, select one of the following options:

   - **Edit copy with Lightroom corrections**: A copy of the selected file(s) will be created (and if you have corrected these files in Lightroom, the corrections will be applied to the copy or copies).

   - **Modify a copy**: The copy created will not include any corrections made in Lightroom Classic.

   - **Modify the original** transfers the selected file(s) as is, without creating a
By deploying the **File Copy Option** arrow, you can change your external editing preferences (unless you have modified the original).

4. Click on **Edit**. The images open in the selected plugin.
5. Process your images.
6. Click **Save**. The plugin closes, your images return to Lightroom Classic, stacked with their originals, in the original folder or collection, with the file name followed by the suffix set in **Edit Externally File Name** preferences.
Workflow with HDR Efex Pro 2

The workflow for merging photos with HDR Efex Pro 2 is unique and does not go through the *Edit In* cascading menu, but rather through the Export menu. There is also a more direct access. Via the Export menu

1. Make basic corrections to your originals.
2. In a folder or collection, select the images to be merged.
3. Right-click, and in the cascading menus, choose *Export* and then *Export*…
4. From the *Export* menu, you can access commands to transfer to HDR Efex Pro 2 in two ways:

   - **Export to**: From the list at the very top of the Export menu, select *HDR Efex Pro 2*.
   - **HDR Efex Pro 2 preset**: In the *Export Presets* column on the left, open the *HDR Efex Pro 2* section and click on the *HDR Efex Pro 2* preset.
5. Verify the settings or change them as desired in the **File Settings** section on the right.

6. Click on **Export** at the bottom right.

7. A dialog box prompts you to choose between processing the originals directly, or creating a copy with the Lightroom settings. Select the desired option and then click **Edit**.

8. Lightroom Classic generates the files according to the settings in step 5.

9. The **Merge Settings** window opens. Create the HDR image, edit it in HDR Efex Pro 2, and then click on **Save**, at the bottom right.

10. Lightroom Classic automatically switches to a collection labeled with the return date and time, within a collection set named HDR Efex Pro 2, to display the created image. In the original folder or collection, the HDR image is stacked with the originals, and the file name has the suffix `_HDR`. 

Selecting the images to merge
**Selecting the mode for exporting files to HDR Efex Pro 2**

**Selecting the file format**
The HDR Efex Pro 2 Merge Settings window

Processing and then saving in HDR Efex Pro 2
Direct access

To transfer images to be merged into HDR Efex Pro 2 without going through the Export menu:

1. Select the images.

2. Right-click and from the cascading menus, select **Export** and then **HDR Efex Pro 2**.

3. Follow the steps in the **Via the Export menu** section above.
Non-destructive workflow

From Lightroom Classic, you can enjoy two reversible workflows, one via Photoshop, the other via the Nik Collection.

Reversible workflow via Photoshop (smart objects)

First processing:

1. In Lightroom Classic, make basic corrections to your originals.

2. From a folder or collection, select the image(s) to be processed in the Nik Collection.

3. Right-click and, from the cascading menus, choose **Edit in** and then **Open as Smart Object in**.
Photoshop. The image will open as a smart object in Photoshop.

4. Process the image in the Nik Collection with the reversible Photoshop workflow, as explained in the chapter Workflow with Adobe Photoshop. When you return to Lightroom Classic, the processed image is stacked with the original.
Processing in the Nik Collection (Viveza 2)

Adding the smart filter to the image
Modify the processing

1. In Lightroom Classic, select the previously processed image.

2. Right-click then **Edit in** and **Edit in Adobe Photoshop** (no need to reselect the smart object command). The image will open in Photoshop.

3. Follow the procedure as explained in the **Workflow with Adobe Photoshop** [link] chapter, notably the part about how to reopen and resume processing in the Nik Collection.

4. After saving in the Nik Collection and then in Photoshop, the image returns to Classic Lightroom and its thumbnail is refreshed to show the modified processing.
Returning the image to Photoshop

Double-click on the smart filter to relaunch Viveza 2.
Changing the processing in Viveza 2

The two versions of the image processed in Viveza 2: first version on the left, second on the right
The Nik Collection non-destructive workflow

In case you don’t have Photoshop or don’t want to use it, from Lightroom Classic you can take advantage of the reversible workflow offered by the Nik Collection (from version 3.0 onwards).

For more information and to follow the steps of the reversible workflow with the Nik Collection, see the Non-destructive Workflow page in this chapter.
Serif Affinity Photo

The Serif program is an alternative to Adobe Camera Raw and Adobe Photoshop, and you can use the plugins from the Nik Collection by DxO in it, starting with version 1.8 for Affinity Photo, and version 2.5 for the Nik Collection.

Using Affinity Photo and the Nik Collection together requires a special installation procedure, which is described in the installation, activation, and uninstallation page in the System requirements chapter.

Workflow with Affinity Photo

To process your images in the Nik Collection by DxO in Affinity Photo:

1. In Affinity Photo, develop your RAW files or process your TIFF, PSD, JPEG, or other files as you normally do (basic corrections, etc.)

2. Go to Filters > Modules > Nik Collection and select the plugin you wish to work with.

3. Once you have finished working with the plug-in, click OK. The Nik Collection plug-in will apply processing and then close; the processed image is displayed in Affinity Photo.

4. If you want to return to the image at a later time, you can save it in Affinity Photo format (.afphoto extension) via the File > Save or Save as menu.

5. If you want to export your image, do so in the desired format by going to the File > Export menu.
Image: Chris Gorman

Image opened in Affinity Photo

Opening external plugins

Processing an image in the Nik Collection (Color Efex Pro 4)
Processed image returned to Affinity Photo
Standalone mode

You can use the plugins of the Nik Collection by DxO autonomously, without using a host application (Lightroom, Photoshop, etc.), so long as you use TIFF or JPEG files. Here we discuss:

- Standalone mode — PC
- Standalone mode — Mac

In standalone mode, and provided you open a TIFF file, you can use the reversible workflow available starting with version 3.0 of the Nik Collection by DxO. For more information, see the Non-destructive Workflow page in this chapter.

Standalone mode — PC

1. You can launch a Nik Collection plugin directly in one of the following ways:
   - Double-click on the icon.
   - Right-click on an image, and then in the context menu, choose Open and select a plug-in. The selected plug-in opens.

2. If you have opened the plug-in directly, without an image, go to the File > Open menu. A system dialog allows you to select an image to open.
3. Process your image as desired.
4. Click on **Save**: processing is applied to the image, and the plugin closes. The processed image remains in the same format as when you opened it (JPEG > JPEG, TIFF > TIFF).

**Standalone mode — Mac**

1. You can launch a Nik Collection plugin directly in one of the following ways:
   - Double-click on the icon.
   - Right-click on an image, and then in the context menu, choose **Open with** and select a plugin.

   The selected plug-in opens.
2. If you have opened the plug-in directly, without an image, go to the File > Open menu. A system dialog allows you to select an image to open.
3. Process your image as desired.
4. Click on **Save**: processing is applied to the image, and the plugin closes. The processed image remains in the same format as when you opened it (JPEG > JPEG, TIFF > TIFF).
Non-destructive workflow

Starting with the Nik Collection by DxO 3.0, you can take advantage of a reversible workflow, which allows you to resume or modify the processing you have done, under the following conditions:

1. Works with TIFF files only.
2. Can be used in all plugins except Perspective Efex.
3. Accessible via the following*:
   - Standalone mode
   - Workflow with DxO PhotoLab
   - Workflow with Adobe Lightroom Classic

* The reversible workflow of Nik Collection by DxO is not available in Serif Affinity Photo, nor in Adobe Photoshop, which has its own reversible workflow using dynamic objects (see the page on Workflow with Adobe Photoshop).

The principle of the reversible, non-destructive workflow is based on encapsulating a second TIFF file in the TIFF file generated during transfer from the host application to the Nik Collection (or during the workflow in standalone mode). This doubles the size of the file that contains an input TIFF, an output TIFF, and the parameters and settings applied in the Nik Collection.

To take advantage of this workflow in Standalone mode, simply check the Save & allow to resume editing (larger files) option next to the Save button.

You can access an information page about reversible flow by clicking on the ? button in the bottom right corner of the open plugin.

Non-destructive workflow with DxO PhotoLab

Perform the first processing:

1. Select a RAW, DNG or TIFF file in the Image Explorer.
2. Click on the Nik Collection button.
3. In the Selector Plugin, click Settings.
4. In the Edit in dialog box, choose Process as TIFF and export and confirm by choosing OK.
5. In the Plugin Selector, select the desired plugin (except Efex Perspective). The image will open in the selected plugin.
6. A dialog box will be displayed in two cases:
   - If it is a TIFF file, you are prompted to use the reversible workflow.
• If it is a JPEG file, you are prompted to use the TIFF format to take advantage of the reversible workflow.

• In both cases, you can select **Do not display again**.

7. Process your image.

8. Before saving, select the **Save & allow to resume editing (larger files)** checkbox. The checkbox is not active if your image is not in TIFF format.

9. Click on **Save**. Processing is applied to the image, and then the plugin closes; the process image is visible in DxO PhotoLab.
Selecting TIFF format (required for non-destructive workflow)

Information message about the non-destructive workflow
Processing the image in the Nik Collection (in this case, Analog Efex Pro 2)

Saving with the intention of further editing
Modifying the processing

1. Select the return TIFF file from the Nik Collection.
2. Click on the **Nik Collection** button.
3. In the Plugin Selector, click on **Settings**.
4. In the **Edit in** dialog box, choose **Export selected file(s) without processing** and confirm by choosing **OK**.*
5. In the **Plugin Selector**, click on the plugin you used for the first processing. (If you choose another plugin this time, its effects combine with the effects applied during the first processing.)
6. The image will open in the selected plugin.
7. Modify the processing of your image.
8. Click on **Save**. Processing is applied to the image, and then the plugin closes; the processed image is visible in DxO PhotoLab.

* Choosing this option is crucial, because if you select one of the other two, you will not be able to change the processing.

** If you want to keep the ability to repeatedly change the processing of your image,
**Workflow**

⚠️ make sure that you have checked the **Save and edit later** box.

Export selected files without processing (required for reversible workflow)

Processing modification in the plugin
Non-destructive workflow with Adobe Lightroom Classic

Performing the first processing:

1. Select a file.

2. Go to the **Edit in** cascading menu and select one of the Nik Collection plugins*.

3. In the **Edit Photo With...** dialog box, in the **File Copy Options** section, verify that the format is **TIFF**. The image will open in the selected plug-in.

4. A dialog box will be displayed in two cases:
   
   - If it is a TIFF file, you are prompted to use the reversible workflow.
   - If it is a JPEG file, you are prompted to use the TIFF format to take advantage of the reversible workflow.
   - In both cases, you can select **Do not display again**.

5. Process your image.

6. Before saving, check the **Save & allow to resume editing (larger files)** box.

7. Click **Save**. Processing is applied to the image, and then the plug-in closes. The processed image returns to Lightroom Classic, stacked with the original.

* Perspective Efex does not benefit from the reversible workflow. For HDR Efex Pro 2,
Opening the Nik Collection (Silver Efex Pro 2) from Lightroom Classic

access is via export (see Adobe Lightroom Classic page).
Lightroom Classic dialogue box showing editing options

Information message about the reversible workflow
Processing the image in Silver Efex Pro 2

Box to check for reversible workflow ("save and edit later")
Modifying the processing:

1. Select the TIFF file from the Nik Collection.

2. Go to the Edit In cascading menu and select the plugin used in the first processing.

3. In the Process Photo With... dialog box, select Edit Original or Edit Copy*. The image opens in the selected plugin.

4. Modify the image processing as desired**.

5. Make sure the Save & allow to resume editing (larger files) checkbox is checked, otherwise uncheck it if you do not plan to resume editing again**.

6. Click on Save. The processing is applied to the image, and then the plug-in closes; the processed image returns to Lightroom Classic, stacked with the original.

* The Edit Copy with Lightroom corrections option does not restore reversibility of processing.

** You can re-edit the image as many times as you like, as long as you do not uncheck the Save & allow to resume editing (larger files) box.
Selecting and opening the image in the Nik Collection (Silver Efex Pro 2)
The two options to retain for the non-destructive workflow
Modifying the processing in Silver Efex Pro 2

Processed image returned to Lightroom Classic
Workflow with Adobe Photoshop
Accessing the Nik Collection from Adobe Photoshop

In Photoshop, there are several ways to access the Nik Collection by DxO plugins, starting with the Filter menu, then the reversible workflow with smart objects and filters, and finally the special case of HDR Efex Pro 2.

- Opening an image in the Nik Collection from the Filter menu
- Launching HDR Efex Pro 2
- Converting to a smart object

Opening an image in the Nik Collection from the Filter menu

After opening your image in Photoshop*:

1. Go to the Filter menu, then go to the Nik Collection sub-menu.
2. Select one of the Nik Collection plugins. The image will open in the selected plugin.
3. Perform your processing and corrections.
4. Click on Save. The plugin applies processing and then closes, and your processed image is displayed in Photoshop.
5. Save or Save As (to create another file), then exit Photoshop.

* This procedure applies to both Photoshop and Photoshop Elements.

You can also process your images in the Nik Collection through Photoshop from your host application, such as DxO PhotoLab or Adobe Lightroom Classic. See the Workflow chapter in the relevant application pages.

Image: Chris Gorman
Accessing the Nik Collection from the Photoshop Filter menu

Processing in the Nik Collection (Silver Efex Pro 2)
Launching HDR Efex Pro 2

The case of HDR Efex Pro 2, which allows image merging, is special, and you don’t need to have the images already open in Photoshop:

1. Go to the File menu, then go to the Automate sub-menu.

2. Select Merge to HDR Efex Pro 2. HDR Efex Pro 2 will open, along with a dialog box for selecting images.

3. Click Open, which will open a system dialog box.

4. Locate and select the images you wish to merge, and then click OK. The HDR Efex Pro 2 dialog box will display a list of the selected images.

5. To remove an image from the list, click on the file name and then click on Remove.

6. The Add Open Files button allows you to select images already open in Photoshop.

7. If you wish to switch to a reversible workflow, check Create Smart Object.

8. Click on Merge Dialog. The dialog box for creating HDR files opens.

9. After selecting the options you need, click Create HDR. The images are merged, and the HDR image opens in HDR Efex Pro 2.

10. When you are finished processing, click Save. The image processed in HDR Efex Pro 2 will display in Photoshop.
* Smart objects are not available in Photoshop Elements. ** For more information on the content and options of the HDR Merge dialog box, see the Merging images page in the HDR Efex Pro 2 chapter.

Opening HDR Efex Pro 2 from Photoshop
Selecting files in HDR Efex Pro 2

Preparing to merge in HDR Efex Pro 2
Converting to a smart object

In Photoshop, a smart object* is a layer that encapsulates the original image, providing a non-
destructive and reversible workflow, and plugins in the Nik Collection by DxO are compatible with that workflow. This means you can make corrections or apply a rendering to the image, which you can modify as you wish, after saving and even after closing the applications.

Converting your image to a smart object and then processing it in a Nik Collection plugin

1. Open the image in Photoshop**.

2. In the **Filter** menu, select **Convert for Smart Filters**. A dialog box informs you that the selected layer (the background layer of your image) will be converted to a smart object (you can disable this dialog).

3. Click on **OK**. Your image is converted to a smart object, the background layer is renamed **Layer 0**, and an icon appears in the thumbnail in the **Layers** panel.

4. Go to the **Filter > Nik Collection** menu and select the desired plugin** ***. A dialog box confirms that the selected plugin has detected that it is a smart object (you can disable its display).

5. Work on your image in the selected plugin, then click **OK**. The plugin closes and the processed image is displayed in Photoshop; in the **Layers** panel, a filter effect thumbnail is displayed below Layer 0 with the name of the plugin used below it.

6. Save and exit Photoshop.
Converting to smart object
Selecting a plugin and warning message about smart objects

Processing image in Color Efex Pro 4
Re-editing your processing

1. Open the processed image in Photoshop.

2. In the **Layers** panel, double-click the plugin name below the thumbnail of the filter effect. The plugin used to process this image will open.

3. Modify or even completely reprocess the image, as you wish.

4. Click on **OK**. The plugin closes and the processed image is displayed in Photoshop.

5. Save and exit Photoshop.
Reopening the Color Efex Pro 4 smart filter

Modifying the processing in Color Efex Pro 4
Permanently applying processing

1. If it is not already the case, open the image in Photoshop.
2. In the **Layer** menu, select **Flatten Image**. The mask of the filter is Layer 0 will form only a background layer; at this point, the processing is no longer reversible.
3. Save and exit Photoshop.

* Lightroom Classic allows you to open images as smart objects in Photoshop (see the Adobe Lightroom Classic page in the **Workflow** chapter).

** Applies only to Photoshop (Photoshop Elements does not offer workflows with...
smart objects and filters).

*** HDR Efex Pro 2 can be accessed through the File > Automation menu, and offers its own option for working as a smart filter.
Selective Tool 2 and Brush tool

The Nik Collection by DxO takes your workflow and integration with Photoshop and Photoshop Elements one step further with Selective Tool 2 and the Brush tool. The Selective tool allows you to launch one of the plugins or to apply processes directly without opening a plugin, and the Brush tool allows you to apply the processes and some corrections from the suite locally in Photoshop. Here we will discuss:

- Selective Tool 2
- Brush tool

Selective Tool 2

The Selective Tool 2 is a floating palette that is part of the Nik Collection, where you will find a list of plugins, with direct access to some predefined tools and effects, as well as a communication section, where you will find information and updates.

Interface and handling

The floating palette is automatically displayed in Photoshop. You can change this behavior:
1. Park the Selective Tool at the bottom left in Photoshop: Click on the "-" (minus) sign at the top left.

2. Show the Selective Tool again: Click the window reset sign.

3. Display only the plugin icons: Click on the 3rd icon, top left (and vice-versa to restore full display).

4. Close the Selective Tool: Click on the "X".

5. Open or reopen the Selective Tool: In the File menu of Photoshop, go to Automate, then select Nik Selective Tool 2.

6. Reveal section contents: use the scroll bar, on the right, the mouse wheel or the trackpad.

7. Show/hide the contents of each section: Click on the chevron on the right.
8. Move the Selective Tool: Grab the top bar.

Preferences and help
Nik Collection Preferences

To access the Selective Tool 2 Preferences, click on the gear at the bottom left:

1. General section:
   - **Open Selective Tool automatically on launch**: Check or uncheck the box to enable / disable the automatic display of the Selective Tool when opening Photoshop (automatic display is enabled by default).

2. Filters section:
   - **Apply filter to**: Apply filters and image processing to either the composite image or the active layer.
   - **Apply Brush effect**: Apply the effects with the Brush tool to the current layer or to another layer.
• **Apply Favorite Filters, Recipes & Last Edit:** Apply Favorite filters and effects or the last edit either directly in Photoshop or by opening the relevant plugin.

**Help**
Click on the “?” button at the bottom right to access the Selective Tool 2 user guide.

**Use**
The Selective Tool allows you to perform the following operations and tasks:

- Launch one of the Nik Collection by DxO plugins.
- Apply a favorite preset, filter, or recipe, without having to open one of the plugins, which saves you time if you have many images to process.
- Apply the latest processing done with a plugin.

**For information about features specific to Dfine 2, see the Brush Tool section below.**

**Launching a plugin**

To process an image with one of the plugins of the Nik Collection while in Photoshop:
1. Go into the Selective Tool.
2. Click on one of the buttons to select a plugin.
3. The chosen plugin opens.
4. Process your image, then save it.
5. After it is returned to Photoshop, the processed image is its own layer.

**Directly applying a favorite preset, filter, or recipe:**
You can apply a preset, filter, or recipe without opening its associated plugin, as long as you have selected it as a Favorite* in the plugin**:

1. Go into the Selective Tool.

2. Click the arrow to the right of the desired plugin button. A space opens below the button, where you can choose from among your favorite presets, filters, or recipes.

3. Click on the desired preset, filter, or recipe, which is immediately applied to the image.

* To create favorites that can appear in the Selective Tool, see the specific chapters for each Nik Collection plugin.

** Perspective Efex, RAW Presharpener (Sharpener Pro 3), and Viveza 2 do not allow you to create favorites, so you will not be able to apply favorites directly from them with the Selective Tool.
Applying a Last edit:

Another time-saving feature is the ability to apply the very last edit you applied the last time you used a plugin*, without having to open the plugin:

1. Go into Selective Tool.
2. Click on the arrow to the right of the desired plugin button. A space will open below the button.
3. Click on Last edit. The most recent processing is applied to the image.

* The Last edit function is not available in Perspective Efex.

Brush tool

When using the Nik Collection by DxO in Photoshop, a Brush button is visible at the bottom of the plugin window you are currently using, next to the Undo and Save buttons. The Brush button is not visible when using the Nik Collection from a host application such as DxO PhotoLab or Adobe Lightroom Classic. It is a tool specific to Photoshop and Photoshop
Elements*. It will allow you to apply your treatments and effects locally**, painting into the image opened in Photoshop. You can apply artistic or creative effects, but the real interest of this function is to be able to make more technical corrections, such as enhancing the sharpness or reducing noise with Dfine 2 (see below).

* The Brush button activates the Brush tool in Photoshop and Photoshop Elements.

** The Brush button is not available in Efex Perspective.

Operating principles
To locally process with one of the Nik Collection plugins:

1. Open the plugin of your choice, either through the **Filter** menu in Photoshop or with **Selective Tool 2**.

2. After opening the plugin, choose the processing to apply.

3. At the bottom of the plugin window, click the **Brush** button. The plugin will close. Photoshop automatically generates a layer and a black fusion mask to paint the process (view in the **Layers** panel).
4. Photoshop’s Brush tool is activated automatically (you can set it in the options bar at the top). Paint into the image to apply the processing.

5. A floating window from the Selective Tool offers you the following options:

- **Brush** button, enabled by default, to apply the processing.
- **Eraser** button, to locally erase the processing applied with the brush.
- **Fill** button, to apply the processing to the entire image or to a selection made with one of the Photoshop tools.
- **Erase** button, to completely remove the application of processing.
- **The Apply** button, to apply the correction permanently (which also causes the layers to be flattened).
- **The Undo** button, to cancel the operation and close the floating window.

You can cumulate different uses of the brush, including with several plugins one after the other, or several times with the same plugin, but with a different or complementary treatment, by repeating the above steps. Each time you use the Brush mode, Photoshop will automatically create a layer and a black fusion mask.

**Corrections specific to Dfine 2**

Dfine 2 also comes with seven additional noise correction tools, each designed to work on specific details. These tools have no settings or parameters, as they are designed to be applied selectively, and provide optimal noise reduction for each of the different types of details or cases offered. These tools are available only in Selective Tool 2 and their use does not launch Dfine 2:
1. **Background** applies noise reduction to the background of the image.

2. **Hot Pixels** minimizes unwanted, hot, or dead pixels visible as bright spots in the image, especially in the darkest areas of the image.

3. **Fine Structures** reduces color noise and contrast noise, while preserving details such as hair and fine image structures.

4. **Skin**: Applied to the skin, it reduces both color and contrast noise and unevenness, while preserving details.

5. **Sky** reduces color noise and smoothes out artifacts that appear in the blue sky.

6. **Shadows** reduces color noise, especially in dark and dimly lit areas, preserving detail and structure.

7. **Strong Noise** is used on images taken at high sensitivity, with high levels of contrast noise, again preserving details as best as possible. It is an alternative to the selective blur technique, which affects detail and color.
Applying a Dfine 2 noise reduction filter (Strong Noise)
Analog Efex Pro 2
Analog Efex Pro 2

With the Analog Efex Pro 2 module, you can immerse yourself in the past and delight in nostalgia by simulating a large number of vintage cameras and shooting techniques, and by combining a plethora of well-designed and realistic camera and lens effects, film types, and paper prints — including their intrinsic (and often charming) flaws.
Analog Efex Pro 2 settings and help

Analog Efex Pro 2 parameters let you make a number of settings affecting the interface, GPU acceleration, and image output, and gives you access to the online user guide.

Interface settings

After launching Silver Efex Pro 2, click on the Settings button in the lower left corner. In the floating window, you can open one of the sections by clicking on its banner, starting with Interface settings:

- **Interface Language**: Allows you to choose from one of 17 languages. By default, the language selected is that of your operating system.

- **Default Preview mode**: Allows you to choose how images will be displayed when you open the app, either Display single image, or Split preview (the image is separated by a line, with Before corrections on the left, After corrections on the right), or Preview side by side (the two
versions of the image, before and after corrections, are displayed next to each other).

- **Default Background Color***: Determines the appearance of the background, white, gray, or black.

- **Default Zoom Status***: Sets the zoom value that will be applied to the image when you click the Zoom button (values from 6.25% to 400%).

*Changes take effect when you open the application the next time.*

For each of the default display options, if you select **Use last setting**, the setting from the previous session will be automatically applied.

**GPU**
The GPU (Graphics Processor Unit) section, which you can access by clicking on its banner, allows you to use your computer’s video card to perform calculations related to image processing, thus relieving the load on the main processor. To do this, check the **Use GPU for image processing** checkbox. You will also find information about your GPU’s make, model, memory, and driver version (if available) in this section.

**Image output parameters**
In this section, you can choose the settings for the output files after clicking on the **Image Output Settings** banner:

- **TIFF Compression**: Choose between **LZW*** or **ZIP*** compression methods if you want to reduce the size of your TIFF files. Otherwise, select **No Compression***.

- **TIFF saving type**: This is the method of storing image data in TIFF files. **Stripe** is the oldest and **Tiles** is newer and is designed for very large files. The Stripe setting is selected by default; leave it as is if you have no reason to change it.

- **JPEG Quality**: Adjusts the compression of JPEG files; the default setting is 80%. As you decrease the setting, with the slider to the left, the size of JPEG files will decrease, resulting in a gradual degradation of image quality.

*Both LZW and ZIP compression methods are lossless. The ZIP method produces smaller compressed files than the LZW method.*

**Improve the Nik Collection**
If you want the program to transmit usage statistics, check the dedicated box, after opening the section by clicking on its banner. These statistics, which remain anonymous, allow DxO Labs developers to evaluate how users use the program, with the aim of developing and improving the product. Click the link below the
checkbox to find out more about the improvement program (internet connection required).

To save your choices, click **OK**, otherwise click **Cancel**.

**Help**

To access the online help links, you can go to the Help menu or click on the Help button at the bottom left (Internet connection required):

- User guide
- Frequently Asked Questions (FAQs)
- Online Support (report problems and ask questions after creating a support ticket)
- DxO Academy (tutorials, videos, webinars)
- Getting Started
- Close/Open Instant Help
Analog Efex Pro 2 interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. Analog Efex Pro 2 is composed of 5 distinct elements, and includes keyboard shortcuts (see table below):

1. The upper toolbar
2. The left panel
3. The image display area
4. The right panel
5. The lower toolbar

> Keyboard Shortcuts

The upper toolbar

The top toolbar contains the tools and commands related to the display of the image and side panes.
The upper toolbar

1. **Hide or view adjustment panels**: Hide or reveal the left panel.

2. **Single image display**: Normal image display without separation and comparison.

3. **Split preview**: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the browser or with the Hand tool by pressing the spacebar.

4. **Side-by-side preview**: The version before processing is displayed on the left, the version after processing is displayed on the right. You can also display the two versions of the image one above the other by clicking on the button in between. You can also zoom and move synchronously in the two images, either with the Browser or with the Hand tool, by pressing the spacebar.

5. **Compare**: By clicking this button, you can quickly compare the before- and after-correction versions of your image. You can use this tool only in Single image display mode (2).

6. **Zoom + / Zoom -**: Set to 100% by default, lets you zoom into the image. A floating window automatically displays the enlarged zone in the image; you can move this window either by clicking on it and dragging it, or by clicking on a different part of your image. By pressing and holding the spacebar, you can also use the Hand tool to move it. To return to normal view, click on the Zoom button again. The arrow lets you access different sizes, from 6.25% to 400%. You can also use the zoom and movement functions in split preview and side-by-side display modes.

7. **Change background color**: Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid too strong a contrast between a dark image and the interface).

8. **Hide or view adjustment panels**: Hide or reveal the right panel.

* You can use the Tab key to hide/unhide the two side panes at the same time.

** To zoom in, you can also press the Spacebar, and go back to the previous size by
The left panel
The left panel contains all the filters and effects grouped under the **Cameras** section, as well as the **Custom** section, to create your own effects, and the **Imported** section, to load effects shared by other users. To use these sections, refer to the **Cameras and tools** chapter.
Analog Efex Pro 2

Copyright © 2020 DxO
The panel also includes two other sections:

1. **History**: Shows all the processing and correction steps of your image, from the top (older) to the bottom (newer). To view the image at a particular stage, click on the stage in question in the list. The selected step is displayed in yellow, all previous (top) steps are white, and all subsequent (bottom) steps are grayed out: if you make a correction at this time, the grayed out steps will be removed. The **Last filtered state** button allows you to go back to the most recent step in the history. In split or side-by-side display mode, you can move the history selector (the yellow arrow on the left edge of the section) to apply a history step to the left view.

2. **Instant Help**: This palette, which you can close by clicking on the **X**, displays information about the tools and interface elements when you hover over them with the mouse.

**The image display area**

This is where the image is displayed, on a medium gray background (which you can change by clicking the **Change Background Color** button in the top toolbar).
At the bottom right, below the image, you will find the following information:

- File name and extension
- Size in megapixels
- ISO sensitivity
- Camera used

The right panel
The right panel displays the tool sections, based on the effects and filters selected in the left panel. But there are also a number of common features:
Analog Efex Pro 2

1. BASIC ADJUSTMENTS
   - Detail Extraction: 20%
   - Brightness: 0%
   - Contrast: 25%
   - Saturation: -30%

2. Control Points
   - Add Control Point

3. DIRT & SCRATCHES
4. LENS VIGNETTE
5. FILM TYPE
6. LOUPE & HISTOGRAM
7. Vary | Save

Copyright © 2020 DxO
1. **Enable/disable the section effect:** By unchecking the box to the left of the palette name, you temporarily disable the tools and settings applied to the image so as to let you make quick comparisons. To reactivate the tools and settings, check the box.

2. **Reset all settings in this section to their default values:** Click on the curved arrow to reset all the tools and settings in the section at once.

3. Click on the section name bar or the arrow on the left to close/open the section.

4. Double-click on a slider to reset it.

5. **Control points:** See below.

6. **Vary:** Changes the settings randomly with each click, to offer you variations of the chosen effects. Press the *Shift* key at the same time for a more dramatic impact.

7. **Save:** Lets you save and name your custom settings as types that you will find in the Custom section (left pane).

### Control Points

Control points allow you to modify only certain parts of the image. Add a control point and when setting the corresponding sliders, it will only affect the objects or areas covered by the control point. In Analog Efex Pro 2, control points are used to adjust the corrections in the **Standard Settings** panel.

1. **Add Control Point:** Click on this button to add a control point. The mouse pointer changes to indicate that you can click to place the control point in the image. You can place as many control points as you want. After placing the control point on the image, you can apply and
adjust the following settings:

2. **Size**: Sets the range or radius of application of the control point. All image elements whose color, brightness, and contrast correspond to the pixels on which the control point is placed will be affected by the following corrections and settings.

3. **Detail Extraction (DE)**: Controls how much detail is accentuated. Increasing the value of this slider exaggerates details while brightening shadows and degrading highlights.

4. **Brightness (Br)**: Controls the brightness of the selected area.

5. **Contrast (Co)**: Controls the overall contrast of the selected area.

6. **Saturation (Sa)**: Controls the vividness of the colors in the selected area.

**Control Points** list allows you to manage the different control points applied to the image, presented here as a numbered list. An active control point is indicated in yellow.

1. **Switch on /off effect for all control points** disables and re-enables all control points applied to the image, as well as the associated corrections and settings.

2. **Show/hide effect of control point**: The checkbox to the left of each control point in the list lets you temporarily deactivate and reactivate the display of the concerned control point and its associated corrections and settings.
3. **Show/hide selection for all control points**: This button displays the monochrome masks for all control points. To display the mask of only one control point at a time, check the box on the right side of the list. In the monochrome mask, white indicates areas of the image where 100% correction is applied, black indicates no correction, and gray variations indicate areas more or less affected by the correction.

4. **Size**: The dotted circle indicates the size column, in %, of the radius of control point effectiveness.

5. **Group**: You can group several control points by selecting them beforehand (draw a rectangle encompassing the control points or click on it with the Ctrl/Cmd key) and then clicking on this button. In the list, the selected control points are grouped in a numbered group. When you apply a correction to one of the control points, the correction will be applied to the other control points in the group. However, you can use the size slider to adjust the size of each control point in a group independently.

6. **Ungroup**: To remove the grouping of control points, select the group from the list and press this button. All control points will be displayed as ungrouped, allowing you to delete, modify, or create new groups from individual control points.

7. **Duplicate**: Clicking this button duplicates the currently selected control point(s). You can also duplicate a control point by clicking on it with the Alt/Option key (the pointer will change to a "+") and then dragging the mouse to reposition the duplicated control point.

8. **Delete**: Click the Delete button to delete the currently selected control point(s).

**Loupe and Histogram**

The Loupe and Histogram section is also available regardless of the tools you use. To switch from one to the other, move the mouse just below the title bar to bring up the selector, then click on either function:
1. Loupe

- The preview shows a real-time magnification of 200% as you move the mouse pointer through the image.
- You can also lock the loupe to a specific place in the image: click on the pin on the right in the title bar and then click on the desired place in the image. To unlock, click the pin again.
- Regardless of whether the loupe is locked or not, you can also move around in the image after clicking in the loupe (the image displayed in the center does not move, even when zoomed in).

![Loupe & Histogram](image)

2. Histogram

- **Show clipped shadows / Show clipped highlights**: The two buttons at either end of the Loupe/Histogram mode switch can be used to display clipped shadows as a red mask (shadows that are too dense) or blue mask (highlights that have turned white).
- By default, the histogram shows all channels. By clicking in the histogram, you switch from All channels to Red, Green, Blue, Brightness, and then back to All channels.

The lower toolbar

The lower toolbar includes access to help, plugin settings, and save functions:

1. **Help** provides access to the online user guide.
2. **Settings** opens the plugin options window.
3. **Previous / Next** allows you to switch between images if you have opened more than one in the same session; and indicates the number of images.
4. **Save & resume editing** activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).
5. **Cancel** lets you cancel the current processing and corrections and closes the plugin; the image in the host application is not modified.

6. **Save** lets you saves the processing and corrections and closes the plugin; the image in the host application is modified.

* For more information, see the Settings and help page.

**For more information about the Nik Collection 3’s reversible workflow, see the chapter by the same name.

**Keyboard shortcuts**

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipped Highlights</td>
<td>Shift + H</td>
<td>Shift + H</td>
</tr>
<tr>
<td>Clipped Shadows</td>
<td>Shift + S</td>
<td>Shift + S</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
<td>Cmd + Y</td>
</tr>
<tr>
<td>Full Screen</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>Preview</td>
<td>P</td>
<td>P</td>
</tr>
<tr>
<td>Show/Hide Control Palettes</td>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td>Apply Filter</td>
<td>Enter</td>
<td>Return</td>
</tr>
<tr>
<td>Cancel Filter</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Zoom</td>
<td>Spacebar</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Ctrl + &quot;+&quot;</td>
<td>Cmd + &quot;+&quot;</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Ctrl + &quot;-&quot;</td>
<td>Cmd + &quot;-&quot;</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>Ctrl + 0</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Zoom to 100%</td>
<td>Ctrl + Alt + 0</td>
<td>Cmd + Alt + 0</td>
</tr>
<tr>
<td>Remove Control Point or Blur Point</td>
<td>Delete</td>
<td>Delete</td>
</tr>
</tbody>
</table>
Cameras types and tool combinations

The camera selector and tool combination selector in the top left corner allow you to select a camera type, or a rendering inspired by film techniques. After selection several variants of the same camera or rendering are displayed in the left pane, and the associated tools and default settings in the right pane. These cameras and renderings are:

- **Classic Camera**
- **Black and White**
- **Color Cast** offers colorization effects reminiscent of prints that have aged in photo albums.
- **Motion** applies zoom and rotation effects in the image.
- **Wet Plate**: An ancient photographic process that preceded the appearance of silver bromide negatives.
- **Subtle Bokeh**: An artistically blurred background.
- **Double Exposure**: process that consists of exposing the same view twice.
- **Toy Camera** reproduces the behaviour of lenses with significant distortion and/or
vignetting defects.

- **Vintage Camera** gives a vintage look to your photos.
- **Multilens** reproduces cameras that allow you to frame a subject in different ways in the same view.
- **En Vogue**: Renderings added by versions 2 and 2.5 of the Nik Collection by DxO.
- **Camera Kit**: Create your own camera.

For example, if you select Classic Camera, the left panel offers 9 variants or combinations that you can scroll through to select or apply to your photo. If you click Classic Camera 1, the panels shown in the right-hand panel are:

- Standard settings
- Dirt and scratches
- Lens vignetting
- Film type

And if you click on another combination on the left — for example, Classic Camera 2, the controls in the right panel will be the same, but the settings and choice of textures and other effects will be different. You can also display the tool panels as you wish, by selecting them from the **Tools/Tool Combinations** lists. To access this list, click on the arrow to the right of the camera you have selected, which opens a window with a comprehensive list of all available tools and a set of icons showing all available tool combinations.

**Vary slider**

The **Vary** button, located under the panels in the right pane, allows you to randomly change the selected effects and settings by clicking once or several times in a row.

To save your effects, recipes, and custom settings, see the **Custom camera kits and**
Basic adjustments

Use these tools to adjust the basic characteristics of the image — detail, brightness, contrast, and saturation — regardless of what camera type or tool combination you choose.

**Standard settings panel**

<table>
<thead>
<tr>
<th><strong>Detail Extraction</strong></th>
<th>Allows you to control how much detail is accentuated. Increasing the value of this slider amplifies details while lightening shadows and tamping down highlights. As a result, the tone is distributed more evenly throughout the photo.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Brightness</strong></td>
<td>Controls the overall brightness of the image.</td>
</tr>
<tr>
<td><strong>Contrast</strong></td>
<td>Controls the overall contrast of the image.</td>
</tr>
<tr>
<td><strong>Saturation</strong></td>
<td>Controls the overall saturation of colors in a photo.</td>
</tr>
<tr>
<td><strong>Control Points</strong></td>
<td>Selectively apply corrections to the various sliders in the panel and adjust their opacity.</td>
</tr>
</tbody>
</table>

**Lens distortion**

![Image](https://via.placeholder.com/150)

Image: Jad Limcaco on Unsplash

Image: Alexander Shustov on Unsplash
From the **Toy Camera** tool combination, see the optical distortion properties typical of lenses with extreme focal lengths. Apply concave or convex distortion, or the color fringes of chromatic aberrations.

**Lens Distortion panel**

<table>
<thead>
<tr>
<th><strong>Pincushion / Barrel</strong></th>
<th>Drag the slider to the left to apply concave distortion or to the right for convex distortion.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chromatic Shift</strong></td>
<td>Controls the extent to which the chromatic change appears.</td>
</tr>
<tr>
<td><strong>Chromatic Aberration</strong></td>
<td>Select the color combination for the fringes caused by chromatic aberration.</td>
</tr>
<tr>
<td><strong>Defocus</strong></td>
<td>Gradually introduces blur throughout the entire image.</td>
</tr>
</tbody>
</table>

**Bokeh**

From the **Soft Bokeh** tool combination, apply the Bokeh filter to creatively control image sharpness. Use the Insert to Image control to adjust the size and shape of the blurred area or to move the focus away from the center, if desired.

**Bokeh panel**

<table>
<thead>
<tr>
<th><strong>Bokeh Style</strong></th>
<th>Choose between elliptical or tilt/shift blur.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Blur Strength</strong></td>
<td>Determines the amount of blur applied to the photo.</td>
</tr>
<tr>
<td><strong>Optimize Highlights</strong></td>
<td>Allows you to increase the intensity of the highlights in the blurred area.</td>
</tr>
<tr>
<td><strong>Aperture Shape</strong></td>
<td>Click the arrows to choose from several shapes to apply to blurred highlights.</td>
</tr>
<tr>
<td><strong>Aperture Rotation</strong></td>
<td>Adjusts the angle at which the aperture shape is set.</td>
</tr>
</tbody>
</table>

Image: Joshua K. Jackson on Unsplash
Aperture Variation

Drag the slider to the left for a concave aperture shape or to the right for a convex aperture shape.

Zoom and rotation blur

From the **Motion** tool combination, apply a creative blur effect around the center of the image when zooming and rotating to draw the eye into the image. Use the Insert command on the image to move the focus away from the center, if desired.

**Zoom & rotate blur panel**

<table>
<thead>
<tr>
<th>Protect Center</th>
<th>Adjusts the size of the targeted center area.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom Strength</td>
<td>Controls the amount of blur applied to the image during zoom movement.</td>
</tr>
<tr>
<td>Rotate Strength</td>
<td>Controls the amount of blur applied to the image during rotational movement.</td>
</tr>
</tbody>
</table>

Directional blur

From the **Motion** tool combination, create motion, distortion, or texture in the image by making it appear as if the camera or subject is moving. Use multiple vector points to customize the appearance of the desired movement.

**Directional Blur panel**

<table>
<thead>
<tr>
<th>Blur Strength</th>
<th>Controls the amount of blur applied to the image during directional movement.</th>
</tr>
</thead>
</table>
Add a blur point

To add vector points, click **Add a blur point**, and then click in the image to insert the point. Click and drag the point at the end of the vector to change the direction or the extent of the vector. Use the **Delete** key on your keyboard to quickly delete the last inserted point.

Double exposure

Image: Kyle Brumm on Unsplash

From the **Double Exposure** tool combination, apply this filter to recreate the exclusively analog effect of two image captures in a single frame. Choose to overlay a second image on top of the first, or use the frame inlay to overlay, shift and enlarge the same image twice.

**Double Exposure panel**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Second Exposure</td>
<td>By default, the original image is duplicated and appears as a second exposure. Click the “+” button to replace it with another .tif or .jpg image instead.</td>
</tr>
<tr>
<td>Exposure</td>
<td>Protects the overall brightness and contrast of the single image generated by the double exposure.</td>
</tr>
<tr>
<td>Exposure Balance</td>
<td>Controls the opacity of the second exposure.</td>
</tr>
<tr>
<td>Zoom Strength</td>
<td>Adjusts the zoom effect of the double image.</td>
</tr>
<tr>
<td>Rotate Strength</td>
<td>Adjusts the rotation of the double image.</td>
</tr>
</tbody>
</table>

Light leaks
From the **Vintage Camera** tool combination, add light to the image, and use the Insert control on the image to customize the location of the light to vary the effect and make sure the light is placed where you want it. To vary the effect, choose between soft, sharp and precise or dynamic shapes. Use the intensity slider to adjust the overall opacity of the light, or a control point to selectively adjust the effect.

**Light Leaks panel**

<table>
<thead>
<tr>
<th><strong>Strength</strong></th>
<th>Adjusts the presence and impact of the effect applied to the image.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Effects menu</strong></td>
<td>Offers a wide selection of light leaks in three categories (Soft, Crisp, Dynamic).</td>
</tr>
<tr>
<td><strong>Control Points</strong></td>
<td>Locally applies the selected effect and adjusts its opacity.</td>
</tr>
</tbody>
</table>

**Dirt and scratches**
From the **Classic Camera** tool combination, give the impression that your photos have been developed with a negative damaged by dirt, scratches, and/or stains. Use the **Insert** control to adjust the location of marks, to vary the effect, and to make sure the texture appears exactly where you want it. Choose a **Dust and Lint**, **Scratches**, **Organic**, or **Eroded** texture, then apply it in black or white to vary the effect. Use the **Intensity** slider to adjust the overall opacity and tone of the texture, or a control point to selectively adjust or remove the effect.

**Dirt and Scratches panel**

<table>
<thead>
<tr>
<th>Strength</th>
<th>Adjusts the presence and impact of the effect applied to the image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effects menu</td>
<td>Offers a wide selection of defects in four categories (Dust and Lint, Scratches, Organic, Eroded).</td>
</tr>
<tr>
<td>Control Points</td>
<td>Locally applies the selected effect and adjusts its opacity.</td>
</tr>
</tbody>
</table>

**Photographic Plate**
From the **Wet Plate** tool combination, simulates on digital images the natural textures typical of darkroom processing. Choose a **Streaked**, **Corroded**, or **Concrete** style, then apply the texture in black or white to vary the effect. Use the **Intensity** slider to adjust the overall opacity and tone of the texture, or a control point to selectively adjust or remove the effect.

**Photographic Plate panel**

<table>
<thead>
<tr>
<th>Strength</th>
<th>Adjusts the presence and impact of the effect applied to the image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effects list</td>
<td>Offers a selection of plates in three categories (Streaked, Corroded, Concrete).</td>
</tr>
<tr>
<td>Control Points</td>
<td>Locally applies the selected effect and adjusts its opacity.</td>
</tr>
</tbody>
</table>

**Lens Vignetting**

From the **Vintage Camera** tool combination, simulates the vignetting created by different types of lenses. The darkening of the edge of the frame helps to draw the viewer's eye within the image boundaries and gives the picture more depth. Use the **Insert** command on the image to move the vignetting away from the center, if desired.

**Lens Vignette panel**
Amount | Controls the intensity of the vignetting. Move the slider to the left to add vignetting darkening to the image edges. Conversely, move the slider to the right to add lightening vignetting to the edges.

Circle / Rectangle | Controls the overall shape of the vignetting: circular or rectangular.

Size | Sets the area in the image to which vignetting is to be applied.

**Film Type**

Starting from the **Color Cast** tool combination, Film Type simulates different film styles with various colors, tones, contrasts and grain styles. You can choose between warm, cool or subtle color variations.

**Film Type panel**

| Effects list | Selects film renderings from five categories (Warm, Cool, Subtle, B&W Neutral, B&W Toned). |
| Neutral / Faded | Drag the slider to the right to give a retro fade effect. |
| Strength | Controls the degree to which the filter is applied to the photo. |
| Grain per pixel | Based on Nik’s unique Grain Engine, this slider is used to add realistic grain to the photo. Moving the slider to the left reduces the number of grain elements applied per pixel, increasing the size and visibility of the grain throughout the photo. If you don’t want to apply any grain to your photo, move the slider all the way to the right. |
| Soft / Hard | Adjusts the appearance of the grain. When the grain is coarse, the image appears more detailed and sharp. When the grain is finer, the image feels more natural. |
**Multilens**

Starting from the Multilens tool combination, instantly create a dynamic multi-border layout with multiple focal points in a single image.

**Multilens panel**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layout</strong></td>
<td>Choose the layout of your choice from a selection of five layouts and four borders.</td>
</tr>
<tr>
<td><strong>Border Color</strong></td>
<td>Apply a professional white or black border, or remove the border completely for a smooth outline.</td>
</tr>
<tr>
<td><strong>Narrow / Wide</strong></td>
<td>Controls the width of a white or black border.</td>
</tr>
<tr>
<td><strong>Vignette</strong></td>
<td>Adds a darkening effect to each border.</td>
</tr>
<tr>
<td><strong>Variation Strength</strong></td>
<td>Controls the degree of tonal variation between borders.</td>
</tr>
<tr>
<td><strong>Variation Type</strong></td>
<td>Lets you select one of five different patterns of tonal variation between borders.</td>
</tr>
</tbody>
</table>

**Frames**
From the **En Vogue** tool combination, choose a border type from styles that simulate different types of films, or possibly a more subtle streaked border from the **Filmstrip**, **White**, or **Lightbox** border collections. Use the **Scale** slider to adjust the width of the selected borders.

### Frames panel

<table>
<thead>
<tr>
<th><strong>Scale</strong></th>
<th>Allows you to reduce the thickness of the frames.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>List of effects</strong></td>
<td>Offers a wide choice of frames grouped in three categories (Filmstrip, White, Lightbox).</td>
</tr>
</tbody>
</table>

### Levels and curves
Levels and curves are among the most commonly used tools for adjusting the brightness and tone of an image. From the **Color Cast** tool combination, this filter allows you to fine-tune basic brightness and contrast.

### Levels and Curves panel

<table>
<thead>
<tr>
<th><strong>Channel</strong></th>
<th>Selects the channel for which the tone is to be set. In addition to the RGB (Red, Green, Blue) channels usually located in the Curve dialog boxes, the <strong>Levels and Curves</strong> filter also provides a brightness channel that allows you to adjust the brightness and contrast of your photo without changing the colors.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Opacity</strong></td>
<td>Controls the degree to which the filter is added to the photo.</td>
</tr>
<tr>
<td><strong>Tone curve</strong></td>
<td>Click on the curve to add anchors directly to it. To remove an anchor point, double-click it.</td>
</tr>
<tr>
<td><strong>Levels sliders</strong></td>
<td>Move the Shadows, Midtones, and/or Highlights sliders to adjust the tone ranges.</td>
</tr>
</tbody>
</table>
Custom camera kits and tools

In addition to a choice of cameras, Analog Efex Pro 2 also offers you tools that you can combine together as custom kits. You can also change tool settings and save them.

- Building a camera kit
- Importing camera kits
- Managing camera kits

Building a camera kit
To create a custom camera kit:

1. In the camera selector, in the **Build a camera** section, click on **Camera Kit**.
2. The list of tools is displayed in the left pane.
3. Moving the mouse through the list, a + (add to kit) or - (remove from kit) button appears.
4. Add or remove the tools as you wish. Your choice is visible in real time in the right pane.
5. When you have finished your choice of tools, click on **Save** in the right pane under the panels.
6. A dialog box prompts you to enter the name of your custom type.
7. Click OK to confirm.
8. Your custom camera appears in the **Custom** section of the left pane.

**Saving a variant of a kit or tool**

If you simply want to save a variant of a tool, with your own settings, click **Save**, enter an explicit name, and click OK.
Importing camera kits

1. In the title bar of the **Imported** section in the left pane, click on the + button. A system dialog box allows you to locate the location of the kit(s) to be imported.

2. Select the kit(s) to be imported and click **Open**. The kit(s) appear in the Imported section.

Managing camera kits
Bokeh + dirt + vignetting

1. My camera
2. 
3. 
4. 
5. Export All
You can export, modify, and delete custom kits in the **Custom** and **Imported** sections:

1. **rename this recipe**: Click on the recipe name below the thumbnail to activate the input field. After entering the new name, validate with the **Enter** key.

2. **click to delete this recipe**: Hover over the recipe to display the buttons embedded in the thumbnail. Click on the **X** in the upper left corner to remove the recipe from the **Custom** section. This control is only available for imported/custom presets, filters, and recipes.

3. **click to export this recipe**: Hover over the recipe to display the buttons embedded in the thumbnail. Clicking on the top right button will export the recipe for sharing. A system dialog box allows you to change the pre-entered name, and to choose the save location, before clicking on **Save**.

4. **click to update this recipe with the current settings**: Hover over the recipe to display the buttons embedded in the thumbnail. Clicking on the button in the bottom right corner will update the recipe if you make changes to the settings with the tools in the right pane.

5. **export all**: This button, located at the bottom of the panel, allows you to save all the recipes in one go in a folder (which you have created beforehand) that is accessible by a system dialog box.

* Applies only to custom kits, not to imported kits.

The terminology here may seem confusing, as it comes from **Color Efex Pro 4** and **Silver Efex Pro 2**. Here, what is called a "recipe" or "type" simply refers to camera kits.
Color Efex Pro 4
Color Efex Pro 4

The Color Efex Pro 4 module is an extensive library of filters that allows you to apply creative effects, modify them as you wish with global correction tools and control points, and even combine them to create an infinite number of special color effects.
Color Efex Pro 4 settings and help

Color Efex Pro 4 settings let you define a number of parameters affecting the interface, GPU acceleration, and image output, and gives you access to the online user guide.

Interface settings

After launching Color Efex Pro 4, click on the Settings button in the lower left corner. In the floating window, you can open one of the sections by clicking on its banner, starting with Interface settings:

- **Interface Language**: Allows you to choose from one of 17 languages. By default, the language selected is that of your operating system.

- **Default Preview Mode**: Allows you to choose how images will be displayed when you open the app, either Display single image, or Split preview (the image is separated by a line, with Before corrections on the left, After corrections on the right), or Preview side by side (the two versions of the image, before and after corrections, are displayed next to each other).

- **Default Background Color**: Determines the appearance of the background, white, gray, or
black.

- **Default Zoom State**: Sets the zoom value that will be applied to the image when you click the Zoom button (values from 6.25% to 400%).

*Changes take effect when you open the application the next time.*

For each of the default display options, if you select *Use last setting*, the setting from the previous session will be automatically applied.

**GPU**

The GPU (Graphics Processor Unit) section, which you can access by clicking on its banner, allows you to use your computer’s video card to perform calculations related to image processing, thus relieving the load on the main processor. To do this, check the *Use GPU for image processing* checkbox. You will also find information about your GPU’s make, model, memory, and driver version (if available) in this section.

**Image output parameters**

In this section, you can choose the settings for the output files after clicking on the **Image Output Settings** banner:

- **TIFF Compression**: Choose between *LZW* or *ZIP* compression methods if you want to reduce the size of your TIFF files. Otherwise, select *No Compression*.

- **TIFF Save Type**: This is the method of storing image data in TIFF files. *Stripe* is the oldest and *Tiles* is newer and is designed for very large files. The Stripe setting is selected by default; leave it as is if you have no reason to change it.

- **JPEG Quality**: Adjusts the compression of JPEG files; the default setting is 80%. As you decrease the setting, with the slider to the left, the size of JPEG files will decrease, resulting in a gradual degradation of image quality.

  * Both LZW and ZIP compression methods are lossless. The ZIP method produces smaller compressed files than the LZW method.

**Improve the Nik Collection**

If you want the program to transmit usage statistics, check the dedicated box, after opening the section by clicking on its banner. These statistics, which remain anonymous, allow DxO Labs developers to evaluate how users use the program, with the aim of developing and improving the product. Click the link below the checkbox to find out more about the improvement program (internet connection required).
**Filterlist settings**

There are six categories that allow you to rearrange the Filter Library, at the very top of the left pane, with your favorite filter lists.

> Whatever your choice, which will affect the position of 6 category blocks, the top 2 blocks, **All** and **Favorites**, will not change position.

To save your choices, click **OK**, otherwise click **Cancel**.

**Help**

To access the online help links, you can go to the Help menu or click on the Help button at the bottom left (Internet connection required):

- User guide
- Frequently Asked Questions (FAQs)
- Online Support (report problems and ask questions after creating a support ticket)
- DxO Academy (tutorials, videos, webinars)
- First steps
Color Efex Pro 4 interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. Color Efex Pro 4 is composed of 5 distinct elements, and includes keyboard shortcuts (see table below):

1. The upper toolbar
2. The left panel
3. The image display area
4. The right panel
5. The lower toolbar

> Keyboard shortcuts

The upper toolbar

The top toolbar contains the tools and commands related to the display of the image and side panels.
The upper toolbar

1. **Hide or view adjustment panels**: Hide or reveal the left panel.

2. **Single image display**: Normal image display without separation and comparison.

3. **Split preview**: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the Navigator or with the Hand tool by pressing the spacebar.

4. **Side-by-side preview**: The version before processing is displayed on the left, the version after processing is displayed on the right. You can also display the two versions of the image one above the other by clicking on the button in between. While zoomed in, you move synchronously in the two images, either with the Navigator or with the Hand tool, by pressing the spacebar.

5. **Compare**: By clicking this button, you can quickly compare the before- and after-correction versions of your image. You can use this tool only in Single image display mode (2).

6. **Zoom + / Zoom -**: Set to 100% by default, lets you zoom into the image. After you zoom in, a floating Navigator window automatically displays the enlarged zone in the image; you can move this window either by clicking on it and dragging it, or by clicking on a different part of your image. (By pressing and holding the spacebar, you can also use the Hand tool to move around in your image.) To return to normal view, click on the Zoom button again, which will also hide the Navigator window. The arrow lets you access different sizes, from 6.25% to 400%. You can also use the zoom and movement functions in split preview and side-by-side display modes.

7. **Change background color**: Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid too strong a contrast between a dark image and the interface).

8. **Hide or view adjustment panels**: Hide or reveal the right panel.

* You can use the Tab key to hide/unhide the two side panels at the same time.

** To zoom in, you can also press the Spacebar, and go back to the previous size by releasing it.
The Navigator floating window

The left panel
Filter Library and Recipes

The left panel contains all the filters and effects grouped under the Filter Library section, as well as the Recipes section for storing your own effects, and the History section, which records all the steps involved in correcting and processing images.

For a detailed description of the Filter Library and the Recipes section, refer to their respective pages.

History section
The **History** section automatically saves and shows all the processing and correction steps of your image, oldest the top (initial state) to newest at the bottom. To view the image at a particular stage, click on the stage in question in the list. The selected step is displayed in yellow, all previous (top) steps are white, and all subsequent (bottom) steps are grayed out: if you make a correction at this time, the grayed out steps will be removed. The **Last Filtered State** button allows you to go back to the most recent step in the history.
In split or side-by-side display mode, you can move the history selector (the yellow arrow on the left edge of the section) to apply a history step to the left view.

The image display area
This is where the image is displayed, on a medium gray background (which you can change by clicking the **Change background color** button in the top toolbar). At the bottom right, below the image, you will find the following information:

- File name and extension
- Size in megapixels
- ISO sensitivity
- Camera used

**The right panel**

The right panel displays the tool sections, based on the effects and filters selected in the left panel. But there are also a number of common features:
1. **Toggle the effect of the section**: By unchecking the box to the left of the palette name, you temporarily disable the tools and settings applied to the image so as to let you make quick comparisons. To reactivate the tools and settings, check the box.

2. The hamburger menu (3 stacked marks to the right of the section name) lets you access the following functions:

   - **Copy / Paste Control Points**: Allows you to duplicate control points and associated settings.
   - **Reset Filter**: Resets all section settings to 0, with the choice of whether or not to retain the control points and associated settings.

3. Click on the section name bar (triangle or arrow on the left) to close/open the section.
4. Double-click on a slider to reset it.
5. **Control points**: See below.
6. **Add Filter**: Adds an empty filter under the previous sections. To place a filter there, click in the Filter Library in the left panel.
7. **Save Recipe**: Lets you save and name your custom settings as types that you will find in the Recipes section (left pane).

### Control Points

Control points allow you to modify only certain parts of the image. Add a control point, and when setting the corresponding sliders, it will affect only the objects or areas covered by the control point. In Color Efex 4, control points are used to adjust the opacity of corrections and sliders, depending on the filter used.

![Diagram of control points and sliders](image-url)

1. **[Add]** **Control Point +**: Click on this button to add a control point. The mouse pointer
changes to indicate that you can click to place the control point in the image. You can place as many control points as you want. After placing the control point in the image, you can apply and adjust the following settings:

2. **Size**: The slider allows you to set the range or radius of the application of the control point. All image elements whose color, brightness, and contrast correspond to the pixels on which the control point is placed will be affected by the corrections and settings you apply to the point.

3. **Opacity (O)** modulates the effect of the selected filter corrections.

4. **[Negative] Control Point -**: You can also protect part of the image from sharpening by using a negative control point (you can also put and chain several of them together):

   - Click on the **Control Point -** button.
   - Adjust the radius to cover the area to be protected.
   - Set the **Opacity** slider to 0, which will act as protection and prevent correction in this part of the image.

---

**Control Points**: The Control Points section allows you to manage the different control points.
applied to the image, presented here as a numbered list. An active control point is indicated in yellow.

1. **Enable/Disable effect for all Control Points:** the switch disables and re-enables all control points applied to the image, as well as the associated corrections and settings.

2. **Show/hide effect of Control Point:** The checkbox to the left of each control point in the list lets you temporarily deactivate and reactivate the display of the concerned control point and its associated corrections and settings.

3. **Switch on/off effect for all Control Points:** This button displays the monochrome masks for all control points. To display the mask of only one control point at a time, check the box on the right side of the list. In the monochrome mask, white indicates areas of the image where 100% correction is applied, black indicates no correction, and gray variations indicate areas more or less affected by the correction.

4. **Size:** The dotted circle indicates the size column, in %, of the radius of control point effectiveness.

5. **Group:** You can group several control points by selecting them beforehand (draw a rectangle encompassing the control points or click on it with the Ctrl/Cmd key) and then clicking on this button. In the list, the selected control points are grouped in a numbered group. When you apply a correction to one of the control points, the correction will be applied to the other control points in the group. However, you can use the size slider to adjust the size of each control point in a group independently.

6. **Ungroup:** To remove the grouping of control points, select the group from the list and press this button. All control points will be displayed as ungrouped, allowing you to delete, modify, or create new groups from individual control points.

7. **Duplicate:** Clicking this button duplicates the currently selected control point(s). You can also duplicate a control point by clicking on it with the Alt/Option key (the pointer will change to a "+") and then dragging the mouse to reposition the duplicated control point.

8. **Delete:** Click the Delete button to delete the currently selected control point(s).

**Loupe and Histogram**

The Loupe and Histogram section is also available regardless of the tools you use. To switch from one to the other, move the mouse just below the title bar to bring up the selector, then click on either function:
1. **Loupe**

   - The preview shows a real-time magnification of 200% as you move the mouse pointer through the image.
   - You can also lock the loupe to a specific place in the image: click on the pin on the right in the title bar and then click on the desired place in the image. To unlock, click the pin again.
   - Regardless of whether the loupe is locked or not, you can also move around in the image after clicking in the loupe (the image displayed in the center does not move, even when zoomed in).
2. **Histogram**

- **Show clipped shadows / Show clipped highlights**: The two buttons at either end of the Loupe/Histogram mode switch can be used to display clipped shadows (shadows that are too dense) as a red mask or clipped highlights (bright areas that have turned white) as a blue mask.

- By default, the histogram shows all channels. By clicking in the histogram, you switch from All channels to Red, Green, Blue, Brightness, and then back to All channels.

**The lower toolbar**

1. **Help** provides access to the online user guide.
2. **Settings** opens the plugin options window.
3. **Previous / Next** allows you to switch between images if you have opened more than one in the same session; and indicates the number of images.
4. **Save & allow to resume editing** activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).
5. **Cancel** lets you cancel the current processing and corrections and closes the plugin; the image in the host application is not modified.
6. **Save** lets you save the processing and corrections and closes the plugin; the image in the host application is modified.

* For more information, see the **Settings and help** page.

**More information about the Nik Collection 3’s non-destructive workflow.**

### Keyboard shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipped Highlights</td>
<td>Shift + H</td>
<td>Shift + H</td>
</tr>
<tr>
<td>Clipped Shadows</td>
<td>Shift + S</td>
<td>Shift + S</td>
</tr>
<tr>
<td>Append Filter</td>
<td>Shift + Click on a Filter</td>
<td>Shift + Click on a Filter</td>
</tr>
<tr>
<td>Append Recipe</td>
<td>Shift + Click on a Recipe</td>
<td>Shift + Click on a Recipe</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
<td>Cmd + Y</td>
</tr>
<tr>
<td>Full Screen</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>Preview</td>
<td>P</td>
<td>P</td>
</tr>
<tr>
<td>Show/Hide Control Palettes</td>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td>Apply Filter</td>
<td>Enter</td>
<td>Return</td>
</tr>
<tr>
<td>Cancel Filter</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Zoom</td>
<td>Spacebar</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Ctrl + &quot;+&quot;</td>
<td>Cmd + &quot;+&quot;</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Ctrl + &quot;+&quot;</td>
<td>Cmd + &quot;+&quot;</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>Ctrl + 0</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Zoom to 100%</td>
<td>Ctrl + Alt + 0</td>
<td>Cmd + Alt + 0</td>
</tr>
<tr>
<td>Add + Control Point</td>
<td>Ctrl + Shift + A</td>
<td>Cmd + Shift + A</td>
</tr>
<tr>
<td>Function</td>
<td>Windows Key Combination</td>
<td>macOS Key Combination</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Add - Control Point</td>
<td>Ctrl + Alt + Shift + A</td>
<td>Cmd + Option + Shift + A</td>
</tr>
<tr>
<td>Delete Control Point</td>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Duplicate Control Point</td>
<td>Ctrl + D, Alt + drag, or Ctrl + C to copy and Ctrl + V to paste</td>
<td>Cmd + D, Alt + drag, or Cmd + C to copy and Cmd + V to paste</td>
</tr>
<tr>
<td>Expand/Collapse Control Point</td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>Group Control Points</td>
<td>Ctrl + G</td>
<td>Cmd + G</td>
</tr>
<tr>
<td>Ungroup Control Points</td>
<td>Ctrl + Shift + G</td>
<td>Cmd + Shift + G</td>
</tr>
</tbody>
</table>
Recipes

Color Efex Pro 4 offers an infinite choice of filters that you can combine with each other to create recipes, whose settings you can change and then save as custom filters. The Recipes section also contains a large number of predefined recipes, and you can also import and export filters and recipes for sharing.

- Recipes library
- Applying a recipe
- Adding a filter
- Saving recipes and custom filters
- Importing recipes and filters
- Managing recipes

Recipes library

Contents

The Recipes section contains all recipes of Color Efex 4, whether original, custom, or imported. Recipes are sets of filters added to each other (see below). The section consists of the following subsections:

1. **All**: Displays all recipes—original, imported, and custom.
2. **Custom**: Contains all the recipes or custom filters you have saved.
3. **Imported**: Contains all imported recipes and filters.
4. **Favorites**: Contains all the recipes you have marked as favorites.
5. **Recently used**: Contains the recipes that you have used recently.
6. **Sample recipes:** Recipes originally provided and offered by Color Efex 4.

7. **En vogue:** Includes recipes added in versions 2 and 2.5 of the Nik Collection by DxO.

### Applying a recipe

To apply a recipe:

1. Simply click on a thumbnail.

2. A dialog box warns that the selected recipe will replace the recipe and filters currently applied to the image. (Check “Yes” to close the dialog box.)

3. The recipe is applied to the image; you can change the settings in the right panel.

For example, if you apply the recipe Clarity Bump (in the En Vogue subsection), the filters displayed on the right and applied to the image include:

- Tonal Contrast*.
- Brilliance/Warmth*.
- Pro Contrast*.

Of course, even if you use recipes, you can add filters**, and save new custom recipes.

### Adding a filter

When you select a filter from the left pane of the Filter Library, its rendering and effects are applied to the image, and the associated tools and settings appear in the right pane.
If you want to add a filter or another effect to the selected filter:
1. Click the **Add** button in the right pane below the filter panel.
2. An empty Filter section immediately appears.
3. You are prompted to select a filter from the library.
4. Once selected, the corresponding filter panel and its tools are displayed, and the effect is also applied to the image.
5. If you change your mind, click the **X** button in the filter title bar to remove it. Note that you can combine as many filters as you like.

### Saving recipes and custom filters

#### Saving a custom recipe

If you make changes to a single filter that you want to save, or if you combine several filters and want to find this recipe and your own settings later:

1. Click on **Save** in the right-hand pane, under the filter panels.
2. Enter the name of your recipe in the **Custom Recipe** floating window.
3. Confirm by clicking **OK**.
4. You can now find your filter recipe in the Recipes section, which appears automatically.

### Importing filters and recipes

In the Recipes section:
1. At the very bottom, click on the **Import** button.

2. Find the location of the recipe(s) you want to import in the system dialog box.

3. Select the items you want to import and then click on **Open**.

4. You will find the imported recipes and filters in the **Imported** sub-section.

**Managing recipes**

In the Custom and Imported subsections, you can export, modify, and delete whatever custom recipes and filters you wish.
1. **Rename this recipe**: Click on the name of the recipe below the thumbnail to activate the input field. After entering the new name, press Enter.

2. **Add to favorites**: Click on the star to assign the recipe to the Favorites sub-section.
star turns yellow). Click again to remove it (the star turns white again).

3. **Click to delete this recipe**: Click to remove this recipe: Hover over the recipe to display the buttons embedded in the thumbnail. Click on the X in the upper left corner to remove the recipe.

4. **Click to export this recipe**: Hover over the recipe to display the buttons embedded in the thumbnail. Clicking on the button in the top right corner will export the recipe for sharing. A system dialog box allows you to change the name and choose the save location before you click on **Save**.

5. **Click to update this recipe with the current settings**: Hover over the type to display the buttons embedded in the thumbnail. Clicking on the button in the bottom right corner will update the recipe if you have made changes to the settings with the tools in the right pane.

6. **Export All**: This button, located at the top of the section, allows you to save all the recipes in one go in a folder that you created beforehand, and which is accessible via a system dialog.

* Applies only to custom and imported recipes and filters.
Dfine 2
Dfine 2 in noise analysis mode

Dfine 2 in noise reduction mode
Dfine 2

Compared to the other modules in the Nik Collection by DxO, Dfine 2 is the only one designed to address only one problem: digital noise. Whether it’s contrast noise or color noise, the module allows you to automatically or manually analyze your images, which you can then correct globally or selectively, using control points or color ranges.

Dfine 2 also offers specific noise correction brushes for use in Adobe Photoshop. For more information, see the Selective Tool 2 and Brush tool page in the Adobe Photoshop Workflow chapter.

For optimal performance of Dfine 2 and to avoid accumulating noise corrections that could affect image detail, we recommend disabling noise reduction, both in-camera and in your host software.
Dfine 2 settings and help

In the Dfine 2 settings, you will be able to make adjustments to the interface and noise analysis profiles, and access the online user guide.

![Settings Window](image)

**Interface settings**

After launching Dfine, click on the **Settings** button in the lower left corner. The floating window offers you the following options:

- **Default Zoom**: Sets the zoom value to apply when opening the app, either **Zoom to Fit**, which adjusts the image to the available space in the program window, or **Zoom to 100%**.

- **Default Preview Mode**: Allows you to choose how images will be displayed when you open the app, either **Display single image**, or **Split preview** (the image is separated by a line, with Before corrections on the left, After corrections on the right), or **Preview side by side** (the two versions of the image, before and after
**Default Appearance**: Determines the appearance of the background, white, gray, or black.

**Auto Profile Load Behavior**: When you open an image in Dfine 2, Dfine 2 automatically analyzes the noise in the image, with *Auto Image Profiling* as the default. You can also apply the last used profile or apply it based on the camera credentials in your EXIF metadata of the image. Finally, if you do not want automatic profiling at opening, select *Do nothing*.

**Default Profiles Path**: Dfine 2 gives you the ability to create noise analysis profiles, which are stored in a predetermined location. You can access and change this location by clicking *Browse*, which will open a system dialog box.

* Changes take effect the next time you launch Dfine 2.

---

**Improve the Nik Collection**

If you want the program to transmit usage statistics, check the dedicated box, after opening the section by clicking on its banner. These statistics, which remain anonymous, allow DxO Labs developers to evaluate how users use the program, with the aim of developing and improving the product. There is a link below the checkbox that you can click to find out more about the improvement program (internet connection required).

For each of the default display options, if you select *Use last setting*, the setting from the previous session will be automatically applied.

To save your choices, click *OK*, otherwise click *Cancel*.

---

**Help**

To access the online help links, you can go to the Help menu or click on the Help button at the bottom left (Internet connection required):

- User guide
- Frequently Asked Questions (FAQs)
- Online support (report problems and ask questions after creating a support ticket)
- DxO Academy (tutorials, videos, webinars)
Dfine 2 interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. Dfine 2 is composed of 4 distinct elements, and includes keyboard shortcuts (see table below):

1. The top toolbar
2. The image display area
3. The right pane
4. The lower toolbar

> Keyboard Shortcuts

The four elements of the Dfine 2 interface

The upper toolbar

The top toolbar contains the tools and commands related to the display of the image and side panes.
The upper toolbar

1. **Single image display**: Normal image display without separation and comparison.

2. **Split preview**: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the browser or with the Hand tool by pressing the spacebar.

3. **Side-by-side preview**: The version before processing is displayed on the left, the version after processing is displayed on the right. You can also display the two versions of the image one above the other by clicking on the button in between. You can also zoom and move synchronously in the two images, either with the Browser or with the Hand tool, by pressing the spacebar.

4. **Preview**: by checking/unchecking this box, you alternate the display of the image with and without the noise corrections. The preview works with all the display modes described below.

5. **Modes**: Dfine 2 offers several image display modes allowing you, by removing color information, to analyze and view the noise, but also the effect of corrections (best appreciated when using the comparison display modes):
   - **RGB**: Normal display of the image and its three channels — Red, Green, and Blue.
   - **Red, Green, Blue**: Displays the image without the color in one of these channels.
   - **Luminance**: Displays the brightness/contrast noise (grainy, comparable to grains of salt).
   - **Chrominance**: Displays color noise (clusters of colored pixels).
• **Contrast Noise mask**: Displays the contrast noise correction mask of a Control Point or color range (white mask: maximum correction; black mask: no correction; gray mask: correction more or less intense depending on the gray density).

• **Color Noise Mask**: Displays the color noise correction mask of a Control Point or color range (white mask: maximum correction; black mask: no correction; gray mask: more or less correction depending on the gray density).

6. **Select** lets you make a rectangular selection within the image—for example, to link together several control points or noise measurement rectangles.

7. **Zoom + / Zoom** - lets you enlarge the image, by default at 100%, using successive clicks. From 100% up to 300%, the Loupe (magnifying glass) contains a "+"; to unzoom (with the Loupe showing a "-"), press the Alt (PC)/Option (Mac) key, which transforms the Loupe + into a Loupe -. The magnification value is displayed in the upper right corner of the image.

8. **Pan** (or Hand) lets you navigate and move around in the image after zooming.

9. **Change the background color**: Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid too strong a contrast between a dark image and the interface).

The image display area
This is where the image is displayed, on a medium gray background (which you can change by clicking the Change Background Color button in the top toolbar). At the bottom right, below the image, you will find the following information:

- File name and extension
- Size in megapixels
- ISO sensitivity
- Camera used

**The right pane**

The right pane displays the Noise Reduction section, including noise analysis and correction tools (see the Measuring and reducing noise page), as well as the Loupe and Navigator combined.
Loupe: Active when the image is displayed normally:

- The red line separates the preview before correction (left) and after correction (right).
- You can move around in the preview where you want by clicking and holding the click while you move the mouse.
- You can lock the loupe at any point in the image by activating the pin and placing it in the image (you can still move it by hand).

2. Navigator: When you zoom in, the Navigator replaces the Loupe, and displays the entire image.
   You can move around the image using the red rectangle.

The lower toolbar

1. Help* provides access to the online user guide.
2. Settings* opens the plugin options window.
3. **Previous / Next**: allows you to switch between images if you have opened more than one in the same session; and indicates the number of images.

4. **Save & resume editing** activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).

5. **Cancel**: Cancels the current processing and corrections and closes the plugin; the image in the host application is not modified.

6. **Save**: Saves the processing and corrections and closes the plugin; the image in the host application is modified.

* For more information, see the Settings and help page.

**More information about the Nik Collection 3’s non-destructive workflow.

**Keyboard shortcuts**

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Tool</td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>Zoom Tool</td>
<td>Z</td>
<td>Z</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Select Zoom Tool, hold Alt and click</td>
<td>Select Zoom Tool, hold Option and click</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Ctrl + &quot;-&quot;</td>
<td>Cmd + &quot;-&quot;</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Ctrl + &quot;+&quot;</td>
<td>Cmd + &quot;+&quot;</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>Ctrl + 0</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Zoom to 100%</td>
<td>Ctrl + Alt + 0</td>
<td>Cmd + Alt + 0</td>
</tr>
<tr>
<td>Pan Tool</td>
<td>H or Spacebar</td>
<td>H or Spacebar</td>
</tr>
<tr>
<td>Apply Filter</td>
<td>Enter</td>
<td>Enter</td>
</tr>
<tr>
<td>Cancel Filter</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Delete Selected Item</td>
<td>Backspace</td>
<td>Delete</td>
</tr>
</tbody>
</table>
Measuring and reducing noise

Using Dfine 2 takes place in two steps: the automatic measurement of the noise, then the processing of the noise itself, in a global or selective way (the latter involving either control points or color ranges). Here, we discuss:

- Measuring noise
- Overall noise reduction
- Reducing noise with control points
- Reducing noise with color ranges
- Advanced tools

**IMPORTANT:** For optimal use of Dfine 2, and to avoid cumulative noise processing, disable noise correction in your camera, and most importantly, in your host application.

Dfine 2 also offers specific noise correction brushes for use in Adobe Photoshop. For more information, see the Selective Tool 2 and Brush tool page in the Adobe Photoshop Workflow chapter.

Measuring noise
As soon as you open your image, Dfine 2 will analyze it and place measurement rectangles in the image. A progress bar, in the right panel, indicates the current measurement, which can take several seconds.

Once the analysis is finished, the message **Auto profile applied** is displayed in green in the progress bar (1), and the image displays analysis rectangles or tiles, that Dfine 2 has placed in several locations (2-5).

**Noise reduction panel**

The Noise Reduction panel, in measurement mode, consists of the following parts:

1. **Mode selector**: Measure or Reduce
2. **Method selector**: Automatic or Manual

3. **Add Rectangle**: Allows you to draw analysis rectangles (visible in the Manual method section).

4. **Measure Noise**: Click to restart an analysis after reinitialization or switching to manual mode.

5. **Noise analysis progress bar**

6. **Reinitialize** lets you cancel the noise analysis (click on Measure Noise to restart an analysis).

7. **Load** allows you to load and apply noise reduction profiles.

8. **Save** allows you to create noise reduction profiles.

**Analysis rectangles**

You can modify the analysis rectangles as you wish, which means a switch to the **Manual** method:

1. Click on a rectangle to select it (the white dotted rectangle becomes red and white).
2. Use the mouse to move the rectangle where you want in the image.
3. Use the corner handles to change the size of the rectangle.
4. Duplicate a rectangle by clicking with the **Alt/Option** key held down (the pointer will show a "+" sign) then drag the mouse to detach and move the duplicated rectangle.
5. To delete a rectangle, click on it to activate it, then press the **Delete** key on your keyboard.

Any action or modification on an analysis rectangle generates the message “Profile must be updated” in the progress bar. In this case, click on the **Measure Noise** button to restart an analysis.
You can also draw your own rectangles:

1. Select **Manual** from the **Method**, drop-down menu.
2. Click on the **Add rectangle** button.
3. Draw your rectangle in the image.*
4. Redo an analysis by clicking on the **Measure Nose** button.

You can draw as many measurement rectangles as you want.

* Draw your rectangles on flat areas or in areas of the image with no details.

### Saving and loading a profile

While it is ideal to let the automatic noise measurement and correction do the work, Dfine 2 allows you to save noise measurements and corrections as profiles that you can assign to a particular camera model and ISO sensitivity.

1. To do so, click on **Save** after measuring.
2. The first time you use Dfine 2, a dialog box prompts you to create a folder in which to place your profiles. In fact, in the next dialog box, a Profiles folder is offered to you, but you can
change its name as you wish. You can also create sub-folders for each of your devices, for example.

3. The profile is automatically named with the camera model and sensitivity, retrieved in the EXIF metadata of the image, as well as the date of creation of the profile. Of course, you can change the suggested name.

4. Click on **Save** to save the profile.

### To load and apply a profile:

1. Click the **Load** button, which opens a list of your latest profiles.
2. Select a profile from the menu.
3. The profile is applied, and the name of the profile appears in green in the progress bar field.
4. If your profile is not visible among the choices in the drop-down menu, click **Browse** to locate your profile via a system dialog box.

> **If you have no profiles already loaded in Dfine 2, clicking Load will open your system browser.**

### Overall noise reduction

To access the noise reduction tools, click the **Reduce** button. First choose your reduction method (Control Points or Color Ranges, discussed further below; Control Points is the default method). Below the Method drop-down, you will find two sliders that allow you to act globally, especially if you want to adjust or resume the automatic correction:
1. **Contrast Noise**: Set to 100% by default, this slider acts on the noise that appears as grain reminiscent of analog film. Beware of too many advanced corrections which will not only excessively smooth the image, but also affect the micro details. You need to find a balance between acceptable noise presence and preservation of detail.

2. **Color Noise**: Also set to 100% by default, this slider acts on the noise that manifests itself in the form of green- and/or magenta-colored pixels, and is particularly noticeable in dark or flat areas.

**Reducing noise with control points**

*Applying and using control points*

While automatic correction generally works well for most images, the real advantage of Dfine 2 is its ability to process noise with great precision, using the control points presented here, or using the color ranges discussed in the next paragraph. In either case, you can correct noise in defined areas of the image, such as smoothing out noise visible in the sky, while protecting detail elements from excessive smoothing.
1. Choose **Control Points** from the Method drop-down in the **Reduce** section under **Noise Reduction** in the right-hand panel.

2. Under the Contrast Noise and Color Noise sliders, click the **Add Control Point +** button on the right.

3. Click in the image to place a control point on the area to be processed.

4. Adjust the radius of action of the control point with the first slider.

5. Locally correct the contrast and/or color noise with the sliders (set to 100% by default).

**Using and grouping several control points**
To correct a large area of the image, such as a sky, set additional control points and repeat the steps in the section above. You can also group the control points by activating the **Select** tool (A key), then drawing a rectangle that encompasses multiple control points. In this case, you can simply move one slider and the correction will be applied in the same way to all the others.

**Protecting using a negative control point**

You can also protect part of the image from noise reduction using a negative control point (which you can also group together):
1. In the **Reduce** panel, click on the "-" button (minus sign).

2. Click in the image to place the protection control point.

3. Adjust the radius to cover the area to be protected.

4. The sliders are set to 0 (no correction will be applied).

**Managing control points**
The Control Points list:
1. Lets you temporarily deactivate a control point by clicking on the checkbox to its left.
2. Indicates the level of correction (as a percentage) applied by each of the two control point sliders (Contrast Noise on the left, Color Noise on the right, more fully explained in Overall noise reduction above).

Duplicating a control point
There are two methods for duplicating a control point:
1. In the list of control points, click on the control point you want to duplicate and then click on Duplicate.
2. Move the mouse over the control point you want to duplicate in the image while pressing the Alt/Option key. The mouse pointer will change to a "+" sign: click and hold on the control point, then drag the duplicate where you want it.

Deleting a control point
There are several ways to delete one or more control points.
Method A:
1. In the list, click on a control point to select it.

2. To select the entire list or contiguous control points, click on the first control point and then click on the last control point with the **Shift** key.

3. To select several control points that are not adjacent to each other, click on them with the **Ctrl/Cmd** key held down.

4. Click on **Delete**.

**Method B:**

1. In the image, click on the control point you want to delete.

2. Click on **Delete** or on your keyboard’s **Backspace** key.

**Method C:**

1. To delete multiple control points in the image, activate the **Selection** tool (**A** key).

2. Draw a rectangle containing the control points to delete.

3. Click on **Delete** or on the **Backspace** key, then validate your choice in the dialog box that appears (you can deactivate its display by checking **Do not show again**).

Use the specific display modes when processing noise, in particular the monochrome masks (white: maximum application of noise reduction, black: no noise reduction), as well as the **Preview** or the **Loupe** checkbox at the bottom right. It can be helpful to zoom into the image to judge the noise reduction.

**Reducing noise with color ranges**

Another method of noise reduction is color-dependent, and requires selecting **Color Ranges** from the **Method** menu. By default, Dfine 2 offers you three ranges: red, orange, and blue, represented by tiles accompanied by an eyedropper, which will allow you to select colors directly in the image:
1. Click on an eyedropper to activate it.
2. Place it in the image, then click.
3. The corresponding color is sampled and indicated in the small tile.
4. Adjust the **Contrast Noise** and/or **Color Noise** sliders (set to 100% by default).
5. For another color, click on another eyedropper and repeat the previous steps.

To add a range of colors, click on the "+" button below the list, which will display the tile (in gray), the eyedropper, and associated sliders. You can add as many ranges as you wish, and you can remove them individually by clicking on their "-" (minus sign) button.

**Note that protection control points can be combined with color range correction.**

**Advanced tools**

When you click on the small **More** arrow under the tools, a number of additional options are revealed. These are tools for dealing with special problems inherent to noise:
1. **Edge Preservation**: Allows you to preserve the sharpness of contours, in conjunction with contrast noise reduction algorithms, to prevent excessive smoothing. Check the box to activate the tool, and then use the slider (set to 50% by default) to sharpen (to the right) or soften (to the left) the edges.

2. **JPEG Artifact Reduction**: JPEG compression tends to amplify noise reduction artifacts, which take the form of horizontal and vertical structures at the pixel level. Checking this box enables algorithms that attenuate the presence of such artifacts.

3. **Debanding**: This tool, when enabled, allows you to attenuate a form of noise from the camera's sensor, called banding. This is seen in flat, dark or solid areas of the image, either with a horizontal or vertical banding effect. Check the box, click
Horizontal or Vertical and, if necessary, change the slider setting (to 100% by default).
HDR Efex Pro 2

With the HDR Efex Pro 2 module, you can stitch and merge images shot at different exposure settings to expand the dynamic range, giving you the ability to reproduce the darkest and
brightest tones in the same image. Thanks to its 32-bit engine, HDR Efex Pro 2 opens up many creative possibilities for both surrealistic and natural renderings, as you can globally and selectively correct the resulting image using Control Points.

As access to HDR Efex Pro 2 is different from the other modules in the Nik Collection by DxO, please refer to the [host application] Workflow chapter for more information.
HDR Efex Pro 2 settings and help

Within the HDR Efex Pro 2 settings, you will be able to choose settings for the interface, ghost image processing, GPU acceleration, image output, image stacking with originals, and accessing the online user guide.

Interface settings

After launching HDR Efex Pro 2, click on the Settings button in the lower left corner. In the floating window, you can open one of the sections by clicking on its banner, starting with Interface settings:

- **Interface Language**: Allows you to choose from one of 17 languages. By default, the language selected is that of your operating system.

- **Default Preview Mode**: Allows you to choose how images will be displayed when you open the app, either Display single image, or Split preview (the image is separated by a line, with Before corrections on the left, After corrections on the right), or Preview side by side (the two versions of the image, before and after corrections, are displayed next to each other).

- **Default Background Color**: Determines the appearance of the background, white, gray, or black.

- **Default Zoom State**: Sets the zoom value that will be applied to the image when you click the Zoom button (values from 6.25% to 400%).
Alignment and reduction of ghost images

If you want, HDR Efex Pro 2 is capable of taking into account images to be merged taken freehand and/or containing moving or moving elements. It is also capable of correcting chromatic aberration.

- **Alignment**: Enables or disables the alignment of images that have not been shot on a stable, stationary surface or with a tripod.

- **Ghost Reduction**: Enables or disables the processing of elements or moving subjects in the sequence of images to be merged.

- **Ghost Reduction Strength**: There are 5 levels of ghost reduction — 20% to 100%. The higher the value, the more effective the reduction, but the presence of artifacts and noise in the image will be proportionately higher.

- **Chromatic Aberration**: Chromatic aberration occurs in the form of colored fringes along elements with strong backlighting, and this phenomenon can be amplified when merging images. You can enable or disable the correction, but we recommended that you correct this beforehand on the original images in the host program.

- **Merge Dialog Preview Quality**: The Quick and Precise options respectively allow you to generate a faster but lower quality preview or a better quality preview that will take longer.

*Changes take effect the next time you launch the application.*

For each of the default display options, if you select Use last setting, the setting from the previous session will be automatically applied.

**GPU**

The GPU (Graphics Processor Unit) section, which you can access by clicking on its banner, allows you to use your computer’s video card to perform calculations related to image processing, thus relieving the load on the main processor. To do this, check the Use GPU for image processing checkbox. You will also find information about your GPU’s make, model, memory, and driver version (if available) in this section.

**Image output settings**

In this section, you can make the settings for the output files after clicking the Image Output Settings banner:

- **Image Output Format**: You can choose from 8-bit TIFF, 16-bit TIFF, and JPG. If you select JPG, a JPEG Quality slider, set to 80% by default, allows you to adjust the compression level.

- **TIFF compression**: Choose between LZW or ZIP compression methods if you want to reduce the size of your TIFF files. Otherwise, select No compression.

*When choosing an output format, be careful not to contradict the same setting in the host*
program. If you have selected 16-bit TIFF in the host program and choose JPEG from one of the Nik Collection modules, a JPEG will be generated when saving.

** Both LZW and ZIP compression methods are lossless. The ZIP method produces smaller compressed files than the LZW method.

Stacking
The following options allow you to manage and organize the merged images back into certain applications:

- **Automatically reimport**: Returns the merged image to the host program.
- **Stack With First Image**: Stacks the merged image with the first image in the sequence when it is returned to the host application.

Improve the Nik Collection
If you want the program to transmit usage statistics, check the dedicated box, after opening the section by clicking on its banner. These statistics, which remain anonymous, allow DxO Labs developers to evaluate how users use the program, with the aim of developing and improving the product. There is a link below the checkbox that you can click to find out more about the improvement program (internet connection required).

To save your choices, click **OK**, otherwise click **Cancel**.

Help
To access the online help links, you can go to the Help menu or click on the Help button at the bottom left (Internet connection required):

- User guide
- Frequently Asked Questions (FAQs)
- Online support (report problems and ask questions after creating a support ticket)
- DxO Academy (tutorials, videos, webinars)
HDR Efex Pro 2 interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. HDR Efex Pro 2 is composed of 5 distinct elements, and includes keyboard shortcuts (see table below):

1. The upper toolbar
2. The left panel
3. The image display area
4. The right panel
5. The lower toolbar

> Keyboard shortcuts

The five elements of the HDR Efex Pro 2 interface

The preview window contains preparatory processing tools for merging; see Merging Images for more information.

The upper toolbar

The top toolbar contains the tools and commands related to the display of the image and side
panes.

1. **Hide or view adjustment panels**: Hide or reveal the left panel.

2. **Single image view**: Normal image display without separation and comparison.

3. **Split preview**: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the browser or with the Hand tool by pressing the spacebar.

4. **Side-by-side preview**: The version before processing is displayed on the left, the version after processing is displayed on the right. You can also display the two versions of the image one above the other by clicking on the button in between. You can also zoom and move synchronously in the two images, either with the Browser or with the Hand tool, by pressing the spacebar.

5. **Compare**: By clicking this button, you can quickly compare the before- and after-correction versions of your image. You can use this tool only in Single image display mode (2).

6. **Zoom + / Zoom -**: Set to 100% by default, lets you zoom into the image. After you zoom in, a floating **Navigator** window automatically displays the enlarged zone in the image; you can move this window either by clicking on it and dragging it, or by clicking on a different part of your image. (By pressing and holding the spacebar, you can also use the Hand tool to move around in your image.) To return to normal view, click on the Zoom button again, which will also hide the Navigator window. The arrow lets you access different sizes, from 6.25% to 400%. You can also use the zoom and movement functions in split preview and side-by-side display modes.

7. **Change background color**: Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid too strong a contrast between a dark image and the interface).

8. **Hide or view adjustment panels**: Hide or reveal the right panel.
* You can use the Tab key to hide/unhide the two side panes at the same time

** To zoom in, you can also press the Spacebar, and go back to the previous size by releasing it.
The left panel

The left panel contains all the filters and effects grouped under the Presets section, as well as the Custom section, for creating your own effects, and the Imported section, for loading effects shared by other users. (For the operation of these palettes, see Using and managing presets.)
The panel also includes the **History** section, which shows all the processing and correction steps of your image, from the top (older) to the bottom (newer). To view the image at a particular stage, click on the stage in question in the list. The selected step is displayed in yellow, all previous (top) steps are white, and all subsequent (bottom) steps are grayed out: if you make a correction at this time, the grayed out steps will be removed.

The **Merge Settings** button lets you return to the Merging window (see the [Merging images](#) page).
In split or side-by-side display mode, you can move the history selector, in the form of a yellow arrow on the left edge of the section (circled above), to apply a history step to the left view.

The image display area
This is where the image is displayed, on a medium gray background (which you can change by clicking the Change Background Color button in the top toolbar). At the bottom right, below the image, you will find the following information:

- File name and extension
- Size in megapixels
- ISO sensitivity
- Camera used

**The right panel**
The right panel displays the tool sections, based on the effects and filters selected in the left panel. But there are also a number of common features:
1. **Toggle the effect of the section:** By unchecking the box to the left of the palette name, you temporarily disable the tools and settings applied to the image so as to let you make quick comparisons. To reactivate the tools and settings, check the box.

2. **Reset the controls in this section:** Click on the curved arrow to reset all the tools and settings in the section at once.

3. Click on the section name bar or the arrow on the left to close/open the section.

4. Double-click on a slider to reset it.
5. **Selective adjustments**: See the [Correction tools](#) page for more details.

**Loupe and Histogram**

The Loupe and Histogram section is also available regardless of the tools you use. To switch from one to the other, move the mouse just below the title bar to bring up the selector, then click on either function:

![Loupe and Histogram](#)

1. **Loupe**

   - The preview shows a real-time magnification of 200% as you move the mouse pointer through the image.
   - You can also lock the loupe to a specific place in the image: click on the pin on the right in the title bar and then click on the desired place in the image. To unlock, click the pin again.
   - Regardless of whether the loupe is locked or not, you can also move around in the image after clicking in the loupe (the image displayed in the center does not move, even when zoomed in).

2. **Histogram**

   - **Show clipped shadows / Show clipped highlights**: The two buttons at either end of the Loupe/Histogram mode switch can be used to display clipped shadows as a red mask (shadows that are too dense) or blue mask (highlights that have turned white).
   - By default, the histogram shows all channels. By clicking in the histogram, you...
switch from All channels to Red, Green, Blue, Brightness, and then back to All channels.

The lower toolbar
The lower toolbar includes access to help, plugin settings, and save functions:

1. **Help** provides access to the online user guide.
2. **Settings** opens the plugin options window.
3. **Previous / Next** allows you to switch between images if you have opened more than one in the same session; and indicates the number of images.
4. **Save & resume editing** activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).
5. **Cancel** lets you cancel the current processing and corrections and closes the plugin; the image in the host application is not modified.
6. **Save** lets you save the processing and corrections and closes the plugin; the image in the host application is modified.

* For more information, see the **Settings and help** page.

**More information about the Nik Collection 3’s non-destructive workflow.**

### Keyboard shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipped Highlights</td>
<td>Shift + H</td>
<td>Shift + H</td>
</tr>
<tr>
<td>Clipped Shadows</td>
<td>Shift + S</td>
<td>Shift + S</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
<td>Cmd + Y</td>
</tr>
<tr>
<td>Full Screen</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>Preview</td>
<td>P</td>
<td>P</td>
</tr>
<tr>
<td>Action</td>
<td>Keyboard Shortcut</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Show/Hide Control Palettes</td>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td>Apply Filter</td>
<td>Enter</td>
<td>Return</td>
</tr>
<tr>
<td>Cancel Filter</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Zoom</td>
<td>Spacebar</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Ctrl + &quot;+&quot;</td>
<td>Cmd + &quot;+&quot;</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Ctrl + &quot;-&quot;</td>
<td>Cmd + &quot;-&quot;</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>Ctrl + 0</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Zoom to 100%</td>
<td>Ctrl + Alt + 0</td>
<td>Cmd + Alt + 0</td>
</tr>
<tr>
<td>Add Control Point</td>
<td>Ctrl + Shift + A</td>
<td>Cmd + Shift + A</td>
</tr>
<tr>
<td>Delete Control Point</td>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Duplicate Control Point</td>
<td>Ctrl + D, Alt + drag, or Ctrl + C to copy and Ctrl + V to paste</td>
<td>Cmd + D, Alt + drag, or Cmd + C to copy and Cmd + V to paste</td>
</tr>
<tr>
<td>Expand/Collapse Control Point</td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>Group Control Points</td>
<td>Ctrl + G</td>
<td>Cmd + G</td>
</tr>
<tr>
<td>Ungroup Control Points</td>
<td>Ctrl + Shift + G</td>
<td>Cmd + Shift + G</td>
</tr>
</tbody>
</table>
Merging images

Working in HDR Efex Pro 2 is a two-step process: merging images and then processing the HDR images. On this page, you will learn about image merging, which uses a special interface, the Merge Settings window, to handle a number of issues inherent in image merging. Once the original images have been merged, the HDR image will be displayed in the plugin.

- Upon image opening
- Handling problems
- Previewing and inspecting merged images
- Starting HDR merging

Accessing and using HDR Efex 2 is based on a particular workflow, especially with respect to host applications. For more information, see the Workflow chapter.

Upon image opening

After selecting images with different exposures for HDR merging, and then ordering them to be transferred to HDR Efex Pro 2, they will first open in the Merge Settings window, where you will find the following options:

1. Image thumbnails are displayed at the top of the window, and are indicated by their file name. The darkest image is on the left, the normally-exposed one is in the center, and the brightest one is on the right. (This order also applies if your series contains more or fewer
than three images: darker on the left to brighter on the right.*

2. If the distance between each image is more than 3 EV, a message will warn you that the quality of the blending may be affected, but you can still start it. Otherwise, choose images with a smaller gap, or add intermediate images.

3. An exclamation point in a yellow triangle indicates a number issues with metadata information (focal length, image size, etc.) that HDR Efex Pro 2 requires for image merging. In some cases, HDR Efex Pro 2 will still perform the merge, with automatic cropping if necessary.

1. Beneath the thumbnails, you will find a menu that allows you to manually adjust the exposure differences from one frame to the next (bracketting technique) individually, especially if for some reason HDR Efex Pro 2 does not automatically detect this information in the EXIF metadata of each image.

2. You can also set image exposure differences by batches, by choosing a value from the EV** Spacing menu located to the right. For example, if you choose 3, you will apply a 3-stop (or 3-EV) difference between the darkest image and the normal image, and then between the
normal image and the brightest image. In this case, the difference between the darkest and lightest image will be $3\,\text{EV} + 3\,\text{EV} = 6\,\text{EV}$, or 6 f-stops.

3. Each manipulation of the EV values and their differences refreshes the preview of the final image.

* If you transfer only a single image into HDR Efex Pro 2, it will open directly into HDR Efex Pro 2 without going through the merge window, in which case you will be able to work in single-image HDR mode, but with all the limitations that this imposes in terms of dynamic range.

** The notion of exposure value (EV) as expressed here, is 1 EV = 1 f-stop.

Handling problems

Prior to merging images, HDR Efex Pro 2 allows you to correct certain issues and inspect your image in the Preview. You can uncheck any of the following options in their corresponding checkboxes:

1. **Alignment**: Allows you to best align a series of images taken without a tripod.

2. **Ghost Reduction**: Algorithms detect and prevent the repetition of a moving element in the image (pedestrian, vehicle, etc.). You can select the strength of the reduction, knowing that the higher the value, the more effective it will be—but at the expense of computing time, and
with the probable appearance of artifacts or localized noise in the final image.

3. **Chromatic aberration**: Used to attenuate colored fringes along contours subject to high contrast (for example, tree branches in front of a very bright sky, and located at the edge of the image). Nevertheless, we strongly advise you to treat this phenomenon on the original files, in your host application.

* You can inspect the effect of reducing ghost images and chromatic aberration in the preview of the merged image (see below).

### Previewing and inspecting merged images

A preview of the image after the HDR merge is available in the interface. The image’s appearance will vary depending on the manual settings of the EV deviations.

The **Adjust the exposure of the preview** slider just below the preview image lets you adjust the EV values at each end of the scale. To see the darkest image, move the slider all the way to the left, and for the lightest image, move the slider all the way to the right; you can view any of the intermediate images along the gamut.

You can use slider to darken or lighten the image to inspect for ghost images and chromatic aberration after clicking the **Loupe** button:
1. Move the loupe in the image and then use the red rectangle to position it where you want. As soon as you are positioned, the portion of the image in the red rectangle is displayed in the loupe.

2. You can change the display mode at the top of the loupe by clicking either Ghost Reduction or Chromatic Aberration (the active mode is indicated in yellow).

3. To close the loupe, click on the Loupe button.

* The slider adjusts only the brightness of the preview image; it has no influence on the merged result.

Starting HDR merging

Once you have adjusted your settings, all you have to do is start merging the images by clicking on Create HDR. You will immediately switch to the HDR Efex Pro 2 interface, with a progress bar indicating that processing is in progress.

If you wish to return to the Merge Settings window, especially to change your settings:
1. Go to the History section in the left pane.

2. Click on the **Merge Settings** button at the top of the section.
Using and managing presets

Presets Library

The Preset Library is a collection of effects available for HDR Efex Pro 2, with thumbnails displaying the effect of each style on the active image. Presets are a quick way to learn and use HDR Efex Pro 2, while providing a starting point for creating custom presets that you can then apply to your image with a single click.

Preset categories

Predefined categories allow you to filter the presets provided. By clicking on a category, only the presets in that category will be displayed. Click on the All category to display all presets again. The categories are:
<table>
<thead>
<tr>
<th>PRESET LIBRARY</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL (40)</td>
<td>REALISTIC (9)</td>
</tr>
<tr>
<td>ARCHITECTURE (4)</td>
<td>LANDSCAPE (4)</td>
</tr>
<tr>
<td>ARTISTIC (6)</td>
<td>SURREAL (5)</td>
</tr>
<tr>
<td>RECENTLY USED</td>
<td>FAVORITES (1)</td>
</tr>
<tr>
<td>EN VOGUE (12)</td>
<td></td>
</tr>
</tbody>
</table>

**Search Results (40)**

1. **01 - Default**
2. **02 - Balanced**
3. **03 - Deep 1**
4. **04 - Deep 2**
- **All**: Displays all available presets.
- **Realistic**
- **Architecture**
- **Landscape**
- **Artistic**
- **Surreal**
- **Recently used**: Displays the last presets you tried or used.
- **Favorites**: Displays your favorite presets (see below about adding to favorites).
- **En vogue**: Collection of presets introduced by Nik Collection versions 2 and 2.5.

### Add to favorites

By clicking on the star next to a preset, you will assign it to the Favorites category. To deselect a preset as a favorite, click on its star again (white star: not a favorite preset, yellow star: a favorite preset).

### Custom section

This library stores all your custom presets, separating them from the presets included in the software and to facilitate your own workflow. Custom presets include your own settings, recipes and effects, which you can also share with other Nik Collection users—and vice versa!
1. **Create a new custom preset based on the current photo status (+ button):** Click this button to save current corrections as a custom preset. After naming the preset, the thumbnail will be added to the **Custom** section for later use.

2. **Rename this preset:** Click on the preset name below the thumbnail to activate the input field. After entering the new name, validate with the **Enter** key.

3. **Add to Favorites:** Click on the white star to assign the preset to the Favorites section of the preset library (the star turns yellow). Click again to remove it (the star turns white again).

4. **Click to remove this preset:** Hover over the preset to display the buttons embedded in the thumbnail. Click on the X in the upper left corner to remove the preset from the **Custom** section. This control is only available for imported/custom presets.

5. **Click to export this preset:** Hover over the preset to display the buttons embedded in the thumbnail. Clicking on the top right button will export the preset for sharing. A system dialog box allows you to change the pre-entered name, and to choose the save location, before clicking on **Save**.

6. **Click to update this preset with the current settings:** Hover over the preset to display the buttons embedded in the thumbnail. Clicking on the button in the bottom right corner will update the preset if you make changes to the settings with the tools in the right pane.

7. **Export all:** This button, located at the very bottom of the panel, allows you to save all the
presets in one go in a folder (which you have created beforehand) that is accessible by a system dialog box.

* These commands are available only for custom presets, and not for the presets delivered with the plugin.

**Imported section**
This library is a collection of presets provided to you by another user or downloaded from the Internet.

1. **Import a preset from your computer** (+ button): When you click on this button, a system dialog box opens, where you can locate the presets to be imported. After selecting them, click **Open**. The imported presets will appear as thumbnails in the **Imported** section.

2. **Click to remove this preset**: Hover over the preset to display the buttons embedded in the thumbnail. Click on the X in the upper left corner to remove the preset from the **Custom** section. This control is only available for imported/custom presets.

3. **Click to export this preset**: Hover over the preset to display the buttons embedded in the thumbnail. Clicking on the top right button will export the preset for sharing. A system dialog box allows you to change the pre-entered name, and to choose the save location, before clicking on **Save**.

4. **Export all**: This button, located at the very bottom of the panel, allows you to save all the presets in one go in a folder (which you have created beforehand) accessible by a system dialog box.

* These commands are only available for custom presets, and not for the presets
delivered with the plugin. Note that you cannot update or rename imported presets. To do so, apply them, change the settings, and then save as a new preset.
Correction tools

HDR Efex Pro 2’s correction tools allow you to go far beyond simply choosing a predefined HDR rendition. You will be able to alter the HDR method, tone compression, tonality, color, and also make localized adjustments using control points. On this page, we discuss:

- Tone compression
- Tonality
- Color
- Selective settings
- Finishing

The HDR processing engine in HDR Efex Pro 2 is 32-bit end-to-end (compared to 16-bit RAW, TIFF, and 8-bit JPEG files).

Global adjustments

After merging then opening your HDR image, the program applies a default rendering (type 01 - Default), and from there you can:

- Apply one of the types offered by the HDR Efex Pro 2 library and save.
- Start with the default type and apply your own corrections.
- Apply another type and modify it.

For the last two cases, tools are available in the right pane that allow you to act on tone
compression, tone, and color; assign selective corrections with control points; and apply some finishing effects.
Tone compression

Use tone compression to reduce wide variations in brightness, to restore detail and information in the dynamic range of the image, and to give the image a special appearance by combining the following settings:
1. **Tone Compression***: Adjusts the brightness of different tones relative to each other.

2. **Method Strength***: Modulates the combined effect of the HDR method settings (below) and tone compression settings.

3. **HDR Method***: Depending on the type you initially select, HDR Efex Pro 2 will apply different levels to the following settings:

   - **Depth** affects the overall impact of HDR rendering with the Off, Subtle, Normal, Strong settings.
   - **Detail** reinforces the level of detail to extremes with the settings Soft, Realistic, Accentuated, Detailed, and Grungy settings.
   - **Drama** also enhances the contrast of details to extreme levels with the Flat, Natural, Deep, Dingy, Sharp, and Grainy settings.

* First select your HDR method settings, then your tone compression settings, and finally adjust the intensity of the method (work in the 3-1-2 direction of the above points).

**Tonality**

The sliders in the Tonality panel allow you to correct the overall brightness and contrast of your image, and enhance the presence of details and textures:
1. **Exposure** adjusts the overall brightness of the image, darker to the left, brighter to the right, with the ability to intervene more finely at the end of the spectrum using the following two sliders:

   - **Shadows** corrects the brightness of the darkest tones in the image.
   - **Highlights** corrects the brightness of the lightest tones in the image.

2. **Contrast**: acts on the differences in brightness by giving the image a flat aspect to the left (reducing the differences in brightness between dark and light tones), or a highly-modeled aspect to the right (amplifying the differences in brightness, with denser dark tones and more brightness in the light tones). You can fine-tune the contrast settings with these two sliders:

   - **Blacks**: To the right, subtly lightens the dark areas and recovers more details; to the left, deepens the density of the dark areas.
   - **Whites**: To the left, subtly darkens the details of the light areas; to the right, makes details in light areas brighter.

3. **Structure**: To the right, reinforces small details and textures in the image; to the left, diffuses details and textures.

**Color**

In the Color panel, you can warm up or cool down your image, and reduce or enhance the overall brightness of the colors:
1. **Saturation** makes colors more vivid by moving the slider to the right, or gradually removes colors by moving to the left, until you get a grayscale image.

2. **Temperature** uses the same white balance principle found in all photo software: warm the image to the right (insert yellow), and cool it to the left (insert blue).

3. **Tint** compensates for possible color drifts (green on one side, magenta on the other), after adjusting the temperature.

### Selective adjustments

Selective adjustments allow only certain parts of the image to be changed. Add a control point, and slider settings for that point will only affect the objects or areas within the radius of the control point. In HDR Efex Pro 2, the control points take over the global settings, along with the ability to modulate the chosen HDR method.

You will find more information and details on the operation of control points in the dedicated chapter.

### Control points
1. **Control Points**: Click this button to add a control point. The mouse pointer changes to indicate that you can click to place the control point in the image. You can place as many control points as you want. After placing the control point on the image, you can apply and adjust the following settings:

2. **Size**: The slider adjusts the range or radius of application of the control point. All image elements whose color, brightness, and contrast correspond to the pixels on which the control point is placed will be affected by the following corrections and adjustments.

3. After placing the control point on the image, you can apply and adjust the following settings:

   - **Exposure (Ex)**: Changes the brightness of the selected area or object.
   - **Contrast (Co)**: Changes the contrast of the selected area or object.
   - **Saturation (Sa)**: Adjusts the color brightness of the selected area or object.
   - **Structure (St)**: Reinforces or attenuates the structure (reproduction of details and textures) of the selected area or object.
   - **Blacks (Bk)**: Increases or decreases the shadow density of the selected object or area.
   - **Whites (Wh)**: Increases or decreases the brightness of the highlights of the selected object or area.
   - **Temperature (Te)**: Warms (to yellow) or cools (to blue) the selected object or area.
• **Tint (Ti):** Compensates for possible color drifts (green on one side, magenta on the other).

• **Method Strength (MS)**: reinforces or attenuates the previously selected HDR method.

* You adjust the HDR method and tone compression settings with this slider, but you cannot change the type of HDR method or the type of tone compression with this slider.

4. The small triangle located under the first 4 sliders (Ex, Co, Sa, St) reveals or hides the other sliders of the control point.

**Selective adjustments section**

The Selective adjustments section allows you to manage the different control points applied to the image, presented here as a numbered list. An active control point is indicated in yellow.

1. **Enable/Disable effect for all control points:** the switch disables and re-enables all control points applied to the image, as well as the associated corrections and settings.

2. **Show/Hide the effect of the control point:** The checkbox to the left of each control point in the list lets you temporarily deactivate and reactivate the display of the concerned control point and its associated corrections and settings.

3. **Show/Hide selection for all control points:** This button displays the monochrome masks for all control points. To display the mask of only one control point at a time, check the box on the right side of the list. In the monochrome mask, white indicates areas of the image where 100% correction is applied, black indicates no correction, and gray variations indicate areas more or less affected by the correction.

4. **Size:** The dotted circle indicates the size column, in %, of the radius of control point effectiveness.
5. **Group**: You can group several control points by selecting them beforehand (draw a rectangle encompassing the control points or click on it with the Ctrl/Cmd key) and then clicking on this button. In the list, the selected control points are grouped in a numbered group. When you apply a correction to one of the control points, the correction will be applied to the other control points in the group. However, you can use the size slider to adjust the size of each control point in a group independently.

6. **Ungroup**: To remove the grouping of control points, select the group from the list and press this button. All control points will be displayed as ungrouped, allowing you to delete, modify, or create new groups from individual control points.

7. **Duplicate**: Clicking this button duplicates the currently selected control point(s). You can also duplicate a control point by clicking on it with the Alt/Option key (the pointer will change to a "+") and then dragging the mouse to reposition the duplicated control point.

8. **Delete**: Click the Delete button to delete the currently selected control point(s).

---

**Finishing adjustments**

The **Finishing** section is purely creative, allowing you to apply vignetting effects and neutral density, and to use the curve to take contrast further.
1. **Vignette** section tools allow you to apply an effect to darken or lighten the edges of the image, to give it a vintage effect or to focus attention on the subject:

   - **Vignette** (drop-down menu): Set by default to Off (no vignetting), move the mouse over the list to see the effect on your image in real time. To select an effect and apply it, click on it.
   - **Place Center**: Click the button to position an off-center vignetting effect. The
mouse pointer will change to a "+" that you then click to place in the image. If you want to change the positioning, click the button again and start over.

- **Quantity** controls the amount of vignetting. Moving this slider to the left darkens the edges of the image, and moving it to the right lightens them.
- **Circle** controls the overall shape of the vignetting, between circular and rectangular.
- **Size** adjusts the extent of the vignetting effect in the image.

![Black Frame 1 vignetting effect.](image)

2. **Graduated Neutral Density** applies more or less density to the upper and lower areas of the image without altering the colors:

- **Upper Tonality** acts on the density, lighter or denser, in the upper 2/3 of the image.
- **Lower Tonality** acts on the density, lighter or denser, in the lower 2/3 of the image.
- **Blend** controls the transition (0% sharp, 100% diffuse) between the image and the edge of the upper or lower tones.
- **Vertical Shift** allows you to extend or reduce the density effect.
- **Rotation** controls the rotation angle of the effect.
3. Levels and curves (section): The curve allows you to refine or completely rework the contrast of your images, either by using a predefined curve or by acting on the curve and level sliders:

- **Levels and curves** (menu): Set to Neutral by default, this menu allows you to select contrast, silver film contrast, or color curve presets. You can configure the curve as you wish and you can change the settings.

- **Channel**: Set to RGB by default (RGB: Red, Green, Blue, = RGB: Red, Green, Blue), this menu allows you to select the channel for which the tone should be set. In addition to the RGB channels, there is also a Luminosity channel that lets you adjust the brightness and contrast of your photo without changing the colors.

- **Tone curve**: Click on the curve to adjust it, and add anchor points, which will allow you to lock the contrast settings at specific points on the curve, and thus on the image. To remove an anchor point, double-click on it.

- **Levels sliders** let you adjust the extent of Shadows (left), Midtones (center), and Highlights.
Perspective Efex
Perspective Efex

The Efex Perspective module allows you to correct geometric problems such as perspective (for example, lines that are not parallel but should be) and volume distortion (stretching of elements at the edges of an image taken with a wide-angle lens). It also allows you to create miniature effects.

Perspective Efex is based on DxO ViewPoint, from which it takes all of the tools, and also allows you to take advantage of the efficiency of DxO Optics Modules to correct vignetting, distortion, and chromatic aberration.
Perspective Efex settings and help
The Efex Perspective Preferences allow you to set the language and interface elements, and give you access to the online user guide.

Preferences
After launching Perspective Efex, go into the Perspective Efex menu and select Preferences from the drop-down menu. In Preferences, you can choose the following options or settings:

- **Language**: Allows you to choose from one of 4 languages. By default, the language selected is the language of your operating system.

- **Background color**: Adjusts the gray level of the background to your liking, from white to black.

- **Overlay grid size**: Adjusts the size of the grid squares; the default value is 50.
• **Display image size**: Permanently displays the width x height of the image in pixels in the bottom right corner of the desktop.

• **Automatically check for updates every 24 hours**: If the option is deactivated, you can make an immediate search by clicking on the link.

• **I agree to participate anonymously in the Product Improvement Program**: By clicking on the link, you open a web page with more information (DxO Labs evaluates how users use the program, with the aim of developing and improving the product).

• **Send crash reports**: In the event of an incident or crash, a diagnostic log is automatically generated and sent to DxO Labs for investigation.

  *Internet connection required.*

To save your choices, click **Save**, otherwise click **Cancel**. No restart is required for the changes to take effect.

**Help**

To access the online help links, go to the Help menu (Internet connection required), where you will find:

- Online user guide
- DxO Academy (tutorials, videos, webinars)
- Visit website (for DxO Labs)
- Check for updates
- Activate the product
Perspective Efex interface

On this page you will find a description of the Perspective Efex interface:

- **Interface and layout**
- **Toolbars**
- **Palettes**
- **Keyboard shortcuts**

### Interface and layout

Because Perspective Efex borrows many of the same tools and corrections as found in DxO ViewPoint, its interface and layout is somewhat different from other Nik Collection modules. This said, the Perspective Efex is composed of five principal parts:

1. The top toolbar
2. The image display area
3. The lower toolbar(s)
4. The correction palette
5. The loupe

### Toolbars
The upper toolbar

Located at the top of the Perspective Efex window, it includes tools for opening and saving files, as well as different display and navigation modes.

1. **Display before and after correction side by side**: Display the image before correction (left) and after correction (right) at the same time.

2. **Display the image before and after correction one behind the other***: Click the left mouse button to display the before and after corrections one after the other.

3. **Fit to screen**: The image is displayed in its entirety, taking up all the available space in the display window.

4. **Display at 100%**: the image is 100% enlarged (1 image pixel = 1 screen pixel).

5. **Compare with original image**: Hold the button for a quick comparison with the original image. (Release to return to regular display.)

6. **Show or Hide Overlay Grid**: Enables or disables the display of the overlay grid in the image.

*You can also toggle the image before and after correction with the D key.

**To zoom in the image, use the mouse wheel, and navigate with the Hand tool that replaces the mouse pointer.

The lower toolbar

Perspective Tool (upper) / Crop Tool (lower)

Depending on the correction tool you have selected and activated in one of the side panels, this bar is displayed at the bottom of the program window and includes the following commands:

1. **Selected tool**: The icon is a simple reminder of the tool activated in a side palette.

2. **Line color**: Click on the small blue tile (default color) to open a system color chart that allows you to choose the color of the perspective and horizon correction lines, to improve their visibility in relation to the displayed image. (Note that this command is not available
with the Crop tool.)

3. **Show Grid**: Available only with the Crop tool, this button activates or deactivates the display of the grid superimposed in the image.

4. **Mask Opacity**: Available only with the Crop tool, this slider lightens or darkens parts of the image that are outside the cropped area.

5. **Preview**: Available only with the Perspective and Horizon tools, this tool lets you update the image content after making corrections.

6. **Reset**: Cancels all corrections made and returns to the original image.

7. **Apply**: Applies the corrections and closes the lower toolbar.

**Secondary lower toolbar**

![Secondary lower toolbar]

In the plugin version of Perspective Efex, a second bar (under the first) is located at the very bottom of the window with the following commands:

1. **Preferences**: Opens the program settings dialog window.

2. **Help**: Accesses the Efex Perspective online help (Internet connection required).

3. **Exit**: Exits Perspective Efex, but a dialog box will first ask whether you wish to save changes or not. The **Cancel** option closes the dialog box and allows you to remain in Perspective Efex.

4. **Save**: Applies the corrections permanently and then closes the plugin before returning to the host application.

**Palettes**

**Correction tool palettes**

We will discuss the operation of the different correction tools — Distortion, Volume Distortion, Perspective, Horizon, Cropping and Miniature Effect — in more detail in the appropriate sections. Here we present the general operation of these palettes and the controls they have in common.
1. **Reset all**: Cancels all corrections and returns to the original image. See **Reset correction** below.

2. **Expand or hide palettes**: Each palette has a number of controls and sliders. To unfold them, click on the arrow-shaped icon in the upper left corner of the relevant sections. Follow the same procedure to hide them.

3. **Enable / disable palette**: The button indicates the palette’s operating status (left and grey: disabled; right and blue: enabled). Click on the palette to temporarily activate or deactivate it and its associated corrections.

4. **Hide tools**: When the entire contents of a palette is expanded (all tools and sliders showing), you can return to the standard view by clicking on the "-" (minus) sign at the bottom right of each palette.

5. **Reset correction**: Each tool in a palette has a reset button.

6. **Hide / show palettes**: Click to hide or reveal the side panel.
### Keyboard shortcuts

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows</th>
<th>OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit display to screen</td>
<td>F3</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Display at 100%</td>
<td>F4</td>
<td>Cmd + 1</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Ctrl + +</td>
<td>Cmd + +</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Ctrl + -</td>
<td>Cmd + -</td>
</tr>
<tr>
<td>Hand tool</td>
<td>H or spacebar</td>
<td>H or spacebar</td>
</tr>
<tr>
<td>Crop tool</td>
<td>C</td>
<td>C</td>
</tr>
<tr>
<td>Show/Hide superimposed grid</td>
<td>G</td>
<td>G</td>
</tr>
<tr>
<td>Move anchor points</td>
<td>Arrows</td>
<td>Arrows</td>
</tr>
<tr>
<td>Toggle between anchor points</td>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td>Quit</td>
<td>Alt + F4</td>
<td>Cmd + Q</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
<td>Cmd + Shift + Z</td>
</tr>
<tr>
<td>Preferences</td>
<td>Ctrl + Shift + P</td>
<td>Cmd + ,</td>
</tr>
<tr>
<td>Show image before and after correction</td>
<td>Ctrl + D</td>
<td>Cmd + D</td>
</tr>
<tr>
<td>Full screen</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>Exit full screen mode</td>
<td>F or Esc</td>
<td>F or Esc</td>
</tr>
<tr>
<td>Show/Hide controls</td>
<td>F9</td>
<td>Tab</td>
</tr>
<tr>
<td>Online help</td>
<td>F1</td>
<td>Cmd + /</td>
</tr>
<tr>
<td>Slow mode for Perspective and Horizon tools</td>
<td>Press on Shift while placing anchor points on the image</td>
<td>Press on Shift while placing anchor points on the image</td>
</tr>
</tbody>
</table>
Downloading and installing DxO Optics Modules

When you choose automatic distortion correction, a dialogue box about managing DxO Optics Modules will open. This dialogue box indicates which DxO Optics Module(s) can be used, allows you to choose among the appropriate DxO Optics Modules available if there is any ambiguity — that is, if DxO ViewPoint cannot fully identify the camera/lens combination you used to take the shot.

The Distortion palette after installing the DxO Optics Module

The same dialogue box also displays the status of the appropriate available DxO Optics Modules — Installed, Update available, or Download.  
1. Select the DxO Optics Module you want to use and then click on OK.
2. If you are downloading an updated version or a new module, you will see a progress bar. As soon as the download is finished, the installation will be immediately effected and taken into account. You will not need to restart the application.

When a DxO Optics Module is not available

If no DxO Optics Module is available for your equipment, the **Auto** button is deactivated. In this case, you can manually correct your image.

You can eliminate the DxO Optics Module you are using for processing an image by clicking on the trash can icon located in the upper right of the Distortion palette.
Correcting distortion

- About distortion
- Applying an automatic distortion correction
- Applying an automatic distortion correction when EXIF metadata is lost
- Manually correcting distortion

About distortion

All lenses are more or less affected by distortion, which takes two principal forms:

- Barrel: Lines are curved toward the exterior of the image.
- Pincushion: Lines are curved toward the interior of the image.
Some lenses are affected by both phenomena — for example, a zoom lens can display a barrel distortion at its shortest focal length, and a pincushion distortion at its longest focal length... not counting all the distortion variations at intermediate focal lengths.

Since Perspective Efex relies on DxO Optics Modules to correct distortion, we recommend that you do not use lens correction tools from host applications or from your camera body.

Perspective Efex allows you to correct distortion for all lenses, either automatically, using DxO Optic Modules, or manually, if there is no DxO Optics Module for your camera hardware (body and lens). You can also correct images that you take with fisheye lenses, either automatically or manually, to remove or tamp down circular distortion.

### Applying an automatic distortion correction

If your material is supported by a DxO Optics Module, you can correct your image automatically.

1. From your host application, open the image in Perspective Efex.
2. Click on **Auto** in the Distortion palette. A dialogue box will indicate if a DxO Optics Module for your equipment is already installed, or if not, whether it is available for downloading.
3. Click on **OK** to correct the image using the selected DxO Optics Module and to close the
dialogue box.

When a DxO Optics Module is installed and taken into account, the Distortion palette displays the following information: camera model used, lens model used, and the name of the original image file.

**Applying an automatic correction if the EXIF data is lost**

If Perspective Efex does not find the necessary EXIF metadata information, a dialogue box will offer to find the original image in order to retrieve the missing information. This said, certain programs modify and sometimes eliminate the EXIF data necessary for Perspective Efex to determine the proper DxO Optics Module to use.

From your host application, open the image in Perspective Efex.

1. If a dialogue box in the Distortion palette requests access to the original file, click on **Open** original image.

2. To find the original image, click on **Open** in the dialog box that appears at the top of Perspective Efex: a system dialogue box will open. You will need to find the JPEG or RAW image file that was loaded directly from your camera before processing.

3. After finding and selecting the original image, validate by clicking on **Open**. If the corresponding DxO Optics Module is not already installed, a new dialogue box will open and prompt you to download it (if available); otherwise it will display the information about the shooting equipment and the name of the original file.

4. After you have applied your corrections, click on the **Save** button on the lower right. Perspective Efex will close and the corrected file will be transferred back to the host application.

   **If your image file does not contain the necessary EXIF data, you will have to do your corrections manually.**
Manually correcting distortion
If your shooting equipment is not supported by a DxO Optics Module, you can manually correct your image.

1. From your host application, open Perspective Efex.
2. In the Distortion palette, click on the Manual button.
3. Depending on the type of distortion visible in the image, select either Barrel, Pincushion, or Fisheye. The correction will be applied immediately.
4. If necessary, you can use the Intensity slider to fine-tune the correction.
Correcting volume deformation

- About volume deformation
- Determining the type of volume deformation
- Correcting volume deformation

About volume deformation (anamorphosis)

The deformation of subjects located on the edges of images is a geometrical flaw that is frequently seen in interior, marriage, and other event photos.

Known as volume deformation or "anamorphosis," this flaw is due to taking pictures of groups of people or objects with a wide-angle or wide-angle zoom lens. The curve of the lens stretches out and distorts the subjects on the image edges.

For optimal quality results, we advise you to correct any problems with distortion before correcting volume deformation.

Determining the type of volume deformation

Look carefully at your image to determine the kind of distortion affecting it:
If the spherical objects (such as heads) near the edges of your image appear stretched or flattened, your image is suffering from a cylindrical or horizontal/vertical volume deformation, in which case you need to use the horizontal/vertical correction tool.

If objects seem to stretch toward the corners of the image, then you are dealing with diagonal volume deformation, in which case you will need to use the diagonal correction tool.

Correcting volume deformation
Correcting horizontal/vertical deformation
After opening your image in Perspective Efex from the host application, activate the horizontal or vertical volume deformation correction by clicking on the Horizontal/Vertical button in the Volume deformation palette.

The correction is automatically and immediately applied to the image.

You can use the sliders to adjust the settings.

- The Horizontal slider can stretch the image content toward the edges of the photo (slider moved to the left) or can compress the objects toward the center (slider moved to the right). Its default value is 100 (slider at center).
- The Vertical slider flattens the image content vertically. Its default value is 0 (slider on the left).

Correcting diagonal deformation

1. After opening your image in Perspective Efex from the host application, activate the diagonal volume deformation correction by clicking on the Diagonal button in the Volume deformation palette.

2. The correction is automatically and immediately applied to the image.

When in doubt, don’t hesitate to experiment with both tools, and then choose the one that makes the subjects in your image appear the most natural.

If necessary, you can manually fine-tune the automatic correction by adjusting the Intensity slider. Moving the slider to the left, the image will be progressively stretched and distorted toward the center; moving to the right, the image is stretched and distorted toward the edges. The default setting for this slider is 150.

Double-click on any slider to return it to its default value setting.
Correcting volume deformation can clip the total surface area of the image. If you think you will need to apply this correction, give a larger frame to your photo when shooting.

You can fine-tune the value of your correction by entering a value in the bubble displayed above the slider in use.
Fixing perspective

- About perspective
- Automatically fixing perspective
- Forcing vertical parallels
- Forcing horizontal parallels
- Forcing a rectangle
- Correcting perspective in 8-point mode
- Advanced settings

About perspective

In architectural photography, the position of the photographer relative to a building almost always means a low-angle or high-angle shot. In both cases, convergent lines distort the subject, and the distortion becomes even more pronounced toward the edges of the image.

Automatically fixing perspective

Perspective Efex offers tools for correcting vertical and horizontal parallel lines, for forcing a rectangle (to straighten out, for example, window and door frames), as well as an 8-point correction mode that allows you to correct each side completely independently.
corrections (if necessary). Any automatic corrections are preserved if you then decide to go into one of the manual modes (Forcing [vertical/horizontal] parallels, Rectangle, and 8 points).

After opening the image in Efex Perspective from your host application, go to the **Perspectives** palette and click on the **Auto correct** button. By default, Perspective Efex will automatically correct both vertical and horizontal perspectives. If you are not satisfied with the result, you can select one of two different modes within the **Auto** correction palette, **Verticals only** or **Horizontals only**; the correction will be applied as soon as you select it in the drop-down menu.

You can use the **Intensity** slider to adjust the automatic correction, or you can use the advanced settings to modify the perspective (see the Advanced settings section).

To reset the automatic perspective correction, click on the **Cancel** icon in the upper right side of the palette.

Correcting perspectives can result in heavy cropping, so be sure to take that into account and include sufficiently large margins when framing your photos.

Before correcting perspectives automatically, first correct any distortion in order to achieve optimal results.

The integration of the loupe with the anchor points, using the Shift key to slow down placement movement, and switching from one anchor point to another using the **Tab** key also work for Forcing a rectangle and Correcting perspectives in 8-point mode.

**Forcing vertical parallels**
The Perspective palette

1. After opening your image Perspective Efex from your host application, go to the Perspective palette and then click on the Force Vertical Parallel button. Two vertical lines, each one with two circular anchor points, will be superimposed on your image.

2. Choose two vertical reference elements in your image, preferably located on the same plane, for optimal correction.

3. Place the mouse cursor on one of the anchor points and click on it: a magnifying glass will automatically appear to help you place the anchor points with greater precision. Move the anchor point to one of the ends of your reference element. An active anchor point is indicated by a dark gray circle.

Press the Shift key to slow down the movement of the anchor point so that you can...
increase the precision of its placement.

4. Place the second anchor point so as it aligns with your vertical element. Follow the same procedure for the second line. You can also use your keyboard's 4 arrow keys to place the anchor points with even greater precision. Once aligned, it is also possible to reposition the lines by clicking on their center with the mouse.

Pressing the **Tab** key lets you switch from one anchor point to another.

5. Perspective Efex lets you verify your correction settings before applying them to your image. To do so, click on the **Preview** button in the lower toolbar. Perspective Efex will correct your image and will darken the parts of the image that will be suppressed when the automatic crop is applied (see Cropping). The greater the correction, the more the image will be cropped to compensate for rectifying the low- or high-angle shot.
The darkened zones indicate the parts of the image that will disappear when cropped.

6. Click on the **Apply** button in the lower toolbar.

So long as you have not saved the corrected image, you can undo the changes and can reset by clicking on the **Reset the correction** button.

You can change the color of the lines to improve their visibility with respect to the background color of your image. Click on the colored Line color block located in the lower toolbar and select the color you want to use.

Correcting volume deformation can clip the total surface area of the image. If you think you will need to apply this correction, give a larger frame to your photo when shooting.

Forcing horizontal parallels
The principle for forcing horizontal parallels is identical to that for forcing vertical parallels, except that the reference lines are horizontal and will let you align and level, for example, the top and bottom of a building, a window frame, or a door.

1. To activate the correction for horizontal perspectives, click on the **Force Horizontal Parallel** button in the **Perspective** palette. Two horizontal lines with two circular anchor points will be superimposed on your image.

2. Choose two horizontal reference elements in your image and place your lines in the same way as for correcting vertical perspectives.

3. Place the mouse arrow on one of the anchor points and click on it to grab it and move it to one of the ends of your reference element. Move the second anchor point so as to align the line with your horizontal element. Proceed in the same way for the second line.
4. Verify your correction by clicking on the **Preview** button in the lower toolbar. Perspective Efex will darken the parts of the image that will be suppressed when the automatic cropping is applied.

5. Click on the **Apply** button in the lower toolbar.

**Forcing a rectangle**

![Perspective Efex interface](image)

A third function of the perspective correction feature lets you use a reference rectangle to simultaneously correct both vertical and horizontal perspectives independently on each side. The applications are numerous: you can restore the exact shapes and forms to distorted elements in the scene, or straighten an interior space (such as an airport arrivals hall, a museum, or palace gallery) that was not shot in perfect alignment with an axis, or was taken at a too-low or too-high angle, etc.

1. To activate the correction, click on the **Rectangle** button.

2. You can act on all four lines: place the anchor points on the axes of the vertical and horizontal reference lines (which should be on the same plane as much as possible — that is, on elements located at approximately the same shooting distance).
Each anchor point acts on two lines at the same time.

3. Verify your correction by clicking on the Preview button in the lower toolbar. DxO ViewPoint will darken the parts of the image that will be suppressed when the automatic cropping is applied.

4. Click on the Apply button in the lower toolbar.

Manipulating one anchor point circle in the Rectangle tool affects both a vertical and a horizontal line.

Clicking on Ctrl/Cmd while moving an anchor point will cause the correction to take effect in real time without having to click on the Preview button.

You can display the composition grid to verify that all the principal elements in your image have been correctly adjusted according to your settings, instead of relying solely on a naked-eye assessment.

Correcting perspective in 8-point mode
The 8-point perspective correction follows the same principle as forcing a rectangle, with one important difference: while forcing a rectangle lets you adjust the four sides independently, the lines need to be placed on the same plane in order to achieve an optimal result.

With the 8-point method, you can place the lines on different planes, which gives you great flexibility when making complex corrections, or when the elements that need to be fixed are not all at the same distance from the where the photo was shot.

1. To activate the correction, click on the 8 points button.
2. You can act on each of four lines in a completely independent way: you can place them on the vertical and horizontal reference lines in the image, even if they are not on the same plane — that is, even if they are at different distances from the shooting point. The lines should be located as far away as possible from each other.

Choosing horizontal and vertical reference elements and placing correction lines.
3. Verify your correction by clicking on the **Preview** button in the lower toolbar. Perspective Efex will darken the parts of the image that will be suppressed when the automatic cropping is applied.

4. Click on the **Apply** button in the lower toolbar.

**Advanced settings**

The **Perspective** palette provides four sliders for fine-tuning correction settings:

**Intensity**: This slider, with a default value of 100, helps you find the best compromise between possible corrections and the most natural rendering. The Intensity slider lets you adjust the perspective correction to achieve the most natural look.

You can fine-tune how natural the perspective correction looks by, for example, setting the **Intensity** slider to 75 instead of 100. (Of course, the setting will depend on the subject and on the type of rendering you would like).

**Up/Down**: Toggles the image around a horizontal axis. You can use this command if the image has few reference lines, and also to compensate as much as possible for a shot that was not perfectly in line with the subject.

**Left/Right**: Toggles the image around a vertical axis.
**H/V Ratio**: This slider lets you fix distortions that can sometimes accompany perspective corrections. The default value is 0. Moved to the left, the image is compressed vertically; moved to the right, the image is compressed horizontally.

![Effect of the H/V Ratio slider](image)

With respect to the Perspective palette, see the paragraph about Warning Messages for more information about missing EXIF data that makes automatic correction of the image aspect ratio impossible.
Straightening horizons and cropping

- About horizons
- Automatically straightening horizons
- Straightening the horizon by drawing a reference line
- Cropping an image
- Automatically cropping an image
- Manually cropping an image

About horizons

A common flaw in landscape photography: the horizon is tilted by several degrees, or vertical elements such as poles or trees appear slanted. In all instances, tilting occurs most often because the photographer does not hold the camera absolutely level. The solution to this problem is simple: adjust the entire image by several degrees.

Automatically straightening horizons

To straighten the horizon automatically, go to the Horizon palette and click on the Auto button.

To optimize the calculations for automatically straightening the horizon, first correct the distortion, which can — depending on the camera and/or lens that you may use —
significantly curve the horizon line.

If you are not satisfied with the result, you can:

- Use the **Angle** slider to adjust the correction, either by moving the slider or by entering a value in the bubble that displays about the slider.
- Use the manual straightening tool.

### Straightening the horizon by drawing a reference line

Before straightening the horizon, correct the distortion, which — depending on the camera and/or lens you use — can significantly curve the horizon line.

The Horizon tool lets you correct compositions with a tilted horizon line. This feature can be used in tandem with the Perspective tool.

1. To activate the tool, click on the **Horizontal Level** or **Vertical Level** button in the Horizon palette. A horizontal or vertical line with two circular anchor points will be superimposed on your image.

   If the horizon line isn’t visible in your image, you can still straighten it by using a vertical reference line (such as the side of a building, a ship mast, a window or door frame, etc.).
2. Place the mouse pointer on one of the anchor points. Click on the anchor point to grab and move it to one of the ends of your reference element. Move the second anchor point to align with the line on your horizontal or vertical element.

3. When you click on an anchor point, the magnifying glass (loupe) automatically displays so that you can use it to more precisely place the anchor point.

   To slow down the movement of the loupe, hold down the Shift key. You can also use your keyboard’s arrow keys to move an anchor point. The Tab key lets you switch from one anchor point to another.

4. Choose the horizontal reference element in your image.

5. Verify your correction by clicking on the Preview button in the lower toolbar. Perspective Efex will darken the parts of the image that will be suppressed when you apply automatic cropping.

6. Click on the Apply button in the lower toolbar.

**Cropping an image**
The corrections done using the Distortion, Volume deformation, Perspective, and Horizon tools include an automatic crop feature that maximizes the visible field of the image. Perspective Efex’s **Crop** tool lets you adjust the proportions of the final image to suit your tastes.

![The darkened zones on the image represent the areas lost after correction.](image)

**Automatically cropping an image**

After correcting the perspective of your image in Perspective Efex, go to the **Crop** palette and click on the **Crop** button. An adjustable grid will be superimposed on your image.

1. Click on the **Auto** button. In this mode, Perspective Efex calculates the preserved zone of the image as closely as possible and displays darkened zones that correspond to the surface area that will be lost in the original image.

Checking/unchecking the **Show grid** box in the lower toolbar lets you activate/deactivate the composition grid in the image.
Auto mode calculates the crop as closely as possible.

Several formats are offered in the **Aspect Ratio** drop-down menu: 16/9 (TV format), 5/4, 5/2, 2/1, 3/2 (APS-C reflex and full-format cameras), 4/3 (compact camera format), and 1/1 (square format).

- By clicking on **Preserve** in the **Aspect Ratio** drop-down menu, you will preserve the proportions of the original image.

- By selecting **Unconstrained**, you can manually apply a correction.

- By selecting **Add Custom**, you can enter the pixel values (for height and width) of your choice and define the proportions of the custom crop.

2. Select the format you would like: the grid superimposed on your image will be automatically modified. By clicking on the grid, you can also change the position of the frame and adapt it to the composition of your image.
You can resize and reposition the grid.

The crop grid is divided into thirds, making it easy to apply the "rule of thirds" when composing your final image.

Even though the crop is applied when you click on Apply, this can be undone so long as the image is not saved.

3. By checking the Constrain to image box, the frame is automatically confined to the part of the image being worked on so as to avoid having any dark zones superimposed on the perspective corrections.

4. To apply the crop, click on the Apply button in the lower toolbar.

Whether in automatic or manual mode, Perspective Efex automatically detects the orientation of the crop zone.

Manually cropping an image

Click on the Crop button in the Crop palette. The adjustable grid will be superimposed on your image. To adjust the proportions of the final image to suit your tastes, select Freehand mode from the Correction drop-down menu.

Change the dimensions of the adjustable grid by manipulating the resizing points located in the corners and on the sides of the grid. You can also change the overall position of the frame to
adapt it to the composition of your image.

You can use the arrow keys on your keyboard to adjust the position of the crop zone.
Miniature effect

- About the miniature effect
- Applying a miniature effect

About the miniature effect
The miniature effect tool simulates a tilt-shift lens, which moves the plane of sharpness in an image so as to give photos of landscapes or cityscapes the appearance of a scale model or diorama. This effect is particularly dramatic in urban landscape photos taken from above. Perspective Efex’s miniature effect tool gives you great flexibility in choosing the positioning and the intensity of the focus areas.

Example of line placement for creating a miniature effect
Applying a miniature effect

After opening an image in Perspective Efex from your host application, select the Miniature Effect palette:

![Miniature effect palette](image)

You can then select a shape from the Blur shape menu; if you do not select a shape, the circular shape will be applied by default:
Once activated, along with the selected blur shape, the Miniature effect superimposes a number of lines and tools on the image (numbered in the following image and explained further below):

1. You can use the mouse to move the center anchor point in the image. By default, it is placed in the middle of the image, and is activated when the pointer passes over it.
2. The two continuous lines, one on each side, define the area of sharpness in the center on either side of the central anchor point. You can use the mouse to spread them further apart or to close them synchronously, or you can select one of the two lines (for movement in both directions), or select an anchor point (for movement in any direction and for rotation).
3. The small disk to the right of each reference line adjusts the blur intensity: Click to adjust the slider value with the mouse; the scale goes from 0 to 100 (the default value is 40).
4. The two dotted lines define the blur transition area between a solid line and a dotted line (the blur is maximal outside the dotted line). To adjust the size of the transition zone, just move one of the dotted lines toward the center (to reduce the transition area), or away from the center (to...
increase the transition area).

5. By default, the position of lines and blurring are symmetrical. If you want to set the blur to be on either side of the center mark, go into the Miniature effect palette, and uncheck Symmetrical position and / or Symmetric blur. This way you can move all the lines independently, as well as define two different blur intensity values.

6. When you are finished defining the miniature effect, click on **Apply** in the bottom toolbar (or click **Reset** to cancel the effect).

   To see the thumbnail effect without being hindered by lines, move the mouse out of the image.

To get a wide view of the working area, move the mouse wheel upwards to zoom out.

You can change the color of the lines in the lower toolbar.

The **Blur shape** menu allows you to choose between different blur effects, such as a more or less pronounced circular pattern, or the simulated blur of a 6-, 8-, or 9-blade lens iris diaphragm (the higher the number of blades, the smoother and more gradual the blur/net transitions).
Illustration showing the differences among the different available kinds of blur
Sharpener Pro 3

The Sharpener Pro 3 module is composed of two separate modules that are used at two different stages of the image processing workflow: RAW Presharpener, for preliminary sharpening; and Output Sharpener, for output sharpening.

RAW Presharpener

The RAW Presharpener module, as its name suggests, is intended for the preliminary sharpening of RAW files, which are generally softer due to several possible factors, including the presence of a low-pass filter in front of the sensor; in-camera processing; and processing applied to a file upon its import into RAW development software.

⚠️ To take full advantage of RAW Presharpener, we recommend that you disable any sharpening done in the camera and in the host RAW file processing software.
Output Sharpener

The second module, Output Sharpener, is intended for sharpening after the image development and processing phase, depending on the destination and the output medium (electronic distribution or printing, which require very different settings).
Sharpener Pro 3 settings and help

In the RAW Presharpener and Output Sharpener settings, you will be able to make interface adjustments, choose output sharpening options, and access the online user guide.

Filter settings

This tab applies to both RAW Presharpener and Output Sharpener, the latter having an additional tab (see below). After launching one of the two modules, click on the Settings button in the lower left corner. In the floating window, you can make the following settings:

- **Default Zoom**: Sets the zoom value to apply when opening the app, either *Zoom to Fit*, which adjusts the image to the available space in the program window, or *Zoom to 100%*.

- **Default Preview Mode**: Allows you to choose how images will be displayed when you open the app, either *Display single image*, or *Split preview* (the image is separated by a line, with Before corrections on the left, After corrections on the right), or *Preview side by side* (the two versions of the image, before and after corrections, are displayed next to each other).

- **Default Appearance**: You can choose whether the background gray level will be light, medium, or dark.
* Changes take effect when you open the application the next time.

For each of the default display options, if you select Use last setting, the setting from the previous session will be automatically applied.

Improve the Nik Collection

If you want the program to transmit usage statistics, check the dedicated box, after opening the section by clicking on its banner. These statistics, which remain anonymous, allow DxO Labs developers to evaluate how users use the program, with the aim of developing and improving the product. There is a link below the checkbox that you can click to find out more about the improvement program (internet connection required).

To save your choices, click OK, otherwise click Cancel. To reset all options to the default configuration, click Reset.

Output Sharpener settings (Output Sharpener only)

Output Sharperner allows you to set up sharpening tools as well as calibrate sharpening settings:

- **Default Control Point Settings**: From this menu, you can choose the mode of operation for a new Control Point: on Neutral, the slider settings will be 100% for Output Sharpness and 0% for the other sliders (Structure, Local Contrast, and Focus). The other option allows you to apply your own sharpening settings by default.

- **Default Control Point Sliders**: The default option Output Sharpness Intensity displays only this slider when you apply a new Control Point. The All option always displays all sliders, and Use Last Control Point Settings repeats the option used in the previous session.

- **Default Measurement Unit**: Choose between metric and imperial values.

- **Number of Inks Used**: Allows you to adapt the accentuation algorithms to be used according to the type of printing: Normal, Photo (default setting) and Four-Tone.

- **Image Slider Size**: Choose whether or not to display the Image Width and Image Height sliders in the Output Sharpening palette for all output types except Screen.

To save your choices, click OK, otherwise click Cancel.
To access the online help links, you can go to the Help menu or click on the Help button at the bottom left (Internet connection required):

- User guide
- Frequently Asked Questions (FAQs)
- Online support (report problems and ask questions after creating a support ticket)
- DxO Academy (tutorials, videos, webinars)
Sharpener Pro 3 interface and keyboard shortcuts

You will find the following topics on this page:

- RAW Presharpener interface
- Output Sharpener interface
- Keyboard shortcuts for RAW Presharpener and Output Sharpener

## RAW Presharpener interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. RAW Presharpener is composed of 4 distinct elements, and includes keyboard shortcuts (see table below):

1. The top toolbar
2. The image display area
3. The right pane
4. The lower toolbar
The upper toolbar

1. **Single image display**: Normal image display without separation and comparison.

2. **Split preview**: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the Navigator or with the Hand tool by pressing the spacebar.

3. **Side-by-side preview**: The version before processing is displayed on the left, the version after processing is displayed on the right. You can also display the two versions of the image one above the other by clicking on the button in between. You can also zoom and move synchronously in the two images, either with the Navigator or with the Hand tool, by pressing the spacebar.

4. **Preview**: by checking/unchecking this box, you alternate the display of the image with and without the noise corrections. The preview works with all the display modes described below.

5. **Modes**: RAW Presharpener provides display modes for easy viewing of sharpening enhancements:
   - **Sharpened image**: Normal image display with the sharpening settings.
   - **Effect Overlay** displays a red/orange color mask when placing a control point or working with color ranges. This mask allows you to visualize the stacking of corrections: the more stacks, the denser the color mask becomes.
   - **Effect Mask** shows the effect of highlighting with control points or color ranges. White indicates a 100% application of sharpness enhancement, black indicates no sharpness enhancement, and intermediate gray values indicate more or less sharpness enhancement.

6. **Select** activates the tool for making a rectangular selection within the image—for example, to link together several control points or noise measurement rectangles.

7. **Zoom + / Zoom -** lets you enlarge the image, by default at 100%, using successive clicks.
From 100% up to 300%, the Loupe (magnifying glass) contains a "+"; to unzoom (with the Loupe showing a "-"), press the Alt (PC)/Option (Mac) key, which transforms the Loupe + into a Loupe -. The magnification value is displayed in the upper right corner of the image.

8. **Pan** (or Hand) tool lets you navigate and move around in the image after zooming.

9. **Change background color**: Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid too strong a contrast between a dark image and the interface).

The image display area

![Image display area](image)

This is where the image is displayed, on a medium gray background (which you can change by clicking the **Change Background Color** button in the top toolbar). At the bottom right, below the image, you will find the following information:

- File name and extension
- Size in megapixels
- ISO sensitivity
• Camera used

The right pane
RAW Presharpening

Adaptive Sharpening 80%
Sharpen Areas Sharpen Edges

Image Quality:
- Normal
- High ISO

SELECTIVE SHARPENING

Control Points

Apply to entire image:
- 0%
- 100%

0 Control Points used

Navigate

CANCEL SAVE ALL
The right pane displays the Global and Selective accentuation tools, as well as the combined Loupe and Navigator. You can open or close the Selective Sharpening section by clicking on the arrow or in the title bar. A checkbox allows you to quickly compare the image with and without locally-applied sharpening.

1. **Loupe**: Active when the image is displayed normally:
   - The red line separates the preview before correction (left) and after correction (right).
   - You can move around in the preview where you want by clicking and holding the click while you move the mouse.
   - You can lock the loupe at any point in the image by activating the pin and placing it in the image (you can still move it by hand).

2. **Navigator**: When you zoom in, the Navigator replaces the Loupe, and displays the entire image.
   - Move the red rectangle to see different parts of the zoomed-in image.

* For more information about global and selective sharpening tools, refer to RAW Presharpener - Initial Sharpening section in this chapter.
The lower toolbar

1. **Help** provides access to the online user guide.
2. **Settings** opens the plugin options window.
3. **Previous / Next:** allows you to switch between images if you have opened more than one in the same session; and indicates the number of images.
4. **Save & resume editing** activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).
5. **Cancel:** Cancels the current processing and corrections and closes the plugin; the image in the host application is not modified.
6. **Save:** Saves the processing and corrections and closes the plugin; the image in the host application is modified.

* For more information, see the [Settings and Help page](#).

** More information about the Nik Collection 3’s non-destructive workflow.**

Output Sharpener interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. Output Sharpener is composed of 4 distinct elements, and includes keyboard shortcuts (see table below):

1. **The top toolbar**
2. **The image display area**
3. **The right pane**
4. **The lower toolbar**
The 4 elements of the Output Sharpener interface

The upper toolbar

The top toolbar contains the tools and commands related to the display of the image and side panes.

1. **Single image display**: Normal image display without separation and comparison.
2. **Split preview**: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the Navigator or with the Hand tool by pressing the spacebar.
3. **Side-by-side preview**: The version before processing is displayed on the left, the version after processing is displayed on the right. You can also display the two versions of the image one above the other by clicking on the button in between. You can also zoom and move synchronously in the two images, either with the Navigator or with the Hand tool, by pressing the spacebar.

4. **Preview**: by checking/unchecking this box, you alternate the display of the image with and without the noise corrections. The preview works with all the display modes described below.

5. **Modes**: Output Sharpener provides display modes for easy viewing of sharpening enhancements:
   - **Sharpened image**: Normal image display with the sharpening settings.
   - **Effect Overlay** displays a red/orange color mask when placing a control point or working with color ranges. This mask allows you to visualize the stacking of corrections: the more stacks, the denser the color mask becomes.
   - **Effect Mask** shows the effect of highlighting with control points or color ranges. White indicates a 100% application of sharpness enhancement, black indicates no sharpness enhancement, and intermediate gray values indicate more or less sharpness enhancement.

6. **Selection** activates the tool for making a rectangular selection within the image—for example, to link together several control points or noise measurement rectangles.

7. **Zoom + / Zoom -** lets you enlarge the image, by default at 100%, using successive clicks. From 100% up to 300%, the Loupe (magnifying glass) contains a "+"; to unzoom (with the Loupe showing a "."), press the Alt (PC)/Option (Mac) key, which transforms the Loupe + into a Loupe -. The magnification value is displayed in the upper right corner of the image.

8. **Pan** (or Hand) tool lets you navigate and move around in the image after zooming.

9. **Change the background color**: Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid too strong a contrast between a dark image and the interface).

**The image display area**
This is where the image is displayed, on a medium gray background (which you can change by clicking the **Change Background Color** button in the top toolbar). At the bottom right, below the image, you will find the following information:

- File name and extension
- Size in megapixels
- ISO sensitivity
- Camera used

**The right pane**
The right pane displays the Global and Selective accentuation* tools, as well as the Loupe and the Navigator combined. You can open or close tool sections by clicking on their arrow or in the title bar. A checkbox in the title bar of the **Selective sharpening** section allows you to quickly compare the image with and without locally-applied sharpening.

1. **Loupe**: Active when the image is displayed normally:
   - The red line separates the preview before correction (left) and after correction (right).
   - You can move around in the preview where you want by clicking and holding the click while you move the mouse.
   - You can lock the loupe at any point in the image by activating the pin and placing it in the image (you can still move it by hand).

2. **Navigator**: When you zoom in, the Navigator replaces the Loupe, and displays the entire image.
   - You can move around by entering the red rectangle.

* For more information about global and selective sharpening tools, refer to the **Output Sharpener — creative output enhancement** section in this chapter.
The lower toolbar

The lower toolbar includes access to help, plugin settings, and save functions:

1. **Help** provides access to the online user guide.
2. **Settings** opens the plugin options window.
3. **Previous / Next**: allows you to switch between images if you have opened more than one in the same session; and indicates the number of images.
4. **Save & resume editing** activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).
5. **Cancel**: Cancels the current processing and corrections and closes the plugin; the image in the host application is not modified.
6. **Save**: Saves the processing and corrections and closes the plugin; the image in the host application is modified.

* For more information, see the **Settings and Help** page. **For more information about the Nik Collection 3’s reversible workflow**, see the chapter by the same name.

Keyboard shortcuts (RAW Presharpener and Output Sharpener)

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Tool</td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>Zoom Tool</td>
<td>Z</td>
<td>Z</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Select Zoom Tool, hold Alt and click</td>
<td>Select Zoom Tool, hold Option and click</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Ctrl + &quot;-&quot;</td>
<td>Cmd + &quot;-&quot;</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Ctrl + &quot;+&quot;</td>
<td>Cmd + &quot;+&quot;</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>Ctrl + 0</td>
<td>Cmd + 0</td>
</tr>
<tr>
<td>Zoom to 100%</td>
<td>Ctrl + Alt + 0</td>
<td>Cmd + Alt + 0</td>
</tr>
<tr>
<td>Pan Tool</td>
<td>H or Spacebar</td>
<td>H or Spacebar</td>
</tr>
<tr>
<td>Action</td>
<td>Key Combinations</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------</td>
<td></td>
</tr>
<tr>
<td>Apply Filter</td>
<td>Enter</td>
<td></td>
</tr>
<tr>
<td>Cancel Filter</td>
<td>Esc</td>
<td></td>
</tr>
<tr>
<td>Delete Selected Item</td>
<td>Backspace</td>
<td></td>
</tr>
<tr>
<td>Add Control Point</td>
<td>Ctrl + Shift + A</td>
<td></td>
</tr>
<tr>
<td>Duplicate Control Point</td>
<td>Ctrl + D, or Alt + drag</td>
<td></td>
</tr>
<tr>
<td>Show Control Point Mask</td>
<td>Ctrl + drag</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cmd + drag</td>
<td></td>
</tr>
</tbody>
</table>
RAW Presharpener — initial sharpening

The RAW Presharpener module is designed to compensate for the loss of sharpness in your image during capture, due to the presence of a low-pass filter in front of the camera sensor, but it can also be used in a complete sharpening workflow, from capture to creative processing to output (the latter two being provided by Output Sharpener), when you want to keep full control over this important phase of the workflow.

In this case, and regardless of the original format of the file to be processed, we advise you to disable any sharpening, both in the camera and in the host application, especially if the latter is a RAW file converter and processor.

On this page, we discuss:

- Enhancing overall sharpness
- Enhancing sharpness with control points
- Enhancing sharpness with color ranges

Enhancing overall sharpness

Once you have opened your image in RAW Presharpener, you can use a simple method, suitable for the majority of images, to enhance overall sharpness with adaptive tools that you will find in the right panel:
1. **Adaptive Sharpening**: Set by default to 50%, this slider strengthens (to the right) or attenuates (to the left) sharpness based on algorithms capable of taking into account the presence of elements in the image such as outlines, details, and flat areas. The rule here is to sharpen the image decisively, but without exaggeration. You can control this by unchecking the Preview* box in the top bar to compare the image after and before sharpening (feel free to zoom in at 100% or compare using the Loupe*).

2. **Sharpen Areas / Sharpen Edges**: Set by default in the center, this slider lets you give more importance to the areas and details of the image within the contours and/or to flat areas by moving it to the left; moving it towards the right, to emphasize the contours or edges instead. In general, however, we advise leaving the cursor as it is, and, if you need to emphasize something within the edges, use the selective methods discussed below instead.

3. **Image Quality**: With this function set to Normal by default, the High ISO option allows you to adapt the sharpening algorithms to images shot at high sensitivity and therefore with noise, which may be amplified by any sharpening. Click the button to activate High ISO.

4. **Apply to entire image**: This slider works best in conjunction with the control points. As long
as you are satisfied with overall sharpening, this slider is set to 100%, but you can also use it to modulate the sharpening.

5.

![Image showing overall sharpness enhancement]

*Overall sharpness enhancement*

When sharpening, you can compare the image before and after correction by zooming in on the image, or by using the Loupe, the Preview button, or the different display modes available in the top bar. For more information about these tools, see the Interface and keyboard shortcuts page.

Enhancing sharpness with control points

Applying and using control points

Control points allow you to enhance the sharpness in a very precise way on elements of the image rather than its entirety. For example, in a portrait, you may want to sharpen the eyes and mouth but not the skin; and in a landscape, you may want to sharpen the ground, but not the sky (especially a blue sky where noise could quickly appear). In the Selective sharpening section on the right, a menu allows you to choose between two methods, Control Points, discussed here, and Color Ranges, discussed further below.
1. From the drop-down menu, choose Control Points.

2. Click on the "+" button on the right.

3. Click in the image to place a control point on the area to be treated.

4. The Apply to entire image slider automatically changes from 100% to 0%.

5. Adjust the radius of action of the control point with the first slider.

6. Accentuate the sharpness with the Adaptive Sharpening and/or Sharpen Areas/Sharpen Edges sliders, located in the top right corner of the panel (see previous paragraph).

7. Adjust the sharpness to your liking using the control point’s Opacity slider (set to 100% by default).
Using multiple control points and grouping them together

To correct a large area of the image, set additional control points and repeat the above steps. You can also chain the control points by activating the **Select** tool (A key), then drawing a rectangle that encompasses multiple control points. In this case, you can simply move one slider to make the emphasis apply equally to all the others.
Protect with a negative control point

*Left: blue sky unprotected from accentuation (100% opacity) / Right: protected blue sky (0% opacity).*

You can also protect part of the image from sharpening with a negative control point (you can also put several negative control points together and chain them):

1. In the **Selective sharpening** section, click the "-" (minus sign) button.
2. Click in the image to place the protection control point.
3. Adjust the radius to cover the area to be protected. The negative control point’s **Opacity** slider is set to 0 (no sharpening) by default, to protect that part of the image.

Here is another example showing the accuracy of a control point emphasis in the case of a portrait. Control points were placed on the eyes [1] and at different points of the mouth [2] to make them sharper, while negative control points [3] were placed to protect the skin from any sharpening:
The sharpness mask display mode shows the sharpened areas in white and the protected areas in black.
Duplicating a control point

If you want to duplicate a control point, there are two methods available:
Method 1:
1. Click on the control point you want to duplicate in the list of control points to select it.
2. Click on Duplicate.

Method 2:
1. Move the mouse over the control point to duplicate in the image while pressing the Alt/Option key. The mouse pointer will change to a "+" sign.
2. Click and hold the click on the control point, then drag the duplicate to where you want it.

Deleting a control point

There are three ways to delete one or more control points:

Method 1:
1. In the list, click on a control point to select it.
2. To select the entire list or contiguous control points, click on the first control point and then click on the last control point while holding down the Shift key.
3. To select several control points that are not adjacent to each other, choose Ctrl/Cmd.
4. Click on the Delete button.

Method 2:
1. In the image, click on the control point you want to delete to select it.
2. Delete it using the Delete or Backspace key on your keyboard.

Method 3:
1. To delete multiple control points in the image, activate the Selection tool (A key).
2. Draw a rectangle around the control points you want to delete.
3. Use the Delete or Backspace key on your keyboard, then validate in the dialog box that appears (you can deactivate its display by checking **Do not display again**).

**Enhancing sharpness with color ranges**

Another method of sharpening is color-dependent. By default, RAW Presharpener offers you three ranges: red, orange, blue, represented by tiles accompanied by an eyedropper, which will allow you to select colors directly in the image. After choosing **Color Ranges** from the **Method** menu:

1. Click on an eyedropper to activate it.
2. Place it in the image, then click.
3. The corresponding color is taken and indicated in the small tile.
4. Enhance the sharpness with the **Adaptive Sharpening** and/or **Sharpen Areas/Sharpen Edges** sliders.
5. Adjust the sharpness with the **Opacity** slider below each color range (default setting is 100%).
6. For a different color range, click another eyedropper and repeat the previous steps.

To add a color range, click on the "+" button below the list, which will display a tile (in pale violet), the eyedropper, and the associated sliders. You can add as many ranges as you wish, and you can remove them individually by clicking on their "-" (minus sign) button.
Note that protection control points can be combined with color range sharpening.
Output Sharpener — creative output enhancement

The Output Sharpener plugin allows you to prepare and sharpen your image in a creative way, depending on its destination (electronic publishing, printing, circulation) and on its size and resolution. This last stage of sharpness work comes after the following steps:

- Creative sharpening in the host application
- Initial sharpening in RAW Presharpener

Output Sharpening and Creative Sharpening are closely related in Output Sharpener, because they occur after you have decided what type of media you are going to use for your image. This means you first deal with the tools in Output Sharpening, and then with the tools in Creative Sharpening.

On this page we will discuss the following topics:

- Presets
- Output Sharpening
- Creative Sharpening
- Selective Sharpening

When working on the sharpness of your images, remember to use the comparison and verification display modes, as well as the Loupe and Zoom functions, the latter being essential for checking the sharpness and the possible appearance of artifacts and sharpening halos along the edges. You will find all the necessary information about these functions in the Interface and keyboard shortcuts page.

Presets

If you have determined a sharpening method and want to use it later on future images, you do not need to redo all the settings every time you start a work session. At the top of the right panel is a section for managing presets:
1. Make your settings in Output Sharpener.

2. In the Presets section, click **Add New Preset**.

3. A dialog box will prompt you to enter the name of your preset.

4. Validate by clicking **OK**. Your preset appears in the section. When working on a new image, click on the preset to apply it.

You can create as many presets as you want, and manage them with the following commands:

1. To update your preset with new settings, hover your mouse over the preset, then click the **Update** button on the right.

2. To delete a preset, move the mouse over it and click the **X** button on its left.

**Output Sharpening**

In this section, you will determine the output media for your image, between on-screen display, which is the default choice, and a number of methods for printing on paper. This is the first step before moving on to creative sharpening, since for the latter you will not use the same settings for a screen and an inkjet printer. To choose the output media, click to scroll down the list (the options depend on the output type, although all types may share some settings in...
1. **Display**: Sharpens the image for display on a computer screen (electronic publishing, web gallery, etc.).

   - **Adaptive Sharpening**: Set to 50% by default, enhances or reduces overall sharpness (it works similarly to the same slider in RAW Presharpener).

2. **Inkjet**: Enhances the sharpness of an image printed on an inkjet photo printer.

   - **Viewing Distance**: Set to Auto by default, adjusts the sharpness according to the distance from which the viewer will view the print. Five distances are provided; the farther away the observer is, the less detail they will perceive. Auto distance is a conservative approach based on the diagonal size of the image, and we recommend using this option, especially if you do not know how the print will be viewed. If you have chosen the **Sharpening Software Proof** display option, in the top bar, and you select a distance from the menu, your image will be displayed at a smaller size to simulate the effect of viewing distance.

   - **Paper Type**: This menu offers several choices of paper (matte, glossy, etc.). Sharpness is influenced by the way the ink dots are absorbed by the paper, and by the texture of the paper.

   - **Print Resolution**: Here you will have to choose the same setting as in the printer driver, and not the “commercial” resolution of your printer. The values are expressed in length x width and in DPI (dots per inch). In the menu at the
very bottom, you can enter a value, by going to **User Defined**, then clicking on **Empty** to display input fields.

- **Image Width / Image Height**: Use these sliders to determine the physical size of the print. Normally, they are not displayed, so you must go to **Settings > Output Emphasis Settings > Image Size Sliders > Display**.

3. **Continuous Tone**: Sharpens prints in the photo lab (unless your lab also uses inkjet).

![Continuous Tone](image)

- **Viewing Distance**

- **Print Resolution**: You can choose from several values expressed in DPI (150, 300, etc.), and you can also enter a value in the **Empty** field.

- **Image Width / Image Height**

4. **Halftone**: Enhances the sharpness of images for print media (newspapers, magazines, etc.).

![Halftone](image)

- **Viewing Distance**

- **Paper Type**: Select the type of publication, newspaper, coated paper, glossy paper, etc.
• **Print Resolution**: The slider allows you to set the lpcm (lines per cm) value, according to the guidelines of the publication where your images will be printed.

• **Image Width / Image Height**

5. **Hybrid Device**: You can apply this option in case you do not know whether your images will be broadcast (screen) or published (print).

![Output Sharpening Panel]

- **Viewing Distance**
- **Image Width / Image Height**

*For more details, refer to the function description in section 2, Inkjet.*

**Creative Sharpening**

Once you have established how to adjust the sharpness of your images because of their destination and output media, it is time to move on to the creative part of the sharpening process, either globally, or with selective tools (control points and color ranges), discussed in the next paragraph, which use the same sliders and algorithms.

The Creative Sharpness section, in the right panel, offers the following tools:

![Creative Sharpening Panel]

1. **Output Sharpening Strength**: This overall sharpness slider allows you to modulate all other settings. The default value is 100%; you can de-emphasize the sharpness to the left, and amplify it to the right.

2. **Structure** enhances or attenuates textures, without affecting the sharpness of the edges.

3. **Local Contrast**: By acting on the micro-contrast of details, this slider lets you give more
punch to your image (towards the right) or, on the contrary, to diffuse the details (towards the left).

4. **Focus** allows you to restore sharpness to elements of the image that are slightly out of focus by moving the slider to the right. By adjusting the slider to the left, you introduce a blur effect, as if the lens focus had been shifted.

![Example of output sharpening with local intensity and contrast enhancement](image)

**Selective Sharpening**

Output Sharpener’s **Selective Sharpening** uses two methods that you can combine: with control points and/or with color ranges.

**Enhancing sharpness with control points**

Control points allow you to enhance the sharpness in a very precise way on elements of the image rather than its entirety. In the **Selective Sharpening** section a menu allows you to choose between two methods, Control Points, discussed here, and Color Ranges, discussed further below.
1. From the drop-down menu, choose Control Points.
2. Click on the "+" button.
3. Click in the image to place a control point on the area to be treated. The Apply to entire image slider automatically changes from 100% to 0%.
4. Adjust the radius of action of the control point with the first slider.
5. Apply one of the 4 available corrections (click on the small triangle to reveal all the sliders):
   - Output sharpening intensity*
• Structure (S)*
• Local Contrast (LC)*
• Focus (F)*

* These sliders are the same as the ones in the **Creative Sharpness** section; refer to the paragraph dedicated to this section to learn more about these tools.

---

**Grouping control points**

To correct a large area of the image, set additional control points and repeat the above steps. You can also chain the control points by activating the **Select** tool (A key), then drawing a rectangle that encompasses multiple control points. In this case, you can simply move one slider to make the emphasis apply equally to all the others.
Top: Protection control points set in the sky (as well as in the canopy of the bridge), all sliders at 0.

Middle: Global accentuation applied; the bridge is sharper, the sky remains intact (no increase in grain/noise).

Bottom: The effect mask, white shows enhanced areas, black shows protected areas.

You can also protect part of the image from sharpening with a negative control point (you can also put several negative control points together and chain them):
1. Click the **Add Control Point** (+) button.

2. Click in the image to place the protection control point.

3. Adjust the radius to cover the area to be protected. Set the sliders to 0 (no sharpening) to protect that part of the image.

### Managing control points

![Control Point Management GUI](image)

From the control point list, you can do the following:

1. Temporarily deactivate a control point: check on the **Show/hide effect of Control Point** box on its left. The value in % shown on the right indicates the size of the control point’s radius of action (adjusted with the **Size** slider for each control point).

2. **Show/hide selection for all Control Points**: You can display the monochrome mask of all control points at the same time by clicking the square button in the header of the control point list, or individually by checking the checkbox(es) in the same column. Note that the mask displays white (areas affected by 100% corrections), black (areas not affected by corrections), and shades of gray, depending on the density of the correction.

3. **Reset the control point sliders**: The curved arrow on the far right resets the slider settings for the selected control point to 0%.

### Duplicating a control point

If you want to duplicate a control point, there are two methods available:

**Method 1:**

1. Click on the control point you want to duplicate in the list of control points to select it.

2. Click on **Duplicate**.

**Method 2:**
1. Move the mouse over the control point to duplicate in the image while pressing the Alt/Option key. The mouse pointer will change to a "+" sign.

2. Click and hold the click on the control point, then drag the duplicate to where you want it.

Deleting a control point

There are three ways to delete one or more control points:

Method 1:
1. In the list, click on a control point to select it.
2. To select the entire list or contiguous control points, click on the first control point and then click on the last control point while holding down the Shift key.
3. To select several control points that are not adjacent to each other, choose Ctrl/Cmd.
4. Click on the Delete button.

Method 2:
1. In the image, click on the control point you want to delete to select it.
2. Delete it using the Delete or Backspace key on your keyboard.

Method 3:
1. To delete multiple control points in the image, activate the Select tool (A key).
2. Draw a rectangle around the control points you want to delete.
3. Use the Delete or Backspace key on your keyboard, then validate in the dialog box that appears (you can deactivate its display by checking Do not display anymore).

Enhancing sharpness with color ranges
Another method of sharpening is color-dependent. By default, RAW Presharpener offers you three ranges: red, orange, blue, represented by tiles accompanied by an eyedropper, which will allow you to select colors directly in the image. After choosing Color Ranges from the Method menu:

1. Click on an eyedropper to activate it.
2. Place it in the image, then click. The corresponding color is taken and indicated in the small tile.
3. Enhance the sharpness with the Output Sharpening Strength slider for each color range as desires (default value is 100%).
4. For a different color range, click the eyedropper into another color and repeat the previous steps.

To add a color range, click on the "+" button below the list, which will display a tile (in pale violet), the eyedropper, and the associated sliders. You can add as many ranges as you wish, and you can remove them individually by clicking on their "-" (minus sign) button.

Note that the protection control points can be combined with color range accentuation.
Silver Efex Pro 2
Silver Efex Pro 2

The Silver Efex Pro 2 module will allow you to discover or rediscover black and white photography, thanks to its numerous presets, global and selective correction tools, filters, as well as copious colorization effects, curves, silver film simulation, and finishing tools—including vignetting, burnt edges, and image contours. The possibilities are endless. You can employ carefully-designed, ready-to-use renderings directly to your images, but you can also modify them as you wish, or you can create your own renderings from scratch. You can also share your renderings with other Silver Efex Pro 2 users.
Silver Efex Pro 2 settings and help

Siver Efex Pro 2 parameters let you make a number of settings affecting the interface, GPU acceleration, and image output, and gives you access to the online user guide.

Interface settings

After launching Silver Efex Pro 2, click on the Settings button in the lower left corner. In the floating window, you can open one of the sections by clicking on its banner, starting with Interface settings:

- **Interface Language**: Allows you to choose from one of 17 languages. By default, the language selected is that of your operating system.
- **Default Preview mode**: Allows you to choose how images will be displayed when you open the app, either Display single image, or Split preview (the image is separated by a line, with Before corrections on the left, After corrections on the right), or Preview side by side (the two versions of the image, before and after corrections, are displayed next to each other).
- **Default Background Color**: Determines the appearance of the background, white, gray, or black.
- **Default Zoom Status**: Sets the zoom value that will be applied to the image when you click the Zoom button (values from 6.25% to 400%).
* Changes take effect when you open the application the next time.

For each of the default display options, if you select **Use last setting**, the setting from the previous session will be automatically applied.

**GPU**
The GPU (Graphics Processor Unit) section, which you can access by clicking on its banner, allows you to use your computer’s video card to perform calculations related to image processing, thus relieving the load on the main processor. To do this, check the **Use GPU for image processing** checkbox. You will also find information about your GPU’s make, model, memory, and driver version (if available) in this section.

**Image output parameters**
In this section, you can choose the settings for the output files after clicking on the **Image Output Settings** banner:

- **TIFF Compression**: Choose between **LZW** or **ZIP** compression methods if you want to reduce the size of your TIFF files. Otherwise, select **No Compression**.
- **TIFF Save Type**: This is the method of storing image data in TIFF files. **Stripe** is the oldest and **Tiles** is newer and is designed for very large files. The Stripe setting is selected by default; leave it as is if you have no reason to change it.
- **JPEG Quality**: Adjusts the compression of JPEG files; the default setting is 80%. As you decrease the setting, with the slider to the left, the size of JPEG files will decrease, resulting in a gradual degradation of image quality.

* Both LZW and ZIP compression methods are lossless. The ZIP method produces smaller compressed files than the LZW method.

**Improve the Nik Collection**
If you want the program to transmit usage statistics, check the dedicated box, after opening the section by clicking on its banner. These statistics, which remain anonymous, allow DxO Labs developers to evaluate how users use the program, with the aim of developing and improving the product. There is a link below the checkbox that you can click to find out more about the improvement program (internet connection required).

To save your choices, click **OK**, otherwise click **Cancel**.

**Help**

To access the online help links, you can go to the Help menu or click on the Help button at the bottom left
(Internet connection required):

- User guide
- Frequently Asked Questions (FAQs)
- Online support (report problems and ask questions after creating a support ticket)
- DxO Academy (tutorials, videos, webinars)
Silver Efex Pro 2 interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. Silver Efex Pro 2 is composed of 5 distinct elements, and includes keyboard shortcuts (see table below):

1. The top toolbar
2. The left pane
3. The image display area
4. The right pane
5. The lower toolbar

> Keyboard shortcuts

The upper toolbar

The top toolbar contains the tools and commands related to the display of the image and side panes.
1. **Hide or view adjustment panels**: retracts or displays the left pane.

2. **Single image display**: Normal image display without separation and comparison.

3. **Split preview**: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the Navigator or with the Hand tool by pressing the spacebar.

4. **Side-by-side preview**: The version before processing is displayed on the left, the version after processing is displayed on the right. You can also display the two versions of the image one above the other by clicking on the button in between. You can also zoom and move synchronously in the two images, either with the Navigator or with the Hand tool, by pressing the spacebar.

5. **Compare**: By clicking this button, you can quickly compare the before- and after-correction versions of your image. You can use this tool only in Single image display mode (2).

6. **Zoom + / Zoom -**: Set to 100% by default, lets you zoom into the image. A floating window automatically displays the enlarged zone in the image; you can move this window either by clicking on it and dragging it, or by clicking on a different part of your image. By pressing and holding the spacebar, you can also use the Hand tool to move it. To return to normal view, click on the Zoom button again. The arrow lets you access different sizes, from 6.25% to 400%. You can also use the zoom and movement functions in split preview and side-by-side display modes.

7. **Change background color**: Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid too strong a contrast between a dark image and the interface).

8. **Hide or view adjustment panels**: retracts or displays the right pane.

---

* You can use the Tab key to hide/unhide the two side panes at the same time.

** To zoom in, you can also press the Spacebar, and go back to the previous size by releasing it.
The left pane

The left pane contains all the filters and effects grouped under the Preset Library section, as well as the Custom section, for creating your own effects; and Imported section, for loading effects shared by other users. For the operation of these sections, see Using and managing presets.

The left pane also includes the History section. It shows all the steps involved in processing and
correcting your image from the top (older) to the bottom (newer). To view the image at a particular stage, click on that stage in the list. The selected step is displayed in yellow, all previous steps (top) are white, and all subsequent steps (bottom) are grayed out: if you make a correction at this time, the grayed-out steps will be removed. In split or side-by-side display mode, you can move the history selector (yellow arrow on the left edge of the section) to apply a history step to the left view.

The image display area

This is where the image is displayed, on a medium gray background (which you can change by clicking the Change Background Color button in the top toolbar). At the bottom right, below the image, you will find the following information:

- File name and extension
- Size in megapixels
- ISO sensitivity
The right pane

The right pane displays the tool sections, based on the prsets selected in the left pane. But there are also a number of common features:

1. **Enable/disable the section effect**: By unchecking the box to the left of the palette name, you temporarily disable the tools and settings applied to the image so as to let you make quick comparisons. To reactivate the tools and settings, check the box.

2. **Reset all settings in this section to their default values**: Click on the curved arrow to reset all the tools and settings in the section at once.

3. Click on the section name bar or the arrow on the left to close/open the section.

4. Double-click on a slider to reset it.

5. **Control points**: See the **Correction tools** page in this chapter for a detailed description of
control points and related functions.

The Loupe and Histogram section is also available regardless of the tools you use. To switch from one to the other, move the mouse just below the title bar to bring up the selector, then click on either function:

1. **Loupe**

   - The preview shows a real-time magnification of 200% as you move the mouse pointer through the image.
   - You can also lock the loupe to a specific place in the image: click on the pin on the right in the title bar and then click on the desired place in the image. To unlock, click the pin again.
   - Regardless of whether the loupe is locked or not, you can also move around in the image after clicking in the loupe (the image displayed in the center does not move, even when zoomed in).

2. **Histogram**

   - By default, the histogram shows the global brightness channel. By clicking in the histogram, you can switch from all the channels to the Red, Green, Blue channels in succession, and then back to Brightness.
When you move the mouse over the histogram, the histogram displays tiles numbered from 0 to 10. This is the "zone system": when you click on one of the blocks, the parts of the image corresponding to that brightness level are highlighted with a colored, hatched mask. Zone 0 corresponds to deep black, and zone 10 to pure white, which can help you adjust the tonality of your image, so that it can be displayed or printed without clipped tones showing any details or image information. To enable the system area indicator, you must check the box to the left of the tiles. This works with the Brightness channel of the histogram, and also with the Red, Green, and Blue channels.

The lower toolbar

The lower toolbar includes access to help, plugin settings, and save functions:

1. **Help** provides access to the online user guide.
2. **Settings** opens the plugin options window.
3. **Previous / Next** allows you to switch between images if you have opened more than one in the same session; and indicates the number of images.
4. **Save & resume editing** activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).
5. **Cancel** lets you cancel the current processing and corrections and closes the plugin; the image in the host application is not modified.

6. **Save** lets you save the processing and corrections and closes the plugin; the image in the host application is modified.

* For more information, see the Settings and help page.

**More information about the Nik Collection 3’s non-destructive workflow.**

### Keyboard shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Undo</strong></td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
<tr>
<td><strong>Redo</strong></td>
<td>Ctrl + Y</td>
<td>Cmd + Y</td>
</tr>
<tr>
<td><strong>Full Screen</strong></td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>P</td>
<td>P</td>
</tr>
<tr>
<td><strong>Show/Hide Control Palettes</strong></td>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td><strong>Apply Filter</strong></td>
<td>Enter</td>
<td>Return</td>
</tr>
<tr>
<td><strong>Cancel Filter</strong></td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td><strong>Zoom</strong></td>
<td>Spacebar</td>
<td>Spacebar</td>
</tr>
<tr>
<td><strong>Add Control Point</strong></td>
<td>Ctrl + Shift + A</td>
<td>Cmd + Shift + A</td>
</tr>
<tr>
<td><strong>Delete Control Point</strong></td>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td><strong>Duplicate Control Point</strong></td>
<td>Ctrl + D, Alt + drag, or Ctrl + C to copy and Ctrl + V to paste</td>
<td>Cmd + D, Alt + drag, or Cmd + C to copy and Cmd + V to paste</td>
</tr>
<tr>
<td><strong>Expand/Collapse Control Point</strong></td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td><strong>Group Control Points</strong></td>
<td>Ctrl + G</td>
<td>Cmd + G</td>
</tr>
<tr>
<td><strong>Ungroup Control Points</strong></td>
<td>Ctrl + Shift + G</td>
<td>Cmd + Shift + G</td>
</tr>
</tbody>
</table>
Using and managing presets

Preset Library
The Preset Library is a collection of predefined effects available for Silver Efex Pro 2, with thumbnails displaying the effect of each style on the active image. Presets are a quick way to learn and use Silver Efex Pro 2, while providing a starting point for creating custom presets that you can then apply to your image with a single click.

Preset categories
Predefined categories allow you to filter the provided presets. By clicking on a category, only the presets in that category will be displayed. Click on the All category to display all presets again. The categories are:

- **All**: Displays all available presets.
- **Classic**
- **Modern**
- **Retro**
Recently Used: Displays the last presets you tried or used.

Favorites: Displays your favorite presets (see below for adding to favorites).

En Vogue: Collection of presets introduced by Nik Collection versions 2 and 2.5.

Add to Favorites

Clicking on the white star next to a preset to assign it to the Favorites category. To deselect a preset as a favorite, click on its star again (white star: not a favorite preset; yellow star: favorite preset).

Custom section

To facilitate your workflow, the preset library stores all your custom presets, separating them from the presets included in the software. Custom presets include your own settings, recipes, and effects, which you can also share with other Nik Collection users (and vice versa).
1. **Create a new custom preset based on state of current photo** (+ button): Click this button to save current corrections as a custom preset. After naming the preset, the thumbnail will be added to the **Custom** section for later use.

2. **Rename this preset**: Click on the preset name below the thumbnail to activate the input field. After entering the new name, validate with the **Enter** key.

3. **Add to Favorites**: Click on the white star to assign the preset to the Favorites section of the preset library (the star turns yellow). Click again to remove it (the star turns white again).

4. **Click to delete this preset**: Hover over the preset to display the buttons embedded in the thumbnail. Click on the X in the upper left corner to remove the preset from the **Custom** section. This control is only available for imported/custom presets.

5. **Click to export this preset**: Hover over the preset to display the buttons embedded in the thumbnail. Clicking on the top right arrow button will export the preset for sharing. A system dialog box allows you to change the pre-entered name, and to choose the save location, before clicking on **Save**.

6. **Click to update this preset with the current settings**: Hover over the preset to display the buttons embedded in the thumbnail. Clicking on the button in the bottom right corner will
update the preset if you make changes to the settings with the tools in the right pane.

7. **Export all**: This button, located at the very bottom of the panel, allows you to save all the presets in one go in a folder (which you have created beforehand) that is accessible by a system dialog box.

* These commands are only available for custom presets, not for the presets that come with the plugin.

**Imported section**

This library gathers the presets that have been provided to you by another user or that you have downloaded from the Internet.

1. **Import a preset from your computer** (+ button): After you click on this button, a system dialog box opens, where you can locate the presets you want to import. After selecting them, click *Open*. The imported presets will appear as thumbnails in the **Imported** section.

2. **Click to remove this preset***: Hover over the preset to display the buttons embedded in the thumbnail. Click on the *X* in the upper left corner to remove the preset from the **Custom**
section. This control is only available for imported/custom presets.

3. **Click to export this preset**: Hover over the preset to display the buttons embedded in the thumbnail. Clicking on the top right button will export the preset for sharing. A system dialog box allows you to change the pre-entered name, and to choose the save location, before clicking on **Save**.

4. **Export all**: This button, located at the very bottom of the panel, allows you to save all the presets in one go in a folder (which you have created beforehand) that is accessible by a system dialog box.

* These commands are available only for custom presets, not for the presets that come with the plugin. Note that you cannot update or rename imported presets. If you want to do so, apply them, change the settings, and then save as a new preset.
Correction tools

On this page you will find a description of all the tools available in the right pane of Silver Efex Pro 2, both for global image correction and selective adjustments with control points. You can use all of these tools based on the default type applied to the image aperture (type 000 Neutral), or on one of the types chosen from the Types library on the left, or chosen from the types in the Custom and Imported sections.

Global adjustments

The global settings contain the main correction sliders. The effects of global settings are applied to the entire image.

You use the controls in the global settings section to correct and adjust image brightness,
contrast, and the appearance of details and texture for the entire image.

1. **Brightness** changes the luminosity of the image. Moving this slider to the left darkens the image, while moving it to the right increases the brightness of the image. Clicking on the disclosure triangle next to the **Brightness** setting displays these additional brightness sliders:

   - **Highlights** adjusts the brightness of bright areas in the image.
   - **Midtones** adjusts the brightness of the midtone areas throughout the image.
   - **Shadows** adjusts the brightness of the dark areas in the image.

   **Dynamic Brightness** uses a unique algorithm that automatically adjusts to different areas of the image. This slider allows for finer changes in brightness, ensuring that the image retains a good range of detail, preserves contrast, and intelligently applies brightness values to different areas of the image. Move the slider to the left to darken the image while keeping details in the lighter tones; move the slider to the right to lighten the image while retaining details in the shaded areas.

2. **Contrast** controls the overall contrast of the image — the difference between the density of the dark areas and the brightness of the light areas. Clicking on the disclosure triangle next to the Contrast setting displays additional contrast sliders:

   - **Amplify Whites**: This slider uses an algorithm that provides unique control over the highlights of the image. By moving this slider to the right, the highlights in each area of the image become brighter. Due to the adaptive nature of the algorithm, each area is treated differently, taking into account its particular characteristics.

   - **Amplify Blacks**: As with the Amplify White slider, this slider uses a unique algorithm to control the tonality of the image. Move this slider to the right to make the dark tones of each area of the image even denser. Because the algorithm is adaptive, each area is treated differently, taking into account its particular characteristics.

   - **Soft Contrast**: The purpose of the slider is to provide a different approach to contrast, one that is less harsh and with much more diffuse transitions.

3. **Structure** controls the overall structure of the image. Increasing the slider settings accentuates details and textures, while reducing them softens fine details for smoother surfaces. Clicking the disclosure triangle next to the Structure setting displays additional sliders:

   - **Highlights**: Selectively adjusts the structure of light areas in the image.
   - **Midtones**: Selectively adjusts the structure of midtones in the image.
• **Shadows**: Selectively adjusts the structure of darker areas in the image

• **Fine Structure**: Similar to the Structure slider, this lets you adjust the finer details in the image.

4. **Tonality Protection** sliders allow you to recover details in shadows and highlights that are lost during contrast or tone adjustments. These sliders will recover only those details that existed in the original image and will have an effect on the image only after using one of the other adjustment tools.

• **Shadows**: Moving the slider to the right will lighten only shadows and recover details embedded in dense areas.

• **Highlights**: Moving the slider to the right will darken only the brightest areas and recover details embedded in those areas.

---

*Image Fabien Voileau*

*Left: Original as first opened in Silver Efex Pro 2.*

*Right: Image corrected for brightness, contrast, and structure.*

---

**Selective adjustments**

Selective adjustments change only certain parts of the image. When you add a control point, its sliders will affect only the objects or areas covered by the control point.

**Adding control points**
1. **Control point** button: Click on this button to add a control point. The mouse pointer changes to indicate that you can click to place the control point in the image. You can place as many control points as you want. After placing the control point on the image, you can apply and adjust the following settings:

2. **Size**: This slider adjusts the range or radius of application of the control point. All image elements whose color, brightness, and contrast correspond to the pixels on which the control point is placed will be affected by the following corrections and adjustments.

3. **Brightness (Br)** changes the brightness of the selected area or object.

4. **Contrast (Co)** changes the contrast of the selected area or object.

5. **Structure (St)** reinforces or attenuates the structure (reproduction of details and textures) of the selected area or object.

6. **Amplify Blacks (AB)** increases or decreases the shadow density of the selected object or area.

7. **Amplify Whites (AW)** increases or decreases the brightness of the highlights of the selected object or area.

8. **Fine Structure (FS)** reinforces or attenuates the structure of fine detail in the selected area or object.

9. **Selective Colorization (SC)** allows you to apply a particular hue to the selected object or area in your image.
Managing control points

The Control Points section allows you to manage the different control points applied to the image, presented here as a numbered list. An active control point is indicated in yellow.

1. **Switch on/off effect for all control points**: the switch disables and re-enables all control points applied to the image, as well as the associated corrections and settings.

2. **Show/hide effect of Control Point**: The checkbox to the left of each control point in the list lets you temporarily deactivate and reactivate the display of the concerned control point and its associated corrections and settings.

3. **Show/Hide selection for all control points**: This button displays the monochrome masks for all control points. To display the mask of only one control point at a time, check the box on the right side of the list. In the monochrome mask, white indicates areas of the image where 100% correction is applied, black indicates no correction, and gray variations indicate areas more or less affected by the correction.

4. The dotted circle indicates the size column, in %, of the radius of control point effectiveness.

5. **Group**: You can group several control points by selecting them beforehand (draw a rectangle encompassing the control points or click on it with the Ctrl/Cmd key) and then clicking on this button. In the list, the selected control points are grouped in a numbered group. When you apply a correction to one of the control points, the correction will be applied to the other control points in the group. However, you can use the size slider to adjust the size of each control point in a group independently.

The small triangle located under the first 3 sliders (Br, Co, St) lets you show or hide their section’s other control point sliders.
6. **Ungroup**: To remove the grouping of control points, select the group from the list and press this button. All control points will be displayed as ungrouped, allowing you to delete, modify, or create new groups from individual control points.

7. **Duplicate**: Clicking this button duplicates the currently selected control point(s). You can also duplicate a control point by clicking on it with the Alt/Option key (the pointer will change to a “+”) and then dragging the mouse to reposition the duplicated control point.

8. **Delete**: Click the Delete button to delete the currently selected control point(s).

**Color filters**

The **Color Filter** section allows you to simulate the rendering of the color filters that photographers used to screw onto their lenses to alter the contrast of their black and white film, depending on the subject being photographed — for example, to increase the density of the sky and the brightness of the clouds, to give more shine to the skin, etc.

![Color Filter Interface](image)

1. **Colored Filters**: Click on one of the color filters (red, orange, yellow, green, blue) to quickly select a simulated color filter to apply when converting to black and white. Each selected filter automatically sets the values of the Hue and Intensity sliders (see below). The first filter is neutral (sliders at 0), allowing you to freely define its hue and intensity.

2. **Hue** adjusts the color of the simulated filter and controls the relationship of colors in the image. Objects with the same hue as the selected value will become brighter, while objects with a complementary hue will become darker.

3. **Strength**: Slide to the left for less contrast between colors, or to the right for more contrast between colors.
Film types
Silver Efex Pro 2 offers a rich collection of black and white simulations that replicate all of their characteristics such as grain, contrast, and color response. You can also modify the characteristics of the film to suit your needs using the tools available in this section. You will be able to give a specific rendering to your image, or to manipulate grain so as to mask certain problems inherent to the lack of sharpness or to an excessive smoothing of the noise (and details), or quite simply to bypass the sometimes too-perfect rendering of digital images.
1. **Neutral** drop-down menu: Allows you to choose from simulated black-and-white films, grouped by ISO sensitivity (films with [New] in front of them indicate those added when the program was last updated). For a quick real-time preview of the rendering, hover the mouse over the list, and then click on the desired film to apply the rendering.

2. **Grain** section groups together the sliders that let you modify the aspect of the grain of the film (the sliders are preset according to the selected film):
**Grain by pixel** modifies the aspect of the grain applied to the image. Drag to the left to have more present or coarser grain and to the right to have finer grain.

**Soft / Hard** adjusts the separation and visibility of the grain structure.

 переходит в двухуровневое моделирование, что позволяет более точно контролировать уровень и тип шума.

*Zoom in to at least 100% to check and better visualize how your corrections affect the appearance of the grain.*

3. **Sensitivity** section: Allows you to change the sensitivity of the selected film to the different colors of the image, the sliders being preset according to the selected film. In each of the 6 color channels, adjust the slider to the left to make the corresponding colors denser, and to the right to make them lighter.

4. **Levels and Curves** section: Allows you to affect the contrast and tonal response of the selected film, the curve being preset according to the selected film. Click to add anchor points to the curve to change the brightness, contrast, and tonal value relationship in the image. Level settings are located below the curve, allowing control over the tone of shadows, midtones, and highlights. To reset an anchor point, double-click the point you want to remove.

![](image)

*Adding the Fomapan 100 Classic film effect*

**Finishing adjustments**

The **Finishing adjustments** section is purely creative, allowing you to apply toning, vignetting, burnt edges, and frame effects to your images.
1. **Toning**: The tools in this section allow you to tint black and white images, using virage (or toning) techniques from the darkroom:

   - **Toning** (drop-down menu): Set by default to Neutral (no toning). Move the mouse over the list to see the effect on your image in real time. Click on a toning effect to select apply it.
   - **Strength**: This slider sets the overall intensity of the tone applied to the image and also affects the setting of the Silver Tone and Paper Tone sliders (see below).
   - **Silver Hue** determines the replacement hue for the dark tones, represented by the silver grains of the film.
   - **Silver Toning** sets the intensity of the dark tones.
   - **Balance** determines the balance in the combination of tints applied to the dark tones (Silver) and light tones (Paper). When this slider is set to 0%, the Silver tone and Paper tone mix with the midtones in a balanced way; moved towards the left, you give more importance to the darker tones; moved towards the right, more
importance to the lighter tones.

- **Paper Hue** determines the replacement tint for the light tones associated with the whiteness of the paper.

- **Paper Toning** determines the intensity of the light tones.

2. **Vignette** section tools allow you to apply an effect to darken or lighten the edges of the image, to give it a vintage effect or to focus attention on the subject:

   - **Vignette** (drop-down menu): set by default to Off (no vignetting), move the mouse over the list to see the effect on your image in real time. To select an effect and apply it, click on it.

   - **Amount**: Controls the amount of vignetting. Moving this slider to the left darkens the edges of the image, and moving it to the right lightens them.

   - **Circle**: Controls the overall shape of the vignetting, between circular and rectangular.

   - **Size**: Adjusts the extent of the vignetting effect in the image.

   - **Place Center**: click the button to position an off-center vignetting effect. The mouse pointer will change to a “+” that you then click to place in the image. If you want to change the positioning, click the button again and start over.

3. **Burn Edges** (section): These tools, also inspired by darkroom techniques, will allow you to create denser image edges than with the tools in the Vignette section. Unlike the latter, you can work side by side, and even combine the effect with vignetting.

   - **Burn Edges** (drop-down menu): Disabled by default, the drop-down menu allows you to preview by mouse-over, or apply by clicking, one of the 4 proposed effects.

   - **Edge Selector** lets you select and adjust an image edge that you want to rework individually.

   - **Strength** darkens the burnt edge effect on the selected side.

   - **Size** adjusts the size of the burnt edge.

   - **Transition** controls the blend between the darkening effect and the image.

4. **Image Borders**: The borders in this section also come from techniques used in the lab under the enlarger.

   - **Image Borders** (drop-down menu): Set to Off by default, the menu contains a list of contours that you can preview in the image in real time by hovering with the mouse, and apply by clicking.

   - **Size** adjusts the thickness of the border added to the image.
The added edge always trims part of the image. If you want to keep the entire image, increase the size of the working area in Adobe Photoshop.

- **Spread**: By moving this slider to the right, the border details of the image extend further into the image.

- **Clean/Coarse**: Controls random details around the image. Moving the slider to the right (to Coarse) creates more random detail in the border.

- **Vary Border**: Creates random borders from one image to another. Clicking the button will create a random border number. To recreate the exact same border later, note the number, as well as the size, gap, and Clean/Coarse settings. To get a similar but different border for each image, use the same size, gap, and clean/coarse finish values, but choose a different border number.

*Adding image border Type 4*
Viveza 2
Introduction

The Viveza 2 module is a simple yet powerful tool that uses control points to globally and locally rework the colors and tonality (brightness and contrast) of your images. Control points lets you accentuate or attenuate colors by playing on the hues, saturation, and brightness, and lets you rework the contrast as well as the micro-contrast of your images.
Viveza 2 settings and help

Viveza 2 allows you to adjust a number of display mode settings and to access the online user guide.

![Viveza 2 Settings Window]

**Settings**

After launching Viveza 2, click on the **Settings** button in the lower left corner, and then select the following options in the floating window as desired:

- **Default Zoom**: Sets the zoom value to apply when opening the app, either **Zoom to Fit**, which adjusts the image to the available space in the program window, or **Zoom to 100%**.

- **Default Preview Mode****: Allows you to choose how images will be displayed when you open
the app, either Display single image, or Split preview (the image is separated by a line, with Before corrections on the left, After corrections on the right), or Preview side by side (the two versions of the image, before and after corrections, are displayed next to each other).

- **Default Appearance**: You can choose whether the background gray level will be light, medium, or dark.
- **Default Control Point Size**: You can set the size of the action radius when you create a control point.

* Changes take effect when you open the application the next time.

For each of the default display options, if you select Use last setting, the setting from the previous session will be automatically applied.

### Improve the Nik Collection

If you want the program to transmit usage statistics, check the dedicated box, after opening the section by clicking on its banner. These statistics, which remain anonymous, allow DxO Labs developers to evaluate how users use the program, with the aim of developing and improving the product. There is a link below the checkbox that you can click to find out more about the improvement program (internet connection required).

To save your choices, click **OK**, otherwise click **Cancel**. To reset all options to the default configuration, click **Reset**.

### Help

To access the online help links, you can go to the Help menu or click on the Help button at the bottom left (Internet connection required):

- User guide
- Frequently Asked Questions (FAQs)
- Online support (report problems and ask questions after creating a support ticket)
- DxO Academy (tutorials, videos, webinars)
Viveza 2 interface

Generally speaking, all the components of the Nik Collection suite share the same interface, except for a few details and elements. Viveza 2 is composed of 4 distinct elements, and includes keyboard shortcuts (see table below):

1. The upper toolbar
2. The image display area
3. The right panel
4. The lower toolbar

> Keyboard shortcuts

The upper toolbar

The top toolbar contains the tools and commands related to the display of the image and side panes.
1. **Single image display**: Normal image display without separation and comparison.

2. **Split preview**: Divides the image in two with a vertical red line that you can move left or right, or toggle to horizontal mode by clicking the arrow at the top of the line, with the option of also moving the red line up and down. The left half (or upper half) represents the image as it was opened in the plugin, the right half (or lower half) represents the processed and corrected image. You can also zoom in and out of the image either with the Navigator or with the Hand tool by pressing the spacebar.

3. **Side-by-side preview**: The version before processing is displayed on the left, the version after processing is displayed on the right. You can also display the two versions of the image one above the other by clicking on the button in between. You can also zoom and move synchronously in the two images, either with the Navigator or with the Hand tool, by pressing the spacebar.

4. **Preview**: by checking/unchecking this box, you alternate the display of the image with and without the noise corrections. The preview works with all the display modes described below.

5. **Select** activates the tool for making a rectangular selection within the image—for example, to link together several control points or noise measurement rectangles.

6. **Pan** (or Hand) tool lets you navigate and move around in the image after zooming.

7. **Zoom + / Zoom** - lets you enlarge the image, by default at 100%, using successive clicks. From 100% up to 300%, the Loupe (magnifying glass) contains a "+"; to unzoom (with the Loupe showing a "."), press the Alt (PC)/Option (Mac) key, which transforms the Loupe + into a Loupe -. The magnification value is displayed in the upper right corner of the image.

8. **Change background color**: Click the button successively to change the background from medium gray to white, black, and back to medium gray so as to adapt the screen to the brightness of the image displayed (for example, you can darken the background to avoid too strong a contrast between a dark image and the interface).

9. **Hide or view adjustment panels**: Hide or reveal the right panel.

The image display area
This is where the image is displayed, on a medium gray background (which you can change by clicking the **Change Background Color** button in the top toolbar). At the bottom right, below the image, you will find the following information:

- File name and extension
- Size in megapixels
- ISO sensitivity
- Camera used

**The right panel**

The right panel displays the global correction and selection tools, as well as the Loupe:
1. **Control Points**: See the *Correction tools* page in this chapter for a detailed description of control points and related functions.

2. Double-click a slider to reset it.

3. Levels and curves.

The **Loupe** is also available regardless of the tools you use.
• The red line separates the preview before correction (left) and after correction (right).

• You can move around in the preview by clicking and holding the click while you move the mouse.

• You can lock the loupe at any point in the image by activating the pin and placing it in the image (you can still move it by hand).

The lower toolbar

1. Help* provides access to the online user guide.

2. Settings* opens the plugin options window.

3. Previous / Next: allows you to switch between images if you have opened more than one in the same session, and indicates the number of images.

4. Save & resume editing** activates the reversible workflow. The ? button opens a page with information about this workflow (internet connection required).

5. Cancel: Cancels the current processing and corrections and closes the plugin; the image in the host application is not modified.

6. Save: Saves the processing and corrections and closes the plugin; the image in the host application is modified.

* For more information, see the Settings and Help page.

** More information about the Nik Collection 3’s non-destructive workflow.
## Keyboard shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a control point</td>
<td>Ctrl + Shift + A</td>
<td>Cmd + Shift + A</td>
</tr>
<tr>
<td>Delete a control point</td>
<td>Backspace</td>
<td>Delete</td>
</tr>
<tr>
<td>Duplicate a control point</td>
<td>Ctrl + D, Alt + drag, or Ctrl + C to copy, then Ctrl + V to paste</td>
<td>Cmd + D, Option + drag, or Cmd + C to copy, then Cmd + V to paste</td>
</tr>
<tr>
<td>Apply filter</td>
<td>Enter</td>
<td>Enter</td>
</tr>
<tr>
<td>Cancel filter</td>
<td>Esc</td>
<td>Esc</td>
</tr>
<tr>
<td>Full screen</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>Pan or Hand tool</td>
<td>H or spacebar</td>
<td>H or spacebar</td>
</tr>
<tr>
<td>Preview</td>
<td>Ctrl + P</td>
<td>Cmd + P</td>
</tr>
<tr>
<td>Show/Hide command palettes</td>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td>Selection tool</td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>Cancel</td>
<td>Ctrl + Z</td>
<td>Cmd + Z</td>
</tr>
</tbody>
</table>
Correction tools

Viveza 2 is a pure tone and color correction tool, and therefore, unlike other plugins in the Nik Collection by DxO, such as Color Efex Pro, you won’t find predefined types or combinations, and you won’t be able to save your own recipes. Viveza was originally designed to make corrections easy, without having to go through the complex masking techniques offered by major editing software.

Viveza 2’s correction tools are available for both global correction and selective correction using control points, the latter being the *raison d’etre* of the plugin.

- **Global settings**
- **Selective settings**
- **Levels and curves**

![Local saturation corrections](image-url)

Global settings

General overview

The right pane of Viveza 2 shows a number of tools and sliders grouped in the Global panel.
The sliders are set to 0% by default, and to reset a slider, just double-click on it. To reset all corrections, click the Reset button below the slider list. There is also a checkbox that temporarily disables the corrections of the additional sliders, so that you can, for example, quickly compare with/without the corrections.

The eyedropper tool only works with control points; see Selective settings below.

**Sliders**

Underneath the control point tools you will see the **Global** sliders. Two buttons allow you to display only the main sliders (from Brightness to Structure) or all of the sliders.
The description of the sliders below applies to the use of both global and selective control points:

Main sliders

- **Brightness**\(^*\) adjusts the brightness, darker to the left, brighter to the right.

- **Contrast**\(^**\) adjusts the contrast—that is, the difference in brightness between the dark and light parts of the image. Towards the left, the image will be flatter and less saturated; towards the right, the image will be more striking and more saturated.

- **Saturation** acts on the vividness of the colors—more vivid to the right, and less and less saturated (until entirely gray) to the left.

- **Structure** reinforces the details and gives more punch to the image. Set to the left, the slider softens the details.

Additional sliders

- **Shadow Adjustments**\(^*\) adjusts the brightness level in the darker tones of the image
without affecting the rest of the image.

- **Warmth**: Set to the left, cools the colors (toward blue); set to the right, warms the colors (toward yellow/orange).
- **Red**: Used to compensate for a color cast (more green on the left, more red on the right).
- **Green**: Used to compensate for a color cast (more magenta on the left, more green on the right).
- **Blue**: Used to compensate for a color cast (more yellow on the left, more blue on the right).
- **Hue**: Shifts all colors to their complements (for example, the blue of the sky becomes magenta to the right, and green to the left).

* To adjust the brightness of the darkest tones, use the Shadow Adjustments slider instead.

** We recommend readjusting the color saturation after changing the contrast.

Selective settings
Selective settings allow only certain parts of the image to be changed. When you add a control point and then use the sliders for it, only the objects or areas covered by the control point will be affected.

Control points
You can manage and use both individual and grouped control points. At the top of the right panel, you will see:

1. **Add Control Point**: Click on the button and then click in the image to place the control point. An active control point is yellow; you can add as many control points as you need; only the last one you add (or select) is active.
2. **Group**: To group several control points, activate the **Selection** tool in the upper toolbar (or A key) and then draw a rectangle encompassing the control points to be grouped. In this case, the grouped control points are displayed and act in the same way: adjusting a slider results in the same setting on the other(s). But to reduce the visual clutter of several control points, click on the **Group** button: only the active control point will be visible, but the corrections will be applied by all the control points in the group.

3. **Ungroup**: To ungroup control points, activate the **Selection** tool, draw a rectangle encompassing all the control points of the group and then click on the button. Each control point becomes independent again.

Viveza 2 control points make the same corrections as the global settings sliders, but selectively. When you place a control point, only the 4 main sliders and the Size slider are displayed. To scroll through the subsidiary sliders, click the small arrow below the St (Structure) slider. Apart from **Size**, the sliders are in the same order as the global sliders:
1. **Size**: This is the top-most (and unlabeled) control point slider; it sets the range or radius of the control point’s application. All image elements whose color, brightness, and contrast correspond to the pixels on which the control point is placed will be affected by the following corrections and settings.

2. **Sliders**:
   - Brightness (Br)
   - Contrast (Co)
   - Saturation (Sa)
   - Structure (St)
   - Shadows (Sh)
   - Warmth (Wa)
   - Red (R)
   - Green (G)
   - Blue (B)
   - Tint (Ti)

**Sampling eyedropper and color picker**
Sampling eyedropper

Use the eyedropper (active only with the selective settings) to take a color from the image and apply it to the active control point. For example, if you have placed the control point on a blue sky and you pick green from the vegetation, the control point will apply that hue to that location in the image. The selected color will appear in the color picker pad to the left of the eyedropper.

Color picker

You can also click on the tile to the left of the eyedropper, which by default is gray with a ? inside. This will open the operating system’s color selector so you can choose a color that will be immediately applied to the active control point.

Control Point List

The Control Point List lets you manage the various control points, presented here as a numbered list, that you have applied to your image. An active control point is indicated in yellow.

If you don’t see the Control Point List in the right-hand panel, be sure to collapse the list of Global sliders. It is visible only when just the main sliders are showing.
1. **Size:** The % value in the column below the dotted circle indicates the size of the circle or radius of the control point’s application.

2. The color patch indicates the image color and brightness where the control point has been applied.

3. **Show/hide effect of Control Point:** The checkbox to the left of each control point in the list allows you to temporarily deactivate and reactivate the display of the respective control point, as well as its associated corrections and settings.

4. **Duplicate:** Clicking this button duplicates the currently selected control point(s). You can also duplicate a control point by clicking on it with the Alt/Option key (the pointer is marked with a "+") and then using the mouse to reposition the duplicated control point.

5. **Delete:** Click the Delete button to delete the currently selected control point(s).

6. **Show/hide selection of Control Point:** To display the mask of only one control point at a time, check the box on the right-hand side of the control point in the list. In the monochrome mask, white indicates areas of the image where 100% correction is applied, black indicates no correction, and gray variations indicate areas more or less affected by the correction.

7. **Show/hide selection of all Control Points:** This button makes it possible to display the monochrome masks of all control points in your image.

---

**Levels and curves section**

The curve allows you to refine or completely rework the contrast of your images, either by using a predefined curve or by acting on the curve and level sliders:
1. **Select the channel to be adjusted**: Set by default to RGB (Red, Green, Blue), this menu contains separate channels for each color.

2. **Tone curve**: Click on the curve to adjust it, and to add anchor points, which will allow you to lock the contrast settings at specific points on the curve, and thus on the image. To remove an anchor point, double-click it.

3. **Level sliders**: On the bottom of the channel grid, you can drag the **Adjust the shadows** (left), the **Adjust the mid-tones** (center), or the **Adjust the highlights** sliders to adjust the extent of their respective ranges.

4. Use the **Reset** button to return the **Tone curve** and the **Level sliders** to their original positions.